第1章：Adobe Photoshop CS基础知识
(源码网整理：www.codepub.com)
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1.1 基本概念
1.1.1 像素

在Photoshop中，像素（Pixel）是组成图像的最基本单元，他是一个小的方形的颜色块，一个图像通常由许多像素组成，这些像素被排成横行或纵列。当用缩放工具将图像放到足够大时，就可以看到类似马赛克的效果，每个小方块就是一个像素，也可称之为栅格。每个像素都有不同的颜色值。单位长度内的像素越多，该分辨率（ppi）越高，图像的效果就越好。如图1-1所示，左图是显示器上正常显示的图像，当把图像放大到一定比例后，就会看到如右图所示的类似马赛克的效果。[image: image1.jpg]
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1.1.2 关于矢量图和点阵图

矢量图是由诸如Adobe Illustrator、Macromedia Freehand等一系列图形软件产生的，他由一些用数学方式描述的曲线组成，其基本组成单元是锚点和路径，如图1-2所示。不论放大缩小多少，他的边缘都是平滑的，适用于制作企业标志，这些标志无论用于商业信纸，还是招贴广告，只用一个电子文件就能满足要求，可随时缩放，而效果同样清晰。
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像素图则不同，他是由诸如Adobe Photoshop、Painter等软件产生的，如果将此类图放大到一定程度，就会发现他是由一个个小方格组成的，这些小方格被称为像素，故此类图有像素图之称。像素图的质量是由分辨率决定的，单位长度内的像素越多，分辨率越高，图像的效果就越好。用于制作多媒体光盘的图像通常达到72ppi就可以了，而用于彩色印刷品的图像则需300ppi左右，印出的图像才不会缺少平滑的颜色过渡。有时像素图也被称为点阵图。在Photoshop中也有绘制矢量图形的功能，使用起来更加灵活、方便。

1.1.3 图像分辨率

正确理解图像分辨率（Image Resolution）和图像之间的关系对于了解Adobe Photoshop的工作原理非常重要。

图像分辨率的单位是ppi（pixels per inch），即每英寸所包含的像素数量。如果图像分辨率是72ppi，就是在每英寸长度内包含72个像素。图像分辨率越高，意味着每英寸所包含的像素越多，图像就有越多的细节，颜色过渡就越平滑。

图像分辨率和图像大小之间有着密切的关系。图像分辨率越高，所包含的像素越多，也就是图像的信息量越大，因而文件也就越大。通常文件的大小是以“兆字节”（MB）为单位的。

通过扫描仪获取大图像时，将扫描分辨率设定为300ppi就可以满足高分辨率输出的需要。若扫描时分辨率设得比较低，通过Photoshop来提高图像分辨率的话，则由Photoshop利用差值运算来产生新的像素，这样会造成图像模糊、层次差，不能忠实于原稿。如果扫描时分辨率设得比较高，图像已经获得足够的信息，通过Photoshop来减少图像分辨率则不会影响图像的质量。

另外，常提到的输出分辨率是以dpi（dots per inch，每英寸所含的点）为单位，他是针对输出设备而言的。通常激光打印机的输出分辨率为300～600dpi，照排机要达到1200～2400dpi或更高。
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1.1.4 颜色深度

颜色深度（Color Depth）用来度量图像中有多少颜色信息可用于显示或打印像素，其单位是“位（Bit）”，所以颜色深度有时也称为位深度。常用的颜色深度是1位、8位、24位和32位。1位有两个可能的数值：0或1。较大的颜色深度（每像素信息的位数更多）意味着数字图像具有较多的可用颜色和较精确的颜色表示。

因为一个1位的图像包含21种颜色，所以1位的图像最多可由两种颜色组成。在1位图像中，每个像素的颜色只能是黑或白（见图1-3）；一个8位的图像包含28种颜色，或256级灰阶，每个像素可能是256种颜色中的任意一种；一个24位的图像包含1670万（224）种颜色；一个32位的图像包含232种颜色，但很少这样讲，这是因为32位的图像可能是一个具有Alpha通道的24位图像，也可能是CMYK色彩模式的图像，这两种情况下的图像都包含有4个8位的通道。图像色彩模式和色彩深度是相关联的（一个RGB图像和一个CMYK图像都可以是32位，但不总是这种情况）。Photoshop也支持16位/通道，可产生16位的灰度模式的图像、48位的RGB模式的图像、64位的CMYK模式的图像。表1-1列出了常见的色彩深度、颜色数量和色彩模式的关系。[image: image4.png]
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色彩深度 颜色数量 色彩模式
1位 2（黑和白） 位图
8位 256 索引颜色
16位 65536 灰度，16位/通道
24位 1670万 RGB
32位 CMYK，RGB
48位 RGB，16位/通道
1.1.5 颜色模型和模式

颜色模式决定用于显示和打印图像的颜色模型（简单地说，颜色模型是用于表现颜色的一种数学算法）。Photoshop的颜色模式以用于描述和重现色彩的颜色模型为基础。常见的颜色模型包括 HSB（H：色相、S：饱和度、B：亮度），RGB（R：红色、G：绿色、B：蓝色），CMYK（C：青色、M：洋红色、Y：黄色、K：黑色）和 CIE L*a*b*。

常见的颜色模式包括位图（Bitmap）模式、灰度（Grayscale）模式、双色调（Doutone）模式、RGB模式、CMYK模式、Lab模式、索引颜色（Index Color）模式、多通道（Multichannel）模式、8位/通道模式和16位/通道模式。

颜色模式除能够确定图像中能显示的颜色数量之外，还影响图像的通道数和文件大小。这里提到的通道是Photoshop中的一个重要概念，每个Photoshop图像都具有一个或多个通道，每个通道都存放着图像中的颜色信息。图像中默认的颜色通道数取决于其颜色模式。例如，CMYK模式的图像，其默认的通道数为4个，用来分别存放C（青色）、M（洋红色）、Y（黄色）和K（黑色）的颜色信息。除了这些默认的颜色通道，也可以将叫做Alpha通道的额外通道添加到图像中，Alpha通道通常用来存放和编辑选区，并且可添加专色通道。默认情况下，位图模式、灰度模式、双色调模式以及索引颜色模式中只有一个通道，RGB模式和Lab模式中都有3个通道，CMYK模式中有4个通道。

关于通道的详细介绍，请参看本书第4章。
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◆HSB模型

HSB模型是基于人眼对色彩的观察来定义的，在此模型中，所有的颜色都用色相或色调（Hue）、饱和度（Saturation）和亮度（Brightness）3个特性来描述。

（1） 色相是与颜色主波长有关的颜色物理和心理特性。从实验可知，不同波长的可见光具有不同的颜色，众多波长的光以不同比例混合可以形成各种各样的颜色，但只要波长组成情况一定，那么颜色就确定了。非彩色（黑、白、灰色）不存在色相属性。所有色彩（红、橙、黄、绿、青、蓝、紫等）都是表示颜色外貌的属性，他们就是所说的色相，有时也将色相称为色调。简单来讲，色相或色调是物体反射或透射的光的波长，一般用“°”来表示，范围是0°～360°。

（2）饱和度是颜色的强度或纯度，表示色相中灰色成分所占的比例。通常以“%”来表示，范围是0%～100%。

（3）亮度是颜色的相对明暗程度，通常也是以0%（黑色）～100%（白色）来度量。

◆RGB模型和模式

绝大多数可视光谱可用红色、绿色和蓝色（R/G/B）三色光的不同比例和强度的混合来表示。在这3种颜色的重叠处产生青色、洋红、黄色和白色。

由于RGB颜色合成可以产生白色，因此也称他们为加色。将所有颜色加在一起可产生白色，即所有不同波长的可见光都传播到人眼。加色用于光照、视频和显示器。例如，显示器通过红色、绿色和蓝色荧光粉发射光线产生颜色。

Photoshop的RGB模式使用RGB模型，将红（R）、绿（G）、蓝（B）3种基色按照从0到255的亮度值在每个色阶中分配，从而指定其色彩。当不同亮度的基色混合后，便会产生出256×256×256种颜色，约为1670万种。例如，一种明亮的红色其各项数值可能是R＝246、G＝20、B＝50。当3种基色的亮度值相等时，产生灰色；当3种亮度值都为255时，产生纯白色；当3种亮度值都为0时，产生纯黑色。3种色光混合生成的颜色一般比原来的颜色亮度值高，所以RGB模型又被称为色光加色法。

◆CMYK模型和模式

CMYK模型以打印在纸上的油墨的光线吸收特性为基础。当白光照射到半透明油墨上时，某些可见光波长被吸收，而其他波长的光线则被反射回眼睛。

减色（CMY）和加色（RGB）是互补色。每对减色产生一种加色，反之亦然。

CMYK的4个字母分别指青（Cyan）、洋红（Megenta）、黄（Yellow）和黑（Black），在印刷中代表4种颜色的油墨。CMYK模型和RGB模型使用不同的色彩原理进行定义。在RGB模型中由光源发出的色光混合生成颜色，而在CMYK模型中由光线照到不同比例青、洋红、黄和黑油墨的纸上，部分光谱被吸收后，反射到人眼中的光产生的颜色。由于青、洋红、黄、黑在混合成色时，随着4种成分的增多，反射到人眼中的光会越来越少，光线的亮度会越来越低，所以CMYK模型产生颜色的方法又被称为色光减色法。

在Photoshop的CMYK模式中，为每个像素的每种印刷油墨指定一个百分比值。为最亮（高光）颜色指定的印刷油墨颜色百分比较低，而为较暗（暗调）颜色指定的百分比较高。

如果图像用于印刷，应使用CMYK模式。将RGB模式的图像转换为CMYK模式即产生分色。如果由RGB模式的图像开始，最好先编辑，然后再转换为CMYK模式。在RGB模式下，可以直接使用“校样设置”命令模拟CMYK转换后的效果，而无需更改图像数据。也可以使用CMYK模式直接处理从高档系统扫描或导入的CMYK模式的图像。

◆ CIE L*a*b*模型和Lab模式

L*a*b*颜色模型是在1931年国际照明委员会（CIE）制定的颜色度量国际标准模型的基础上建立的，1976 年，该模型经过重新修订并命名为CIE L*a*b*。

L*a*b*颜色与设备无关，无论使用何种设备（如显示器、打印机、计算机或扫描仪）创建或输出图像，这种模型都能生成一致的颜色。

L*a*b*颜色由亮度或亮度分量（L）和两个色度分量a 分量（从绿色到红色）、b 分量（从蓝色到黄色）组成。

在 Photoshop 的Lab模式中（名称中去掉了星号），亮度分量（L）范围为0～100。在拾色器中，a分量（绿色到红色轴）和 b 分量（蓝色到黄色轴）的范围为+128～-128。在“颜色”调板中，a分量和 b 分量的范围为 +120～-120。

Lab 模式是Photoshop在不同颜色模式之间转换时使用的中间颜色模式。

在 Photoshop使用的各种颜色模型中，L*a*b*模型具有最宽的色域（色域是颜色系统可以显示或打印的颜色范围。人眼看到的色谱比任何颜色模型中的色域都宽），包括RGB和CMYK色域中的所有颜色。通常，对于可在计算机显示器或电视机屏幕（他们发出红、绿和蓝光）上显示的颜色，RGB色域包含这些颜色的子集。因此，某些颜色如纯青或纯黄无法在显示器上精确显示。

CMYK色域较窄，仅包含使用印刷色油墨能够打印的颜色。当不能打印的颜色显示在屏幕上时，称其为溢色（超出CMYK色域范围）。
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◆其他颜色模式

除基本的RGB模式、CMYK模式和Lab模式之外，Photoshop还支持（或处理）其他的颜色模式，这些颜色模式包括位图模式、灰度模式、双色调模式、索引颜色模式和多通道模式，他们都有其特殊的用途。例如，灰度模式的图像只有灰度值而没有颜色信息；使用双色调模式可生成一些有特殊颜色效果的图像。下面就来介绍这几种颜色模式。

（1）位图（Bitmap）模式

位图模式用两种颜色（黑和白）来表示图像中的像素。位图模式的图像也叫作黑白图像。因为其颜色深度（或称为位深度）为1，故位图模式的图像，也称为1位图像。由于位图模式只用黑白色来表示图像的像素，在将图像转换为位图模式时会丢失大量细节，因此Photoshop提供了一些算法来模拟图像中丢失的细节。

在宽度、高度和分辨率相同的情况下，位图模式的图像尺寸最小，约为灰度模式的1/7和RGB模式的1/22以下。

（2）灰度（Grayscale）模式

灰度模式可以使用多达256级灰度来表现图像，使图像的过渡更平滑细腻。灰度图像的每个像素有一个 0（黑色）到255（白色）之间的亮度值。灰度值也可以用黑色油墨覆盖的百分比来表示（0%等于白色，100%等于黑色）。

（3）双色调（Duotone）模式

双色调模式采用2～4种彩色油墨混合其色阶来创建双色调（2种颜色）、三色调（3种颜色）和四色调（4种颜色）的图像。在将灰度图像转换为双色调模式的图像过程中，可以对色调进行编辑，产生特殊的效果。使用双色调模式的重要用途之一是使用尽量少的颜色表现尽量多的颜色层次，这对于减少印刷成本是很重要的，因为在印刷时， 每增加一种色调都需要更大的成本。

（4）索引颜色（Indexed Color）模式

索引颜色模式是网上和动画中常用的图像模式，当彩色图像转换为索引颜色模式的图像后变成近256种颜色。索引颜色图像包含一个颜色表。如果原图像中的颜色不能用256色表现，则Photoshop会从可使用的颜色中选出最相近的颜色来模拟这些颜色，这样可以减小图像文件的大小。颜色表用来存放图像中的颜色并为这些颜色建立颜色索引，颜色表可在转换的过程中定义或在生成索引模式图像后修改。

（5）多通道（Multichannel）模式

多通道模式对于有特殊打印要求的图像非常有用。例如，如果图像中只使用了一、两种或三种颜色时，使用多通道模式可以减少印刷成本并保证图像颜色的正确输出。

（6）8位/通道和16位/通道（Bit/Channel）模式

在灰度、RGB或CMYK模式下，可以使用16位/通道来代替默认的8位/通道。根据默认情况，8位/通道中包含256个灰阶，如果增加到16位，每个通道的灰阶数量为65536，这样能得到更多的色彩细节。Photoshop可以识别和输入16位/通道图像，但对于这种图像限制很多，所有的滤镜都是不能使用的，另外，16位/通道模式的图像不能被印刷。
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◆颜色模式的转换

为了能够在不同场合正确输出图像，有时需要把图像从一种模式转换为另一种模式。Photoshop通过执行“图像>模式”（Image>Mode）子菜单中的命令，来转换需要的颜色模式。这种颜色模式的转换有时会永久性地改变图像中的颜色值。例如，将RGB模式图像转换为CMYK模式图像时，CMYK色域之外的RGB颜色值被调整到CMYK色域之内，从而缩小了颜色范围。

由于有些颜色模式在转换后会损失部分颜色信息，因此在转换前最好为其保存一个备份文件，以便在必要时恢复图像。

（1）将彩色模式转换为灰度模式的图像

将彩色模式转换为灰度模式图像时，Photoshop会扔掉原图像中所有的色彩信息，而只保留像素的灰度级。灰度模式可作为位图模式和彩色模式相互转换的中介模式。

（2）将其他模式的图像转换为位图模式

将其他模式的图像转换为位图模式会使图像颜色减少到两种，这样就大大简化了图像中的颜色信息，并减小了文件大小。要将图像转换为位图模式，必须首先将其转换为灰度模式。这会去掉像素的色相和饱和度信息，而只保留亮度值。但是，由于只有很少的编辑选项能用于位图模式图像，所以最好是在灰度模式中编辑图像，然后再转换他。

在灰度模式中编辑的位图模式图像转换为位图模式后，看起来可能不一样。例如，在位图模式中为黑色的像素，在灰度模式中经过编辑后可能会是灰色。如果像素足够亮，当转换回位图模式时，他将成为白色。

（3）将其他模式转换为索引颜色模式

在将彩色模式转换为索引颜色模式时，会删除掉图像中的很多颜色，而仅保留其中的256种颜色，即许多多媒体动画应用程序和网页所支持的标准颜色数。只有灰度模式和RGB模式的图像可以转换为索引颜色模式。由于灰度模式本身就是由256种颜色灰度构成，因此转换为索引颜色后无论颜色还是图像大小都没有明显的差别。但是将RGB模式的图像转换为索引颜色模式后，图像的大小将明显减小，同时图像的视觉品质也将受损。

（4）将RGB模式的图像转换成CMYK模式图像

如果将RGB模式的图像转换成CMYK模式图像，图像中的颜色就会产生分色，颜色的色域就会受到限制。因此，如果图像是RGB模式的，最好在RGB模式下编辑完成后，再转换成CMYK模式图像进行输出和印刷。

（5）利用Lab模式进行模式转换

在Photoshop所能使用的颜色模式中，Lab模式的色域最宽，他包括RGB和CMYK色域中的所有颜色。所以使用Lab模式进行转换时不会造成任何色彩上的损失。Photoshop便是以Lab模式作为内部转换模式来完成不同颜色模式之间转换的。例如，将RGB模式的图像转换为CMYK模式时，计算机内部首先会把RGB模式转换为Lab模式，然后再将Lab模式的图像转换为CMYK模式的图像。

（6）将其他模式转换为多通道模式

多通道模式可通过转换颜色模式和删除原有图像的颜色通道得到。将CMYK图像转换为多通道模式可创建由青、洋红、黄和黑色专色构成的图像。将RGB图像转换为多通道模式可创建由青、洋红和黄专色构成的图像。从RGB、CMYK或Lab图像中删除一个通道会自动将图像转换为多通道模式，原来的通道被转换为专色通道。

专色是特殊的预混油墨，用来替代或补充印刷四色油墨 ；专色通道是可为图像添加预览专色的专用颜色通道。

第2章：Adobe Photoshop CS绘图修饰及图像编辑
颜色设定(1)


     

2.2 颜色设定
在Photoshop中使用各种绘图工具时，不可避免地要用到颜色的设定，Photoshop软件提供了多种颜色选取和设定的方式。

各种绘图工具画出的线条颜色是由工具箱中的前景色确定的，而橡皮擦工具擦除后的颜色则是由工具箱中的背景色决定的。

默认情况下，前景色和背景色分别为黑色和白色，单击图2-2右上角的双箭头，可切换前景色和背景色，单击图2-2左下角的小黑白图标，不管当前显示的是何种颜色，可将前景色和背景色切换到默认的黑色和白色。下面分别介绍设定前景色和背景色的方法。

[image: image5.png]



图2-2

2.2.1 拾色器

单击工具箱中的前景色或背景色图标，即可调出“拾色器”对话框（见图2-3）。在对话框左侧，在任意位置单击鼠标，会有圆圈标示出单击的位置，在右上角就会显示当前选中的颜色，并且在“拾色器”对话框右下角出现其对应的各种颜色模式定义的数据显示，包括RGB、CMYK、HSB和Lab4种不同的颜色描述方式，也可以在此处输入数字直接确定所需的颜色。
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图2-3

在“拾色器”对话框中，可以拖动颜色导轨上的三角形颜色滑块确定颜色范围。颜色滑块与颜色选择区中显示的内容会因不同的颜色描述方式（单击HSB、RGB、Lab或CMYK前的按钮）而有所不同。

例如，选定H（色相）前的按钮时，在颜色滑块中纵向排列的即为色相的变化；在滑块中选定了某种色相后，颜色选择区内则会显示出这一色相亮度从亮到暗（纵向），饱和度由最强到最弱（横向）的各种颜色。

选定R（红色）按钮时，在颜色滑块中显示的则是红色信息由强到弱的变化，颜色选择区内的横向即会表示出蓝色信息的强弱变化，纵向会表示出绿色信息的强弱变化（见图2-4）。
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图2-4

在实际工作中，通常以数值的方式确定颜色，这种方式最准确。如果手边有一本印刷色谱，则可对照色谱中颜色的配比，在颜色定义区内输入颜色，用这种方法可以最大限度地避免显示器的误差。

单击拾色器右上方的“自定（Custom）”按钮，则会出现一个新的“自定颜色（Custom Colors）”对话框（见图2-5），它允许按照标准的色标本，如Pantone色谱的编号来精确地选择颜色。这些标准色谱通常都有自己不同的适用范围，并有统一的描述和配制方法，有时在制定一些标识（如企业标准色）或专色印版时，以这种方式指定颜色可保证其统一性。在“自定颜色”对话框中单击拾色器按钮，又可以重新回到标准的“拾色器”对话框中。
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图2-5

颜色设定(2)


     

2.2.2 颜色调板

选择“窗口>颜色（Window>Color）”命令，即可在桌面上看到“颜色（Color）”调板（窗口菜单下的菜单均为开关菜单，名称前有“√”符号的，表示调板已在桌面上显示，再选一次，可将此调板关闭）。
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图2-6

在“颜色”调板中的左上角有两个色块用于表示前景色和背景色（见图2-6）。色块上有双框表示被选中，所有的调节只对选中的色块有效，用鼠标单击色块就可将其选中。用鼠标单击调板右上角的三角按钮，在弹出菜单中的不同选项是用来选择不同的色彩模式的， 前面有“√”表示调板中正在显示的模式。不同的色彩模式，调板中滑动栏的内容也不同，通过拖动三角滑块或输入数字可改变颜色的组成。直接单击“颜色”调板中的前景色或背景色图标也可以调出“拾色器”对话框。

还可以通过弹出菜单改变“颜色”调板下方的颜色条所显示的内容，根据不同的需要选择不同的颜色条形式。在“颜色”调板中，当光标移至颜色条时，会自动变成一个吸管，可直接在颜色条中吸取前景色或背景色。如果想选择黑色或白色，可在颜色条的最右端单击黑色或白色的小方块。

当所选颜色在印刷中无法实现时，在“颜色”调板中会出现一个带叹号的三角图标（见图2-7），在其右边会有一个替换的色块，替换的颜色一般都较暗。
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图2-7

2.2.3 色板

“色板（Swatches）”（见图2-8）和“颜色”调板有一些相同的功能，就是都可用来改变工具箱中的前景色或背景色。不论正在使用何种工具，只要将鼠标移到“色板”上，都会变成吸管的形状，单击鼠标就可改变工具箱中的前景色，按住Cmd（Mac OS）/Ctrl（Windows）键单击鼠标就可改变工具箱中的背景色。

若要在“色板”上增加颜色，可用吸管工具在图像上选择颜色，当鼠标移到“色板”的空白处时，就会变成油漆桶的形状，单击鼠标可将当前工具箱中的前景色添加到色板中。
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图2-8

若要删除“色板”中的颜色，只要按住Option（Mac OS）/Alt（Windows）键就可使图标变成剪刀的形状，在任意色块上单击鼠标键，就可将此色块剪掉。
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图2-9

如果要恢复软件默认的情况，在“色板”右边的弹出菜单中选择“复位色板”（Reset Swatches）命令（见图2-9），在弹出的对话框中有3个按钮，如果要恢复到软件内定的状态，单击“好” 按钮；如果要使软件内定的颜色在加入的同时保留现有的颜色，可单击“追加（Append）”按钮；若要取消此命令，可单击“取消”按钮。

另外，如果要将当前的颜色信息存储起来，可在“色板”中的弹出菜单中选择“存储色板”命令。如果要调用这些文件，可选择“载入色板”命令将颜色文件载入。当然，也可选择“替换色板”命令，用新的颜色文件代替当前“色板”中的颜色。

颜色设定(3)


     

2.2.4 其他颜色确定方法

◆吸管工具

吸管工具（[image: image13.jpg]


）（Eyedropper Tool）可从图像中取样来改变前景色或背景色。用此工具在图像上单击，工具箱中的前景色就会显示所选取的颜色。如果在按住Option（Mac OS）/Alt（Windows）键的同时用此工具在图像上单击，工具箱中的背景色就显示所选取的颜色。
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图2-10

软件默认的情况是吸取单个像素的颜色，但也可在一定范围内取样。选中工具箱中的吸管工具，在其选项栏中“取样大小（Sample Size）”复选项后面的弹出菜单中（见图2-10），还可以选择“3×3平均”、“5×5平均”，在一个较大的范围内吸取像素颜色的平均值。

在图像中按住鼠标键移动吸管工具，此时，工具箱中前景色框的颜色会随着吸管工具的移动而改变，若想使背景色框中的颜色随着吸管工具的移动而改变，那么在移动吸管工具时按住Option（Mac OS）/Alt（Windows）键就可以了。

按住Option（Mac OS）/Alt（Windows）键，可在使用各种绘图工具时暂时切换到吸管工具，可以方便快速地选取前景色。

◆颜色取样器工具

使用颜色取样器工具（Color Sampler Tool）最多可有4个取样点。取样的目的是测量图像中不同位置的颜色数值，方便图像色彩调节，被标记的颜色点不会对图像造成任何影响。

使用的方法非常简单，在工具箱中选中颜色取样器工具（[image: image15.jpg]o 4



），并直接在图像上单击，生成的取样点如图2-11所示。
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图2-11 图2-12

可通过颜色取样器工具选项栏中的“清除 ”按钮（见图2-12）将所有取样点删除。直接用鼠标拖动就可以移动取样点的位置。如果想删除某个取样点，用鼠标将其拖拉出图像窗口就可以了；或者按住Option（Mac OS）/Alt（Windows）键，此时颜色取样器工具会变成剪刀的形状，在取样点上单击，就可将其删除。

在“信息（Info）” 调板的下半部分可以看到4个取样点的RGB数值（见图2-13）。可在信息调板右上角的弹出菜单中选择“颜色取样器（Color Sampler）”命令，使其前面的“√”符号消失，可暂时隐藏取样点的显示，如再次选择此命令，又可将取样点显示出来。
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图2-13

◆通过信息调板查看颜色信息

当鼠标在画面上移动时，可以在Photoshop的信息调板中实时地看出鼠标当前的位置和当前点的颜色信息。如果选择了不同的工具，还可通过信息调板得到大小、距离和旋转角度等信息（见图2-14）。

单击信息调板右上角的三角按钮，在弹出的菜单中选择“调板选项”，就会弹出“信息选项（Info Options）”对话框（见图2-15）。
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图2-14 图2-15

“第一颜色信息（First Color Readout）”复选栏：在“模式”后面内定的选项是“实际颜色（Actual Color）”，也就是说，如果打开的图像呈RGB模式，则在第一组数据中显示RGB的数值；如果打开的图像呈CMYK模式，在第一组数据中显示CMYK的数值。也可在“模式”后面的下拉菜单中设定其他模式。还可以选择“油墨总量（Total Ink）”或“不透明度（Opacity）”等图像信息显示在调板上。

如果当前操作的图像为双色调模式，则只有用“实际颜色”方式才能显示双色调模式中的各颜色信息。

“第二颜色信息（Second Color Readout）”复选栏：在“模式”后面内定的选项是“CMYK颜色”，另外也可以在模式后面的下拉菜单中设定不同的模式。

“鼠标坐标（Mouse Coordinates）”复选栏：在“标尺单位（Ruler Units）”后面的弹出菜单中有若干选项，其中“厘米（Centimeters）”是最常用的。

在信息调板中，当CMYK数值后面出现叹号时，表明鼠标所在处的颜色超出了印刷范围，该颜色是印刷所不能表现的颜色。

◆通过信息调板了解其他信息

（1）当使用工具箱中的“选框工具”时，在信息调板中显示的是鼠标点的坐标值，并随着鼠标的拖拉显示所选范围的W（宽度）和H（高度）。

（2）当使用工具箱中的“裁切工具”时，在信息调板中显示鼠标点的坐标值，随着鼠标的拖拉来显示所选范围的W（宽度）和H（高度），并且还能显示旋转的角度。

（3）当使用直线工具、路径工具或渐变工具时，在信息调板中显示鼠标点的坐标值，并显示X轴和Y轴方向的变化值（△X和△Y）、角度值（A）以及拖拉鼠标的距离（D）。

（4）当使用度量工具测量图像中的距离时，在信息调板中可了解两点之间测量线的角度（A）、线段的长度（D）、线的起点的坐标（X，Y）以及线段的垂直高度（W）和水平宽度（H）。

（5）当选择“编辑”菜单中的“自由变换（Free Transform）”或“变换（Transform）”子菜单中的“缩放（Scale）”、“旋转（Rotate）”等命令时，在信息调板中显示H（高度）和W（宽度）改变的百分比、旋转的角度、水平及竖直改变的角度等。

（6）在选择“图像>调整>曲线或色阶（Image>Adjustments>Curve/Level）”等命令时，在信息调板中会显示鼠标所在处调节前和调节后的像素点的值。

第2章：Adobe Photoshop CS绘图修饰及图像编辑
图像修饰工具(1)


     

2.5 图像修饰工具
图像修饰工具包括：仿制图章（Clone Stamp）、图案图章（Pattern Stamp）、修复画笔（Healing Brush）、修补（Patch ）、 模糊（Blur）、锐化（Sharpen）、涂抹（Smudge）、减淡（Dodge）、加深（Burn）以及海绵（Sponge）工具，可以使用它们来修复和修饰图像。

2.5.1 仿制图章工具

使用仿制图章工具（[image: image21.jpg]


）可准确复制图像的一部分或全部从而产生某部分或全部的拷贝，它是修补图像时常用的工具。例如，若原有图像有折痕，可用此工具选择折痕附近颜色相近的像素点来进行修复。

单击工具箱中的仿制图章工具，便出现其工具选项栏（见图2-88），在画笔预览图的弹出调板中选择不同类型的画笔来定义仿制图章工具的大小、形状和边缘软硬程度。在“模式”弹出菜单中选择复制的图像以及与底图的混合模式，并可设定“不透明度”和“流量”，还可以选择喷枪效果。
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图2-88

在有很多图层的情况下，选择“用于所有图层”选项后再用仿制图章工具，不管当前选择了哪个层，此选项对所有的可见层都起作用。

下面介绍仿制图章工具（[image: image23.jpg]


）的具体使用方法。

（1）首先在仿制图章工具的选项栏中选择一个软边和大小适中的画笔，然后将仿制图章工具移到图像中，按住Option（Mac OS）/Alt（Windows）键的同时单击鼠标键确定取样部分的起点。

（2）将鼠标移到图像中另外的位置，当按下鼠标键时，会有一个十字形符号标明取样位置和仿制图章工具相对应（见图2-89），拖拉鼠标就会将取样位置的图像复制下来（见图2-90）。
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图2-89 图2-90

（3）仿制图章工具不仅可在一个图像上操作，而且还可从任何一张打开的图像上取样后复制到现用图像上，但却不改变现用图像和非现用图像的关系。图2-92所示的是通过仿制图章工具将咖啡豆（见图2-91）复制到另一个打开的图像上的效果（注意：两张图像的颜色模式必须一样才可以执行此项操作）。在复制图像的过程中可经常改变画笔的大小及其他设定项以达到精确修复的目的。
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图2-91 图2-92

在仿制图章选项调板中有一个“对齐的（Aligned）”的选项，这一选项在修复图像时非常有用。因为在复制过程中可能需要经常停下来，以更改仿制图章工具的大小和软硬程度，然后继续操作，因而复制会终止很多次，若选择“对齐的”选项，下一次的复制位置会和上次的完全相同，图像的复制不会因为终止而发生错位。

若不选择“对齐的”选项，一旦松开鼠标键，表示这次的复制工作结束，当再次按下鼠标键时，表示复制重新开始，每次复制都从取样点开始，操作起来很麻烦。所以应用此选项对得到多个拷贝非常有帮助。图2-93是原始图像，图2-94是不选择“对齐的”选项得到的复制结果。
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图2-93 图2-94

前面所讲的两种情况限于只有一次取样点，若按住Option（Mac OS）/Alt（Windows）键在不同的位置再一次取样，复制就会从新的取样点开始。

图像修饰工具(2)


     

2.5.2 图案图章工具

使用图案图章工具（Pattern Stamp Tool）（[image: image30.jpg]


）可将各种图案填充到图像中。图案图章工具的选项栏如图2-95所示，和前面所讲的仿制图章工具的设定项相似。不同的是图案图章工具直接以图案进行填充，不需要按住Option（Mac OS）/Alt（Windows）键进行取样。
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图2-95

可以在图案预览图的弹出调板中选择预定好的图案，也可以使用自定义的图案，方法是用矩形选框工具选择一个没有羽化设置的区域（羽化＝0），执行“编辑>定义图案（Define Pattern）”命令，弹出“图案名称”对话框，在“名称”栏中输入图案的名称，单击“好”按钮即可将图案存储起来。在图案图章工具选项栏中的图案弹出式调板中可看到新定义的图案。

定义好图案后，直接以图案图章工具在图像内绘制，即可将图案一个挨一个整齐排列在图像当中。图案图章工具选项栏中同样有一个“对齐的”选项，选择这一选项时，无论复制过程中停顿多少次，最终的图案位置都会非常整齐；而取消这一选项，一但图案图章工具使用过程中断，再次开始时图案即无法以原先的规则排列。图2-96是选择“对齐的”选项后多次单击鼠标键后的填充结果，图2-97是不选择“对齐的”选项后多次单击鼠标键后的填充结果。
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图2-96 图2-97

◆艺术克隆

图案图章工具可以作为艺术克隆工具，将图像做绘画笔触的处理，其功能有些与历史记录艺术画笔工具相似，但笔触效果更加灵活。具体操作步骤如下。

（1）打开要做处理效果的图像（见图2-98），将整个图像作为定义的图案，不用制作矩形选区，直接选择“编辑>定义图案（Edit>Define Pattern）”命令。将整个图像都定义为图案（见图2-99）。

[image: image34.jpg]



图2-98

[image: image35.jpg]



图2-99

（2）在“克隆源”图层的图层上方新建一图层“白色挡板”，使用油漆桶工具将此图层填充为白色，并将图层不透明度改为：40%（见图2-100、2-101）。

[image: image36.jpg]
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图2-100 图2-101

（3）在“白色挡板”图层上方新建一图层“克隆” ，将新图层的图层混合模式改为“正片叠底”（见图2-102）。

[image: image38.jpg]



图2-102

（4）使用图案图章工具（[image: image39.png]


）准备开始克隆，将图案图章的选项栏中的“图案拾色器”图案选择定义好的“克隆图片”图案，并将“对齐”和“印象派效果”的选项勾上（见图2-103）。打开画笔选项，选择“滴溅”选项，可以使克隆效果更倾向手绘效果。（见图2-104）

[image: image40.jpg]



图2-103
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图2-104

（5）调整“滴溅”笔刷的主直径，使用大的画笔笔刷绘制背景区域（见图2-105），使用小的画笔笔刷绘制近景部分（见图2-106）。[image: image42.jpg]
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图2-105 图2-106

（6）使用不同大小的画笔笔刷刷头对画面进行调整，绘制艺术效果是随意性的，需要一些尝试。最后调整结果见（图2-107）。

[image: image44.jpg]



图2-107

图像修饰工具(3)


     

2.5.3 修复画笔工具

修复画笔工具（Brush Healing Tool）（[image: image45.jpg]


）用于修复图像中的缺陷，并能使修复的结果自然溶入周围的图像。和图章工具类似，“修复画笔工具”也是从图像中取样复制到其他部位，或直接用图案进行填充。但不同的是，“修复画笔工具”在复制或填充图案的时候，会将取样点的像素信息自然溶入到复制的图像位置，并保持其纹理、亮度和层次，被修复的像素和周围的图像完美结合。如图2-108所示，左图是修复前、右图是修复后的效果。[image: image46.jpg]



图2-108

在修复画笔工具选项栏（见图2-109）中，可看到和图章工具类似的选项。在画笔弹出调板中选择画笔的大小来定义修复画笔工具的大小；在“模式”后面的弹出菜单中选择复制或填充的像素和底图的混合方式。在画笔弹出调板中只能选择圆形的画笔（见图2-110），只能调节画笔的粗细、硬度、间距、角度和圆度的数值，这是和图章工具的不同之处。[image: image47.jpg]s3] an & e cmx [ [] rwmer





图2-109
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图2-110

在“源（Source）”后面有两个选项，当选择“取样（Sampled）”时，和仿制图章工具相似，首先按住Option（Mac OS）/Alt（Windows）键确定取样起点，然后松开Option（Mac OS）/Alt（Windows）键，将鼠标移动到要复制的位置，单击或拖拉鼠标；当选择“图案（Pattern）”时，和图案图章工具相似，在弹出调板中选择不同的图案或自定义图案进行图像的填充。

“对齐的”选项的使用和前面讲到的“仿制图章”工具中此选项的使用完全相同。

如果是在两个图像之间进行修复工作，同样要求两个图像有相同的图像模式。图2-111所示的是两个CMYK模式的图像，按住Option（Mac OS）/Alt（Windows）键在左侧的图像中单击确定取样起点，然后松开Option（Mac OS）/Alt（Windows）键，在右侧图像中拖拉鼠标，拖拉过程如图2-111所示。松开鼠标键，软件开始进行运算，图2-112所示的是运算的结果，可看到复制到图像中的花和图像原来的色相、亮度保持很好的融合，没有像图章工具那样有生硬的感觉。

[image: image49.jpg]



图2-111

[image: image50.jpg]



图2-112

图2-113是原始图像，图2-114是使用“图案图章工具”绘制的结果，图2-115是使用“ 修复画笔工具”的“图案”选项绘制的结果，对比可明显看到两者的不同。
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图2-113

[image: image52.jpg]
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图2-114 图2-115

图像修饰工具(4)


     

2.5.4 修补工具

[image: image54.jpg]



图2-116

使用“修补工具（Patch Tool）（[image: image55.jpg]


）”可以从图像的其他区域或使用图案来修补当前选中的区域。和修复画笔工具相同之处是修复的同时也保留图像原来的纹理、亮度及层次等信息。

在执行修补操作之前，首先要确定修补的选区，可以直接使用“修补工具”在图像上拖拉形成任意形状的选区，也可以采用其他的选择工具进行选区的创建。

将图2-117左上角的部分用“修补工具”圈选起来，然后在“修补工具”的选项栏中选择“源（Source）”选项，按住鼠标拖拉到如图2-118所示的区域，松开鼠标，原来圈选的区域就被图2-118中选区所示的范围所修补，结果如图2-119所示。用同样的方法进行其他区域的修补，修补结果如图2-120所示。

[image: image56.jpg]
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图2-117 图2-118

[image: image58.jpg]
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图2-119 图2-120

当从图像中选择像素修补其他区域时，尽量选择较小的区域，这样修补的效果会好一些。

如果选择修补工具选项栏中的“目的（Destination）”选项，修补的操作和选择“源”不同。图2-121为使用修补工具确定选区的效果，然后用鼠标将此选区拖拉到要修复的区域，结果如图2-122所示。
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图2-121 图2-122

在使用任何一个选择工具创建完选区后，修补工具选项栏中的“使用图案（Use Pattern）”按钮就变成可选项。在弹出的图案调板中选择图案，然后单击“使用图案”按钮，图像中的选区就会被填充上所选择的图案。图2-123所示的是创建的选区，可以通过“选择>羽化（Select>Feather）”命令给选区设定一定的羽化值，图2-124是图案填充的结果。
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图2-123 图2-124

图像修饰工具(5)


     

2.5.5 颜色替换工具

使用颜色替换工具（[image: image64.jpg]


）能够简化图像中特定颜色的替换。可以用校正颜色在目标颜色上绘画（例如，图像中人物的红眼）。其操作步骤如下。

打开有红眼要修改的图像（见图2-125），在选项栏中选取画笔笔尖。设置混合模式为“颜色”，选择颜色为“深褐色”（见图2-126）。使用颜色替换工具（[image: image65.jpg]


）在“红眼”部位进行绘制，将红色改为深褐色（见图2-127）

[image: image66.jpg]
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图2-126

取样
“连续”：用来在拖移时对颜色连续取样。

“一次”：用来替换第一次点按的颜色所在区域中的目标颜色。

“背景色板”：用来抹除包含当前背景色的区域。

限制
“不连续”：用来替换出现在指针下任何位置的样本颜色。

“邻近”：用来替换与紧挨在指针下的颜色邻近的颜色。

“查找边缘”：用来替换包含样本颜色的相连区域，同时更好地保留形状边缘的锐化程度。

“容差”
用来输入一个百分比值（范围为1%~100%）或者拖移滑块。选取较低的百分比可以替换与所点按像素非常相似的颜色，而增加该百分比可替换范围更广的颜色。

“消除锯齿”
用来为所校正的区域定义平滑的边缘。

颜色替换工具不适用于“位图”、“索引”或“多通道”颜色模式的图像。

第4章：Adobe Photoshop CS通道和蒙版
蒙版的基本操作(1)


     

4.1 蒙版的基本操作

通过本课程，将会了解如下内容。

·使用快速蒙版修整选区。

·将选区存储为一个Alpha选区通道。

·使用通道调板观看一个蒙版。

·通过在蒙版中绘制来修改一个选区。

·创建和使用一个渐变蒙版。

蒙版可以用来将图像的某部分分离开来，保护图像的某部分不被编辑。当基于一个选区创建蒙版时，没有选中的区域成为被蒙版蒙住的区域，也就是被保护的区域，可防止被编辑或修改。利用蒙版，可以将花费很多时间创建的选区存储起来随时调用，另外，也可以将蒙版用于其他复杂的编辑工作，如对图像执行颜色变换或滤镜效果等。

在Adobe Photoshop中，可以创建像“快速蒙版（Quick Mask）”这样的临时蒙版，也可以创建永久性的蒙版，如将它们存储为特殊的灰阶通道--Alpha选区通道。Photoshop也利用通道存储颜色信息和专色信息。和图层不同的是，通道不能打印，但可以使用“通道（Channels）”调板来观看和使用Alpha选区通道。

4.1.1 起步

在开始这一课之前，需要将Adobe Photoshop的设置恢复到软件默认的状态。Photoshop的“预置（Preferences）”文件存储各种调板和命令的设置以及色彩校正的信息。每次退出Photoshop时，调板的位置和各种命令设置都被存储在各自的预设文件中，当使用Photoshop色彩管理助理时，显示器校正和色彩空间信息同样也是存储在预设文件中。在软件使用过程中，可能对各种设置做了许多的修改，所以在课程开始之前，需要将各种设置恢复到软件初始的状态，这样才能保证软件设置和本书中所描述的相同。如果想保留原来自定的设置，可以将它存储起来，以备后用。

关于如何将预设文件恢复到初始的设置，请参见本书P9~P10。

4.1.2 创建快速蒙版

打开一个图像文件，利用快速蒙版将一个有浮动的选择范围转变为一个临时的蒙版，并将这个快速蒙版转回选择范围。除非将快速蒙版存储为Alpha通道使之成为永久性的蒙版，否则一旦将临时的快速蒙版转回选择范围，这一临时的蒙版就被删除掉了。

（1） 选择“文件>打开”命令，可将如图4-1所示的文件打开。

[image: image69.jpg]



图4-1

（2） 选择工具箱中的魔棒工具（[image: image70.jpg]


），在魔棒工具的选项栏中，将“容差（Tolerance）”数值设定为55（见图4-2）。
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图4-2

（3） 使用魔棒工具，在小丑鱼身上的任何一个红色的位置单击，就会出现一个有闪动边线的选区。如果想扩展这一选区，在按住Shift键的同时再使用魔棒工具，在小丑鱼身上另外的白色位置单击，就可将选区扩大（见图4-3）。当按住Shift键时，在魔棒工具的下方会出现一个加号，表示增加选区。

[image: image72.jpg]
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图4-3 图4-4

魔棒工具适合于选择颜色单一、边缘清晰的图像区域，小丑鱼身上的白色边缘部分通过魔棒工具很难选择，这时可利用快速蒙版提供的功能来实现选区的准确选择。

（4）在工具箱中单击快速蒙版模式按钮（见图4-4）。根据内定设置，图像一直是在标准模式状态下工作的。在“快速蒙版模式”，会出现红色半透明的“膜”将闪动选择线以外的图像区域蒙住，从而将这些区域保护起来。没有被红色的“膜”保护的可见区域就是闪动的选择线之内的选中区域，但对于图像的色调是红色时，使用红色的半透明的“膜”就难以辨清选择的位置。双击快速蒙版按钮（[image: image74.jpg]


），弹出“快速蒙版选项”对话框（见图4-5），设置色彩指示为“所选区域”，并单击颜色下的红色色块，选取一个与图像反差比较大的的颜色作为半透明“膜”的颜色，按“好”确定。得到图4-6所示结果。

“被蒙版区域”可使被蒙版区域显示为黑色（不透明），使选中区域显示为白色（透明）。用黑色绘画可扩大被蒙版区域；用白色绘画可扩大选中区域。

“所选区域”可使被蒙版区域显示为白色（透明），使选中区域显示为黑色（不透明）。用白色绘画可扩大被蒙版区域；用黑色绘画可扩大选中区域。

要更改不透明度，请输入一个 0% ~100% 中的数值。

颜色和不透明度设置都只影响蒙版的外观，对如何保护蒙版下面的区域没有影响。更改这些设置能使蒙版与图像中的颜色对比更加鲜明，从而具有更好的可视性。[image: image75.jpg]
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图4-5 图4-6

如果在进入快速蒙版状态之前，图像中没有闪动选择线选中的区域，进入快速蒙版状态后，图像并没有红色的“膜”，但在图像的标题栏上可看到“快速蒙版”字样，表明当前的编辑状态。此时在通道调板中可看到有“快速蒙版”字样的临时通道产生。

蒙版的基本操作(2)


     

4.1.3 编辑快速蒙版

在快速蒙版状态下，可以用画笔工具对快速蒙版进行编辑来增加或减少选区。快速蒙版状态的优势就是，可以使用几乎所有的工具或滤镜对蒙版进行编辑，甚至可以使用选择工具。

在快速蒙版模式下，Photoshop自动转换为灰阶模式，前景色为黑色，背景色为白色。当用工具箱中的绘图或编辑工具时，应遵守以下原则：当绘图工具用白色绘制时相当于擦除蒙版，红色覆盖的区域变小，选择区域就会增加；当绘图工具用黑色绘制时，相当于增加蒙版的面积，红色的区域变大，也就是减少选择区域。

◆通过擦除蒙版区域来增加选区

（1）将工具箱中的前景色切换为白色，并选择工具箱中的画笔工具。

（2）在画笔工具的选项栏中，确认模式是“正常”，在弹出式画笔调板中选择一个中等大小的画笔（见图4-7）。[image: image77.jpg]L P





图4-7

（3）在编辑快速蒙版时，为了修改细节的部分，可能随时需要将图像的显示放大或缩小。

放大图像的显示

·选择工具箱中的缩放工具，然后在想放大的区域单击，每单击一次，图像就会放大一些。也可以使用缩放工具在图像上拖拉矩形框将矩形框中的部分放大。

·按住空格键＋Command键（Mac OS）/空格键＋Ctrl键（Windows），不论当前正在使用何种工具，都会临时切换到缩放工具。

使用苹果电脑的用户，切换中英文输入状态的快捷键是先按住Command键，然后按空格键。如果在Photoshop环境中临时切换到缩放工具，应先按住空格键，再按Command键，以免和切换中英文输入的操作冲突。

将图像缩小显示

·双击工具箱中的缩放工具，就可将图像以100%大小显示。

·选择工具箱中的缩放工具，按住Option（Mac OS）/Alt（Windows）键，缩放工具中出现减号的标志，成为缩小工具，每单击一次图像，图像就会缩小一些。

·按住空格键＋Option键（Mac OS）/空格键＋Alt键（Windows），不论当前正在使用何种工具，都会临时切换到缩小工具。

（4）使用画笔工具，将工具箱中的前景色设定为黑色，在红色的“膜”覆盖的区域上绘制，使小丑鱼身上蓝色的部分绘满。不用担心绘制的笔触会超出小丑鱼的身体之外，可以将工具箱中的前景色切换为白色，将绘出边缘的蓝色部分擦除回来。

（5）继续使用画笔工具，将小丑鱼的蓝色部分绘制，比较细的部位，可以在画笔调板中切换较小的画笔进行操作。可以随时单击工具箱中的标准模式图标，观看选区的变化。如果想继续修改，可随时再切换回快速蒙版状态。

当已经将小丑鱼身上需要绘制的蓝色绘制后，可切换回标准模式。双击工具箱中抓手工具，使全部图像都显示在窗口中。

（6）可以在快速蒙版模式下执行“文件>存储”命令将文件存储起来，当下次打开图像文件的时候，制作的快速蒙版依然保留。如果切换到标准模式下执行存储命令，当下次打开文件的时候，选区一定会丢失。

第6章：Adobe Photoshop CS文字图层
文字转换


     

6.2.2 文字转换

创建文字图层后，可以更改文字方向，可以在点文字与段落文字之间转换；可以像处理正常图层那样移动、重新排放、拷贝；可以更改文字图层的图层选项，也可以对文字图层做以下更改并且仍能编辑文字。

·执行“编辑>变换（Edit>Transform）”命令。“透视（Perspective）”和“扭曲（Distort）”除外。

若要应用“透视”和“扭曲”命令，或要对文字图层中的一部分执行“变换”命令，必须执行“图层>栅格化>文字（Layer>Rasterize>Type）”命令栅格化文字图层，使文字无法编辑。

·使用图层样式。

·使用填充快捷键。若要用前景色填充，请按 Option+Delete（Mac OS）/Alt+Backspace （Windows）键 ；若要用背景色填充，请按Command+Delete （Mac OS）/Ctrl+Backspace （Windows）键 。

·对文字执行文字弯曲变形操作。

◆文字图层转换为图像图层

在Photoshop软件中，可以将创建的文字图层转变为图像图层后执行各种滤镜的效果。

首先在图层调板中选择文字图层，然后选择“图层>栅格化>文字（Layer>Rasterize>Type）”命令，可看到图层调板上文字图层缩览图上的T字母消失了，也就是文字图层变成了普通的像素图层，此时图层上的文字就完全变成了像素信息，不能再进行文字的编辑，但可以执行所有图像可执行的命令。但文字图层所用的图层样式并不受影响，在文字图层转化为图像图层后仍然可以进行修改。

◆文字图层转换为工作路径或形状

下面根据实例进行讲解。

（1）如图6-30所示，输入的一些文字用了符号字体，并执行了阴影效果。
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图6-30 图6-31

（2）在图层调板中选中文字图层，如图6-31所示然后选择“图层>文字>创建工作路径（Layer>Type>Creat Work Path）”命令，可以看到文字上有路径显示（见图6-32），在路径调板中看到一个根据文字图层创建的工作路径，如图6-33所示。但工作路径的创建对原来的文字图层并没有任何影响。
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图6-32 图6-33

（3）可以在图层调板中创建一个新的图层，如图6-35所示创建了“图层2”为新图层。选中这个新图层，然后在路径调板中给路径描边，效果如图6-34所示。
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图6-34 图6-35

（4） 再次选中图层调板中的文字图层，为了不影响对后面操作结果的观察，可将“图层2”图层隐藏。选择“图层>文字>转化为形状（Convert to Shape）”菜单命令，在图层调板中可看到文字图层转变成了形状图层（见图6-36）。左侧的图标表示形状图层的填充颜色，右侧的图标表示图形的形状，在路径调板中可看到临时的矢量蒙版所表示的路径（见图6-37）。
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图6-36 图6-37

在路径上放置文字


     

6.2.3 在路径上放置文字

可以使用钢笔、直线或形状等工具绘制路径，然后沿着该路径键入文本。路径没有与之关联的像素。可以将它想像为文字的模板或引导线。例如，要使文本成球形分布，可以使用椭圆工具围绕该球形绘制一条路径，然后在该路径上键入文本。 操作方法如下所示。

（1）选择适当的工具：钢笔工具、直线工具、自由钢笔工具或某种形状工具。在工作区顶部的选项栏中，选择“路径”按钮 ，然后绘制希望文本遵循的路径。 （见图6-38）

[image: image86.jpg]



图6-38

当使用钢笔或直线工具创建路径时，文字将沿着绘制路径的方向排列，当到达路径的末尾时，文字会自动换行。如果从左至右绘制路径，则可以获得正常排列的文字。如果从右至左绘制路径，则会得到反向排列的文字。

（2）在“字符”调板中选择字体和文本的其他文字属性。 在工具箱中选择所需的文字工具。横排文字将与路径垂直，垂直文字将与路径平行。指针将变为一个带有横线的 I 型光标 。横线标记文字的基线，即字母所依托的假想线。

（3）调整指针的位置，将“I”型光标的基线置于路径上，然后单击鼠标左键，这时路径上会出现一个插入点。

（4）键入所需的文本 （图6-39）。

[image: image87.jpg]



图6-39

（5）获得满意的文本后，按 Ctrl + Enter组合键 （Windows） 或 Command + Return 组合键 （Mac OS）即可。

文字图层效果


     

6.2.4 文字图层效果

前面已经讲过，文字图层和其他图层一样可以执行各种“图层样式（Layer Style）”中定义的各种效果，也可以使用“样式”调板中的存储的各种样式。而且这些效果在文字进行像素化或矢量化之后，仍然保留，并不受影响。图6-40所示的是执行一些图层样式后的文字效果。[image: image88.jpg]
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图6-40

第7章：Adobe Photoshop CS图层样式
图层效果(1)


     

7.2 图层效果

在“图层样式（Layer Style）”对话框中可设定10种不同的图层效果，可以将这些图层效果任意组合成各种图层样式，存放在“样式（Style）”调板中随时调用。

这10种效果分别为：“投影”--在图层内容背后添加阴影；“内阴影”--添加正好位于图层内容边缘内的阴影，使图层呈凹陷的外观效果；“外发光”和“内发光”--在图层内容边缘的外部或内部增加发光效果；“斜面和浮雕”--将各种高光和暗调组合添加到图层中；“光泽”--在图层内部根据图层的形状应用阴影，一般可创建光滑的磨光效果；“颜色叠加”、“渐变叠加”和“图案叠加”-- 在图层上叠加颜色、渐变或图案；“描边”--使用颜色、渐变或图案在当前图层的对象上描画轮廓，它对于硬边形状（如文字）特别有用。

在“图层样式”对话框中进行以上效果设定的时候，有一些共同的选项，也有一些各自不同的选项。下面将分别讲解。

7.2.1 投影和内阴影

“投影”（见图7-44）和“内阴影”（见图7-45）有两点不同：在“投影”设定选项中的“扩展（Spread）”项，在“内阴影”中是“阻塞（Choke）”。在“投影”中有“图层挖空投影（Layer Knocks Out Drop Shadow）”选项，而“内阴影”没有。“投影”和“内阴影”的效果如图7-46所示。
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图7-44 图7-45

“结构（Structure）”一栏中有下列选项。

混合模式（Blend Mode）：其后的弹出菜单中可选择不同的作用模式，通常情况下软件内定的模式产生的效果最理想。在模式的后面有一个小的方形色块，表示阴影的颜色，用鼠标单击，就会弹出调色板，选择新的阴影颜色后，单击“好”按钮就可以更换成新的颜色。

混合模式确定图层效果与其下图层的混合方式，不一定包括当前图层。例如，内阴影与当前图层混合，但投影只与当前图层下的图层混合。

不透明度（Opacity）：用来设定图层效果的不透明程度，可直接输入数字，或用鼠标拖动滑动栏中的三角滑钮来改变透明度。

角度（Angle）：用来设定效果应用于图层时所采用的光照角度。“使用全局光（Use Global Light）”是一个非常有用的选项，可使照在图像上的光源外观保持一致，保证了所有图层效果的光线一致。此选项内定状态下是选中的。

距离（Distance）：用来设定阴影偏移的距离。

扩展（Spread）：模糊之前扩大投影的边界。这对于小的细微特写特别有用，如连笔字中的字母下部或字母上部，在模糊程度较大时该部分几乎无法看到。

阻塞（Choke）：模糊之前收缩内阴影的边界。

大小（Size）：用来设定阴影模糊的程度。

“扩展”和“阻塞”的范围与“大小”的数值大小相关。“大小”的数值大，“扩展”和“阻塞”的范围也大，反之亦然。
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投影效果 内定设置的内阴影效果 内定设置的投影+内阴影效果

图7-46

品质（Quality）一栏中有下列选项。

第7章：Adobe Photoshop CS图层样式
图层效果(2)


     

等高线（Contour）：其使用给阴影带来丰富的变化。可以使用软件中存储的等高线设置，也可以自定义等高线。如果要新建或编辑现有的等高线，可通过以下步骤完成。

（1）在图层样式对话框中，单击“等高线”图标右边向下的小黑三角，弹出“等高线”调板（见图7-47），选中一个现有的等高线，再次单击“等高线”图标右边向下的小黑三角将调板关闭，在“等高线”后面出现新选中的等高线。双击此等高线图标，弹出“等高线编辑器（Contour Editor）”对话框（见图7-48）。
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 INCLUDEPICTURE "http://act.it.sohu.com/book/data/book/49/549/07.files/Digest7-12_19.jpg" \* MERGEFORMATINET [image: image98.jpg]



图7-47 图7-48

（2）在“等高线编辑器”对话框中，也可以在“预设（Preset）”后面的弹出菜单中选择一种等高线作为编辑的基础。

（3）在“映射（Mapping）”框中编辑等高线所对应的曲线，曲线的横坐标表示输入阶调，纵坐标表示输出阶调。调整的方法与“曲线”基本相似。

单击等高线上已有的点，或在等高线上单击鼠标增加新的点，然后通过拖移进行调整。也可以在​“输入（Input）”或“输出（Output）”后面的框中输入数字。

若要创建尖角而不是平滑曲线，在等高线上选择某点后将“边角（Corner）”选项选中。

（4）编辑完成后，单击“好”按钮则新的设定将取代旧的等高线设定。

（5）在“等高线编辑器”对话框中单击“新建”按钮则可以新增一个等高线，可以给它确定一个名字，然后进行编辑。若要将等高线存储成等高线文件，以备后用，单击“等高线编辑器”对话框中的“存储”按钮。也可以通过“载入”按钮载入其他存好的等高线文件。

许多相关的命令也可以单击图7-47所示的等高线调板的右上角的小三角，在弹出的菜单命令中进行选择。

消除锯齿：混合等高线的边缘像素使边缘更加光滑，对尺寸小且具有复杂等高线的阴影最有用。

在“投影”中使用等高线可在给定范围内定形阴影的外观。例如，线性等高线使不透明度在线性转换中减弱，而各种自定等高线可用于创建独特的阴影转换。

在其他的图层效果中也可用到等高线的设定，在“投影”、“内投影”、“内发光”、“外发光”、“斜面和浮雕”以及“光泽”等效果中定形某一效果的外观。如等高线使用纯色发光时，可创建透明光环；使用渐变填充发光时，可创建渐变颜色和不透明度的重复变化；使用斜面和浮雕时，等高线将勾画在浮雕处理中被遮住的隆起、凹陷和凸起；使用暗调时，等高线可指定渐隐。

杂色：用来控制加入阴影中颗粒的数量。

图层挖空投影：用于设定是否将投影与半透明图层间进行挖空。

在“等高线”弹出调板中选择 [image: image99.jpg]'y



，得到如图7-49a、b、c、d所示的结果。
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a投影效果 b内阴影效果

[image: image102.jpg]




 INCLUDEPICTURE "http://act.it.sohu.com/book/data/book/49/549/07.files/Digest7-12_24.jpg" \* MERGEFORMATINET [image: image103.jpg]



c投影效果 d投影+内阴影效果

（增加了投影偏移的距离） （杂色=100%）

图7-49

第8章：Adobe Photoshop CS矢量图形和矢量蒙版
矢量图形和矢量蒙版的基本操作(1)


     

8.1 矢量图形和矢量蒙版的基本操作

通过本课程，将会了解如下内容：

·使用矢量蒙版（Vector Mask）控制图层中显示的内容。

·使用矢量图形和矢量蒙版创建一个标志（Logo）。

·在 Photoshop中使用文字并将文字转换为矢量蒙版。

8.1.1 起步

在开始这一课之前，需要将Adobe Photoshop的设置恢复到软件默认的状态。

在Photoshop中选择“文件>打开”命令，打开如图8-1所示的文件，观看一下制作完成的文件。
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图8-1

通常情况下，在不同的电脑之间，尤其是不同的电脑平台之间（如Windows和Mac OS）传送文件时，在打开文件时会出现更新文字图层的提示框。通常需要单击“更新（Update）”按钮。

8.1.2 创建标志

通常情况下，标志（Logo）需要在随意缩放的同时，又能保持边缘的清晰，所以要用到路径来创建图形，并用“矢量蒙版（Vector Mask）”控制图形在图层中的显示内容。

◆使用“形状”作为图案底色

在一个新的图层上创建一个“形状（Shape）”，“形状”会自动填充当前工具箱中的前景色，可以改变它的填充颜色，也可以使用渐变或图案。“形状”的轮廓线存储在图层矢量蒙版中，在路径调板中可以看到，通过编辑“形状”的图层矢量蒙版，可以改变其轮廓线。

（1） 选择“文件>新建”命令，在弹出的“新建”对话框中进行设定：（高度：350像素，宽度：470像素），分辨率为72像素/英寸，模式为RGB，内容为白色），单击“好”按钮创建一个新文件。

（2） 在“颜色（Color）”调板中，分别输入图8-2所示的RGB的颜色值，产生一个灰色。
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图8-2

（3） 在工具箱中选择矩形形状工具，并选择“形状图层”图标（[image: image106.jpg]


）（见图8-3）。直接用鼠标单击此图标就可以将其选中，图标凹进表示选中，单击相临的其他图标就可以取消此图标的选择状态。
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图8-3

（4） 在创建的新文件上用鼠标拖拉，创建一个灰色的矩形（见图8-4）。在图层调板中可看到一个新的名称为“形状1”的形状图层，左边的图标表示整个图层填充了灰色的前景色，右边的图标显示了图层的矢量蒙版，白色表示图形中显示的区域，黑色（图层调板中用深灰色）表示图形不显示的部分。在路径调板中可以看到有一个临时的用斜体字表示的矢量蒙版，和图层调板中的图层矢量蒙版完全相同。
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图8-4

◆从“形状图层”中减去其他形状

创建了形状图层以后，可设定选项从现有的形状中减去其他的矢量形状。也可以用工具箱中的路径选择工具（黑色箭头）和直接选择工具（白色箭头）来移动、缩放和编辑形状。

（1）选择工具箱中的圆形形状工具。在工具选项栏中选择“从形状区域减去”图标（见图8-5）。
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图8-5

（2）在图形上拖拉绘制圆形块，圆形块的颜色是挖空后露出的白色背景（见图8-6），为了保证绘制的是正圆形，在绘制的过程中需按住Shift键。

（3） 在工具箱中选择“路径选择工具”（见图8-7），将圆形块选中，然后在按住Option（Mac OS）/Alt（Windows）键的同时拖拉圆形块，就可将其复制。用同样的方法复制另外的两个圆形块（见图8-8）。
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图8-6 图8-7 图8-8

矢量图形和矢量蒙版的基本操作(2)


     

（4）将上方一排圆形块全部选中，在“路径选择工具”的选项栏中（见图8-9），单击“顶对齐”图标（[image: image113.jpg]


），然后单击“水平居中分布”图标（[image: image114.jpg]


），将多个圆形块分布均匀。
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图8-9

（5）用同样的方法复制另外的圆形块并排列整齐（见图8-10）。在“路径选择工具”的选项栏中单击“组合”按钮，将圆形块的边缘的黑线取消，表明取消其操作状态（见图8-11）。如果想恢复其操作状态，在“图层”调板中单击图层矢量蒙版的图标即可。
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图8-10 图8-11

◆从填充的路径中创建形状

在前面的操作中我们已经学会了利用形状工具创建形状图层，下面将学习使用形状工具创建路径形状。

（1） 在图层调板中，单击“创建新的图层”按钮，在图层调板上就会出现一个名称为“图层1”的空图层（见图8-12）。
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图8-12 图8-13

（2）选择工具箱中的“钢笔工具”如图8-13所示，将LOGO的轮廓勾勒出来（见图8-14）。

（3）执行“图层>新填充图层>纯色”命令，弹出“新图层”设置对话框（见图8-15），点击“好”按钮，路径即可转换成填充图层（见图8-16）。
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图8-14 图8-15
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图8-16

第9章：Adobe Photoshop CS图像色彩的校正
色阶


     

9.1 色阶

选择“图像>调整>色阶”命令，会弹出“色阶（Levels）”对话框（见图9-2），此图是根据每个亮度值（0～255阶）处像素点的多少来划分的，最暗的像素点在左面，最亮的像素点在右面。“输入色阶（Input Levels）”用于显示当前的数值，“输出色阶（Output Levels）”用于显示将要输出的数值。
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图9-2

在“色阶”对话框中不仅可选择合成的通道进行调整，而且可选择不同的颜色通道来进行个别的调整。如果要同时调整两个通道，首先按住Shift键在通道调板中选择两个通道，然后再选择“色阶”命令。

可使用“输入色阶”来增加图像的对比度，直方图下面左边的黑三角用来增加图像中暗部的对比度，右边的白色三角用来增加图像中亮部的对比度，中间的灰色三角用来控制Gamma值，Gamma值用来衡量图像中间色调的对比度，调整Gamma值时同时还可改变图像中间色调的亮度值，但不会对暗部和亮部有太大影响，调整数值在0.1～9.99之间。“输入色阶”后面的3个数值和下面三角的位置相对应。

使用“输出色阶”可降低图像的对比度，黑三角用来降低图像中暗部的对比度，白三角用来降低图像中亮部的对比度，“输出色阶”后面的数值和下面三角的位置相对应。

举例来说，假设一幅图像包含0～255阶的所有像素点，若要增加图像的对比度，将“输入色阶”的黑三角拖到40，那么原来亮度值为40的像素都变为0，并且比40高的像素点也被相应地减少了像素值，这样做的结果是图像变暗，并且暗部的对比度增加（见图9-3）。
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图9-3

另一方面，假设要减小图像的对比度，将“输入色阶”的白三角拖到230处，那么原来亮度值为255的像素都变为230，并且比230低的像素点也被相应地减少像素值，这样做的结果是图像变亮，并且亮部的对比度增加（见图9-4）。
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图9-4

在“通道”弹出菜单中可以选择要调整的图像，即可针对RGB或CMYK等混合通道，也可选择单一通道进行调整。

利用“色阶”对话框中的3个吸管工具（[image: image129.jpg]PV



）直接单击图像，可以在图像中以取样点作为图像的最亮点、灰平衡点和最暗点（注：Lab色彩模式的图像不能使用中间的灰色吸管）。

执行任何一个色彩调整命令，均可将其设定完成的数值存储以待下次使用，可以在对话框内单击“存储”按钮来存储，若要再次应用只需单击“载入”按钮即可载入。

调整过程中如果对调整的结果不满意，请按住键盘上的Option（Mac OS）/Alt（Windows）键，此时对话框中的“取消”按钮会变成“回复（Reset）”按钮，单击“回复”按钮可将图像还原到初始状态。

◆自动颜色校正选项

当选择“图像>调整>色阶或曲线”命令时，在弹出的对话框中有一个“选项”按钮，单击此按钮，就会弹出“自动颜色校正选项（Auto Color Correction Options）”对话框（见图9-5）。
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图9-5

在“自动颜色校正选项”对话框中可自动调整图像整个的色调，可以给暗调、中间调和高光指定颜色，并可以定义“剪贴（Clipping）”的黑色和白色像素的百分比。可以在“色阶”或“曲线”对话框中单独设定每次的执行情况，也可以将设定存储起来用于“色阶”、“自动色阶”、“自动对比度”、“自动颜色”和“曲线”命令。

在“算法（Algorithm）”一栏中有3个选项用来设定色调调整的方式。

·增强单色对比度（Enhance Monochromatic Contrast ）：统一修剪所有通道，在使亮调更亮，暗调更暗的同时，保持整体的颜色关系。“自动对比度”命令使用这种运算方式。

·增强每通道的对比度（Enhance Per Channel Contrast ）：将每个通道的色调范围最大化以进行最大程度的校正。因为每个通道分别调整，此算法可能会引起一些色偏。“自动色阶”命令使用这种算法。

·查找深色与浅色（Find Dark & Light Colors）：在图像中寻找平均最亮和最暗的像素，并在最小化修剪的同时使用它们的像素值将对比度最大化。“自动颜色”命令使用这种算法。

如果想让Photoshop寻找一个平均的接近图像中间色的颜色，并调整Gamma值使颜色平均，可选择“对齐中性中间调（Snap Neutral Midtones）”选项。“自动颜色”命令使用这种算法。

在“剪贴”后面的数值框中可设定剪贴黑色和白色像素的程度。建议使用0.5% ～1%之间的数值。

根据默认情况，Photoshop修剪黑色和白色像素的比例是0.5%，也就是说，当定义图像中最亮和最暗的像素的时候，它忽略极端的前0.5%，这样可保证白色和黑色值具有代表性。

给图像的最暗、中间和最亮的区域分配像素，可单击不同的色块。

将当前“色阶”或“曲线”对话框中的设置存储起来，单击“自动颜色校正选项”对话框中的“好”按钮，在以后使用到“色阶”或“曲线”命令时，当单击“自动”按钮，就会执行相同的设定。

选中“存储为默认值（Save as Defaults）”选项，然后单击“好”，可将此处的设定存储为Photoshop默认的设定，“色阶”或“曲线”、“自动色阶”、“自动对比度”和“自动颜色”都使用此处的设定。

第11章：Adobe Photoshop CS滤镜的特殊效果
扭曲


     

11.4 扭曲

“扭曲（Distort）”滤镜用于将图像进行几何扭曲，创建 3D 或其他整形效果，如图11-4所示。
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原图 扩散亮光（Diffuse Glow） 置换（Displace）
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玻璃（Glass） 海洋波纹（Ocean Ripple） 挤压（Pinch）（数量=+100）

[image: image137.jpg]
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挤压（Pinch）（数量=-100） 极座标（Polar Coordinates） 波纹（Ripple）
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切变（Shear） 球面化（Spherize） 旋转扭曲（Twirl）
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波浪（Wave）（正弦） 波浪（Wave）（三角形） 波浪（Wave）（方形）
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水波（ZigZag）（围绕中心） 水波（ZigZag）（从中心向外） 水波（ZigZag）（水池波纹）

图11-4

以下是关于扭曲滤镜的几点说明。

（1）关于“置换（Displace）”滤镜

“置换”滤镜的使用比较特殊，它需要与另一幅被称为置换图的图像配合使用，并且该置换图必须是以Photoshop格式存储的。这样，在“置换”滤镜的使用过程中，置换图中的形状会以图像的变形效果表现出来。当选择置换命令时，会弹出如图11-5所示的对话框。
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图11-5

“水平比例（Horizontal Scale）”与“垂直比例（Vertical Scale）”表示图像根据置换图颜色移动的距离。填入100%时，置换图中纯黑和纯白的区域将沿水平方向或垂直方向移动128个像素点，其中黑色向右向下移动，白色向左向上移动，而中性灰区域没有变化。如果置换图中存在非中性的灰色区域，中性灰之上或之下的每个亮度值将移动一个像素点。如果将水平或垂直比例中的一个数值设为0，则图像只在一个单一方向上移动。

另外，图像的位移还会受置换图通道数目的影响。当置换图为单通道的灰度模式时，位移即按上述方式进行；而任何一个含有多个通道的置换图，包括各种彩色模式的图像以及含有选区通道的灰度模式图像，使用位移滤镜时，其第一个通道中的黑白变化都会成为水平方向的位移（黑色向右、白色向左），而第二个通道的黑白变化会成为图像垂直方向的位移（黑色向下、白色向上）；而其余通道的变化不会影响位移的效果，位图（Bitmap）模式的图像不能作为置换图。

置换图（Displacement Map）可以有两种方式：“伸展以适合（Stretch to Fit）”和“拼贴（Tile）”，它们用于置换图与原图像大小不一时的情况。“伸展以适合”可以使置换图产生伸缩变形，与原图像的大小相配合；“拼贴”则会将置换图的效果重复排列在结果图像当中。

对于“未定义区域（Undefined Area）”有两个选项：“折回（Wrap Around）”用图像中对边的内容填充未定义空白；“重复边缘像素（Repeat Edge Pixels）”按指定方向扩展图像边缘像素的颜色。如果边缘像素颜色不同，可能会出现色带。关于在其他滤镜命令中出现的“未定义区域”，设定和此处相同。(源码网整理：www.codepub.com)
将“置换”对话框设定完成后，单击“好”按钮，就会弹出“选择一个置换图”对话框，在此对话框中选择置换图。Photoshop软件提供了一个专门的文件夹用来存放置换图，如图11-6所示。
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图11-6

（2）关于“切变（Shear）”滤镜

在“切变”滤镜对话框中，有一个可任意加减点，并可用鼠标任意调整的曲线来控制变形的形状和程度。

（3）关于“波浪（Wave）”滤镜

“波浪”滤镜用来产生一种波纹传递的效果，其控制参数较多，包括“生成器数（Number of Generators）”、“波长（Wavelength）”、“波幅（Amplitude）”以及可以选择的波浪类型：“正弦（Sine）”、“三角形（Triangle）”或“方形（Square）”。按对话框中的“随机化（Randomize）”按钮则可使波浪纹路随机分布，如图11-7所示。
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图11-7

第13章：Adobe Photoshop CS/ImageReady CS网页和动态图形
创建翻转按钮


     

13.3 创建翻转按钮

在ImageReady中 ，可以从切片或图像映射（Image Map）区域创建翻转（Rollover）或次级翻转（Secondary Rollover）按钮。翻转是一种具有多个显示状态的按钮，当在翻转按钮上移动鼠标或单击时，会引发不同的显示或动作。当在翻转按钮上单击鼠标时，次级翻转将影响图像其他区域的显示或动作。

图像映射可将图像的一个区域链接到URL。可以在一个图像中建立多个链接区域（这些链接区域被称为图像映射区域）链接到文本文件、其他图像、视频或多媒体文件以及其他网站的页面等，也可以在图像映射区域创建翻转效果。

使用图像映射和使用切片创建链接的主要不同之处:使用图像映射保持输出图像是一个完整的文件。使用切片会导致图像输出时成为一个分离的文件。另外一个不同的是图像映射可让链接到图像的一个圆形、多边形或矩形区域，而切片只能让链接到矩形的区域。如果只需要链接到矩形区域，那么使用切片比使用图像映射更好。

可以按这个顺序创建不同的Rollover状态类型:指向（Over）、按下（Down）、点按（Click）、移出（Out）、松开（Up）、自定（Custom）和无（None）。

指向（Over）:表示当Web浏览者使用鼠标经过切片或图像映射区域时的状态，此时并没有按下鼠标键（“指向”是自动被选中的第二个翻转状态）。

按下（Down）:表示当Web浏览者在切片或图像映射区域上按下鼠标键的状态（只要浏览者一直在这个区域上按着鼠标，这一状态就会一直保留）。

点按（Click）:表示当Web浏览者在切片或图像映射区域单击鼠标时的状态（浏览者单击鼠标后，这一状态会一直保留到浏览者激活另一个翻转状态为止）。

移出（Out）:表示当Web浏览者将鼠标从切片或图像映射区域上移开时的状态（正常状态通常扮演这一角色）。

松开（Up）:表示当Web浏览者在经过切片或图像映射区域时松开鼠标时的状态（“指向”状态通常扮演这一角色）。

自定（Custom）:表示一个新的翻转状态（必须创建JavaScript编码并将其添加到Web页面的HTML文件中，以保证自定义翻转选项起作用。参照有关JavaScript手册来获取更多的信息）。

无（None）:表示保存图像当前的状态以备以后作为一个翻转状态使用（被设计为“无”的状态将不会在Web页中显示）。

备注:不同的Web浏览器或不同版本的浏览器可能在处理单击和双击时会不同。例如，一些浏览器在一个单击动作后将切片保留在“点按（Click）”状态，并在一个双击动作后将切片保留在“松开（Up）”状态。其他一些浏览器无论单击还是双击，只将“松开（Up）”状态作为一个过渡到“点按（Click）”的状态。为了保证Web页面显示功能正常，一定要在不同的浏览器中预览该翻转效果。

下面举例说明翻转按钮的制作和应用。

（1）设置按钮的外形

在Photoshop中创建一个新的图层文件，尺寸大小为475X85像素，使用形状图层工具来建立按钮的形状，并复制两个副本，将这3个形状图层进行对齐和分布，并分别命名为：Normal、Over、Down。图层中显示状态如图13-5所示，目前它们的外观是一样的（见图13-6）。
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图13-5 图13-6

（2）“Over”样式的制作

选中Over图层，为按钮添加样式。单击图层调板上的添加图层样式按钮（[image: image154.jpg]


），依次添加投影、内阴影、内发光、斜面和浮雕、光泽、颜色叠加以及图案叠加等样式，各个样式的参数设定参见图13-7至图13-14，最后的样式效果如图13-15所示。这就是后面要用到的“Over”样式。
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图13-7 图13-8
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图13-9 图13-10
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图13-11 图13-12
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图13-13 图13-14
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图13-15

（3）“Normal”样式的制作

将上一步骤得到的图层样式添加到样式调板中。可以通过直接单击样式调板的空白处或者单击样式调板下方“创建新样式”按钮，得到新的样式（见图13-16），直接将新存储的样式应用到Normal图层上，并将图层的不透明度调整为36%（见图13-17），效果如图13-18所示。这就是后面要用到的“Normal”样式。
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图13-16 图13-17 图13-18

（4）“Down”样式的制作

将新存储的样式应用到Down图层上，并通过改变“颜色叠加”样式中的颜色（见图13-19），可得到新的“Down”样式（见图13-20）。
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图13-19 图13-20

（5）在ImageReady中保存样式

为了将Photoshop中制作的样式变成预设的翻转样式，必须将文件调入到ImageReady中，单击工具栏最底部的[image: image169.jpg]


按钮，跳转到ImageReady中，依次选中每一个图层，将图13-22所示的3个图层样式添加到“样式”调板中（见图13-21），并分别命名为“Normal”，“Over”和“Down”样式。
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图13-21 图13-22

（6）创建翻转按钮

保留Normal图层，将Over图层和Down图层删除。选中Normal图层，选择“图层>新建基于图层的切片”命令（见图13-23），在“Web内容”调板中，单击调板下方的“创建翻转状态”按钮，得到一个Over状态按钮（见图13-24）。
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图13-23 图13-24 图13-25

将前面制作的Over样式应用到该处的Over状态按钮上。

再次选中Normal图层，选择“图层>新建基于图层的切片”命令，在“Web内容”调板中，单击调板下方的“创建翻转状态”按钮，将前面制作的Down样式应用到该处的Down状态按钮上。（见图13-25）。

（7）储存翻转按钮

将图层切片的翻转效果储存在“样式”调板中，成为一个翻转样式，在存储时会弹出一个“样式选项”对话框（见图13-26），可用来输入名称设定相关的选项。

注意：“样式”调板中“图层样式”和“翻转样式”的表示区别在于：“翻转样式”有一个黑色的小三角，而“图层样式”没有（见图13-27）。
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图13-26 图13-27

（8）应用翻转按钮

在ImageReady中新建一文件，制作3个不同的按钮，其中每个按钮都在单独的图层上（见图13-28）。并在样式调板中选择前面制作好的翻转样式（见图13-29）。可使用工具栏内的预览按钮（[image: image177.jpg]


）进行效果预览。
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图13-28
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图13-29

（9）保存按钮

选择“文件>将优化结果储存为”命令，在“将优化结果储存为”对话框中，保存类型选择“HTML和图像”（见图13-30）。并使用Internet Explorer来浏览制作完成的HTML文件（见图13-31）。
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图13-30
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图13-31

第13章：Adobe Photoshop CS/ImageReady CS网页和动态图形
动画


     

13.4 动画

动画是指在一段时间内显示的一系列图像或帧。每一帧较前一帧有轻微的变化，当连续、快速地显示这些帧时会产生运动的错觉。

一个图像可以具有与不同翻转状态关联的多个动画。例如，将一个动画添加到“Normal”翻转状态，可在 Web 页初次由 Web 浏览器载入时播放。将动画添加到另一翻转状态，可使动画仅在 Web 用户执行指定动作（如将鼠标放置到翻转上或点按翻转）时播放。

13.4.1 过渡和调整

“过渡”（tweening） 这一术语从 in betweening 变化而来，后者是用于描述这一过程的传统动画术语。“过渡”命令大大减少了创建动画效果（如渐现、渐隐或在帧之间移动图素）所需的时间。创建过渡帧之后，可以分别对它们进行编辑。下面举例说明。

（1）在Photoshop中新建一个背景文件，大小为350X100像素，将背景填充为深蓝色；然后新建一图层，在图层里用直线套索工具画出两个房子的造型，并填充颜色。然后使用文字工具在图像的右上角添加文字“Merry Christmas!”（见图13-32），并将文字图层再复制两个，3个图层分别命名为Merry Christmas! 1、 Merry Christmas! 2、Merry Christmas! （见图13-33）。
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图13-32 图13-33

（2）将制作好的图像跳转到ImageReady中，打开动画调板，将第一帧进行复制，得到两帧相同的动画（见图13-34）。选择第2帧，在图层调板中，将Merry Christmas! 1图层用移动工具向左移动至隐藏、 Merry Christmas! 2图层用移动工具向上移动至隐藏、 Merry Christmas! 3图层用移动工具向右移动至隐藏（见图13-35、图13-36）。

（3）将动画调板中“A”、“B”两帧位置进行互相调换（见图13-37），在图层调板中，将3个文字图层的填充不透明度都改为0%（见图13-38）。
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图13-34 图13-35

[image: image186.jpg]




 INCLUDEPICTURE "http://act.it.sohu.com/book/data/book/49/549/13.files/Digest13_30.jpg" \* MERGEFORMATINET [image: image187.jpg]



图13-36 图13-37
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图13-38 图13-39

（4）在动画调板中，按住Shift键将“A”和“B”两帧一并选中，单击动画调板中的过渡按钮（[image: image190.jpg]


），在弹出的对话框中进行过渡的设置（见图13-39），选择要添加过渡的帧数，以及所要过渡的图层是所有图层还是当前图层，以及位置、不透明度、效果的过渡等。单击“好”按钮，这样就完成了文字渐渐从3个方向向一个位置的集中，文字从透明变实心的动画过程，也就是图13-40中所示从“A”到“B”的过渡。
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图13-40

Photoshop CS教程
第1章 预备
1.1 平面设计基本常识(1)


     

平面设计应用的领域非常广泛，随着平面设计的飞速发展，越来越多的人加入了这一行列当中。没有系统地学过造型基础知识和接受专业训练的人，在创作中可能会感到力不从心。我想很多人会遇到这样的情况：创作过程中，本来在大脑里构思得很好，但在实际操作过程中却不能恰当地用图形、图像、文字等艺术语言来表达自己的想法，因此要使用Photoshop进行平面设计，读者除了要全面掌握Photoshop的功能外，还应简单了解一些有关平面设计的基本常识。只有将两者很好地结合起来，才能设计出好的作品。
1.1.1  打开创意之门
所谓创意是指创造性的构思，那么，就平面设计而言，什么样的作品才算是一幅好的作品呢？一般来讲，评价一幅平面设计作品的标准通常有如下几个。
  作品是否较好地表达了主题。例如，要设计一个产品广告，设计者应该清楚，自己的作品从哪些方面充分反映了产品的特点。
  作品是否为受众所喜爱。正如大多数产品都有特定的用户一样，大多数平面设计作品也都有特定的对象（称为受众）。因此，一幅好的平面作品应该得到大多数受众的喜爱。
  作品是否有新意。对于一个企业来说，不创新即意味着死亡。对于平面设计作品来说，是否有新意也是评价作品是否成功的重要标准。
那么，一个好的创意从何而来呢？首先，作者应具有较好的专业素养，这样才能做到“厚积而薄发”；其次，作者应具有敏锐的观察力。俗话说得好，处处留心皆学问。美术创作与一般的科学研究不同，它在很大程度上取决于所谓的灵感，而灵感则源于对事物的细致观察，以及对主题的深刻认识。例如，图1-1所示的两幅作品就非常有特色。
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图1-1  作品赏析
1.1.2  典型的表现手法
要使用平面设计作品表现同一个主题，根据各人的生活环境、对问题的理解的不同，大家所使用的手法也各有千秋。但是，这并不是说就无规律可循。
一般来讲，要表现一个主题，通常可使用如下几种手法。
  层次与对比：通过恰当地运用图形和元素之间的层次感，可以在干扰视觉的同时，突出自身所想体现的主题，这种表现方式往往是比较直接而且有效的方式。对比是另一类常用的表现手段，如正反对比、大小对比、粗细对比、明暗对比、色彩对比、动静对比等，如图1-2所示。
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图1-2  层次与对比
  运用抽象：在进行平面设计时，恰当地运用抽象，有时也能起到事半功倍的效果。例如，大家都非常喜欢的漫画、卡通，实际上就是一种抽象的表现方式。
  突破常规比例：突破事物本身的等比关系，进而推出自身的视觉重点以求突破。就如一些夸张漫画那样，一个大头小身子的人物形象、一种夸张的歪曲正常比例的方式，在不经意间往往能收来奇效，如图1-3所示。此外，用户在设计作品时还可充分运用重复、连续、距离、透视、光影效果、形象比喻、空间表达等手段，如图1-4所示。
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图1-3  突破常规比例                          图1-4  其他表现手段
1.1 平面设计基本常识(2)


     

1.1.3  色彩的基本知识
平面设计中很讲究色彩的运用，通过颜色的冷暖、强弱变化产生色彩的韵律，以达到画面的和谐统一。
1．颜色三要素
  色相：指色彩的不同相貌。
  明度：指色彩的明暗深浅程度。
  纯度：指色相的鲜艳程度。
2．颜色的基本类型
  三原色：指三种颜色，将它们以适当比例混合，可以得出全部色彩，并且它们自身不能被别的色彩调合而成。红橙、绿、蓝紫三种颜色为光中的三原色，黄、品、青为颜料中的三原色。
  间色与复色：三原色中任何两种原色混合，则成为间色，又称为第2次色。两种间色相混合，调成的颜色称为复色。使用三种颜色按不同的比例混合，亦可调出复色。
  同种色：在同一种颜色中加入不等量的黑色或白色，所产生的深浅浓淡不同的颜色，称为同种色。如：深红、大红、粉红。
  同类色：两种以上的颜色，其主要的色素倾向比较接近，都含有同一色素的颜色称为同类色。如：柠檬黄、淡黄、中黄、土黄，可称为同类色，朱红、大红和玫瑰红，可以称为同类色，湖蓝、群青、酞菁蓝、普蓝也可以称为同类色。
  类似色：含有少量共同色素的，在色相上互相邻边的各种颜色称为类似色。如：红与橙，黄与绿，青与紫等。
  对比色：在色相上相对应的颜色（包括其邻近的颜色）称对比色，例如：绿对应红（包含相邻的红橙、黄绿色），黄对应紫（包含相邻的黄橙、蓝紫）。
  补色：亦称强对比色，在色相环上，任何直径两端相对的色称为补色。最强的补色对比在色环上有三对，即黄与紫、橙与蓝、红与绿。
3．色彩的对比
色彩的对比可分为同时对比和继续对比两类。同时对比指色彩的对比，即两种以上的色彩并置在一起所形成的对照现象。同时对比又分为以下几种。
  色相对比：如果将两块相同的橙色分别放在黄色底上和红色底上，则红底上的橙色偏黄，黄底上的橙偏红。红绿并置，则红的更红，绿的更绿。
  明度对比：如果将两块灰色分别放置于黑底和白底上，黑底上的灰显得亮，而白底上的灰则显得暗。
  彩度对比：当鲜艳的颜色和灰色并置时，鲜艳的色就会显得更鲜艳，灰暗的色就会变得更灰暗。
  冷暖对比：如橙色与蓝色并置，橙色会显得更暖，蓝色则更冷。
  面积对比：面积大小不同的色并置，大面积的色容易形成调子，小面积的色易突出。
继续对比指先看了一个颜色后，再看另一个颜色。因前色的影响使后色起了变化。当我们看了黑底上的红色图形再看白墙时，则白墙更白，红色图形变成了青绿色图形。如果看了红色再看黄色，黄色便变成了黄绿色（混合了红色的补色——绿色）。
4．色彩的联想
色彩本身并无感情，是由于人们对某些事物的联想所形成的。
联想：指由这一事物想到另一事物的心理过程，它是以过去的经验、记忆为基础的。由于民族、地区、职业、年龄、性别、文化程度等条件不同，各人的联想不相同。联想又分为具体联想与抽象联想，抽象联想较多地出现于成人中，如表1-1所示。
表1-1  色彩的联想
	             类别
颜色
	颜色的具体联想
	颜色的抽象联想

	红
	太阳、血、红旗、
	热情、活力、热烈、喜庆

	黄
	香蕉、柠檬、月亮
	光明、希望、辉煌、欢快

	蓝
	天空、大海、水
	安静、永恒、理智、冷酷

	绿
	树叶、田野、森林、草地
	和平、希望、青春


1.1.4  文字设计方面的知识
文字设计是广告设计的一个重要组成部分，像报纸广告和杂志广告就是由文字与插图两个要素组成的。文字设计的好坏，直接影响到画面的视觉传达。
1．广告设计中对文字设计的要求
（1）文字的易辨性：传达信息是文字的主要功能，设计文字时应避免繁杂零乱，不要进行毫无意义的装饰变化，使人易认易懂才是文字设计的根本目的，这样才能有效地传达广告的信息。
（2）文字的个性：文字的设计要和产品的风格、特性相统一，不能相互脱离和冲突。
图1.5中举了两个关于广告中的文字设计的例子，供大家参考。
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图1-5  广告中的文字设计
根据文字字体的特性和使用类型，大致分为下列几种。
  端庄典雅型：字体优美清新，格调高雅。此种个性的字体，适用于女性饰品、化妆品等广告。例如，宋体、拉丁文的新罗马体。
  坚固挺拔型：字体造型富于力度，给人以简洁爽朗的现代感，有较强的视觉冲击力。这种个性的字体，适用于家电、摄影器材等广告主题中。例如，仿宋体、拉丁文的古罗马体等。
  深沉厚重型：字体造型规整，具有重量感，庄严雄伟，给人以不可动摇的感觉。这种人性的字体，适用于工程机械、车辆等广告主题。例如，黑体、拉丁文的无饰线体等。
  欢快轻盈型：字体生动活泼，跳跃明快，有鲜明的节奏韵律感，给人以生机盎然的感受。这种个性的字体适用于儿童用品、旅游产品等广告主题。例如，楷书、拉丁文的意大利斜体等。
  古朴型：字体朴素无华，能给人一种对逝去时光的同味体验。这种个性的字体适用于传统产品，如生产历史悠久的名酒等广告主题。例如，书法字体、草书体等。
  新颖奇特型：字体造型设计奇妙，不同一般，个性突出，给人一种强烈的独特印象和刺激感。这种个性的字体适用于创新产品和流行产品的广告等主题，如手机、玩具等。例如：各种变形体。
（3）文字的形式美：文字必须要有视觉上的美感，使消费者看后感到愉快，留下美好深刻的印象，获得良好的心理反应。
（4）文字设计的创造性：与众不同的字体给人以耳目一新的感觉，有利于树立产品的良好形象。在设计时要避免与同类产品广告的字体相同或相似，更不能仿造或抄袭。要在现有的文字基础上，进行反复的修改和揣摩，创造富有个性的文字。
2．对文字进行排列与组合时应注意的问题
  要适应人们的阅读习惯。
  要考虑字体的形状特征。
  要确定总体的设计风格。
  注重空白的作用。
1.1.5  版面编排
版面的编排也是设计中的重要部分之一，好的版面编排能给人一种美的享受，图1-6中列举了几种常用的版面编排，以供大家参考。
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大小                   重复                    粗细                    镜相 
图1-6  版面编排
广告讲究大胆、创新，想常人想不到的招式来表达主题，千万不要让上面的理论知识束缚了你的创作灵感。
1.2 Photoshop CS功能概览(1)


     

Photoshop之所以深受欢迎，主要是因为它具有良好的操作环境和强大的功能。例如，用户可方便地进行“抠图”，可使用图层、图层蒙版、滤镜快速制作各种效果，使用图像修饰工具对图像进行各种修饰，还可使用绘画工具进行绘画等。
1.2.1  增强的文件浏览器
在Photoshop CS中，文件浏览器的功能被大大增强，如图1-7所示。利用旗帜、关键字和文件名、创建日期、修改日期、图像格式等可编辑元数据（Metadata），用户可快速组合和查找所需图像，还可在不打开图像文件的情况下对一组图像进行批处理操作。
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图1-7  文件浏览器
1.2.2  良好的操作环境
在Photoshop中，系统提供了一个工具箱和众多的调板。同时，选中某个工具后，还可利用工具属性栏快速设置工具属性。其工作界面如图1-8所示。而利用系统提供的功能强大的历史调板，用户可随时撤销前面执行的任何操作。
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图1-8  Photoshop的工作界面
1.2.3  强大的“抠图”功能
“抠图”是进行图像处理的一项基本功能，为此，Photoshop提供了众多手段来辅助“抠图”。首先，系统提供了多种选区制作工具，如 [image: image211.jpg]


（矩形）、[image: image212.jpg]


（椭圆）、[image: image213.jpg]


 与 [image: image214.jpg]


（单行像素）、[image: image215.jpg]


（套索）、[image: image216.jpg]


（多边形套索）、[image: image217.jpg]


（磁性套索）、[image: image218.jpg]


（魔棒）；还提供了多种选区编辑命令，例如，可根据颜色制作选区、缩放选区、对选区进行各种运算、保存和安装等。例如，在图1-9中，用户可利用磁性套索工具 [image: image219.jpg]


 方便地选出画面中的花朵。
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图1-9  强大的“抠图”功能
1.2.4  图层的运用
图层是图像处理的一个最有效的手段，当用户对一个图层进行处理时，不影响其他图层中的图像。此外，还可通过为图层增加各种效果、调整图层的色彩混合模式与不透明度、为图层增加蒙版等手段，快速设计各种作品。例如，在图1-10中，我们仅仅通过创建一个新的渐变色图层，并调整其色彩混合模式，即完全改变了图像的风格。
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图1-10  图层的运用
1.2 Photoshop CS功能概览(2)


     

1.2.5  绘画与修饰
Photoshop提供了功能强大的路径和形状绘制工具，利用这些工具可快速绘制各种卡通、标志和沿路径排列的文本等，如图1-11所示。
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图1-11  利用路径工具绘制的卡通画、标志和路径文本
利用Photoshop提供的各种图像修饰工具与色彩调整命令，用户可方便地对图像进行各种修饰。例如，在图1-12中，用户只要用颜色替换工具 [image: image229.jpg]


 在图像的指定区域进行涂抹，即可在保留图像纹理和阴影不变的情况下快速改变图像区域的颜色。
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图1-12  利用颜色替换工具 [image: image233.jpg]


 变换服装颜色
1.2.6  图像的色彩校正
Phtoshop提供了众多的色彩校正命令，用户既可对偏色、太亮或太暗的图像进行校正，也可根据需要调整图像的色彩、色调、亮度、对比度等。例如，利用Photoshop CS新增的用于快速调整图像颜色的Match Color（匹配颜色）命令，可对两幅图像的颜色进行匹配，如图1-13所示。
1.2.7  花样繁多的滤镜
滤镜在Photoshop中也占据着重要的位置，因此，系统提供了包括滤镜画廊、美术效果、模糊、扭曲、风格化、噪声、渲染等种类繁多的滤镜。利用滤镜可快速制作出各种特殊效果，如图1-14所示。
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图1-13  利用颜色匹配调整图的颜色
[image: image237.png]Bawt






 INCLUDEPICTURE "http://act.it.sohu.com/book/data/book/90/390/390/01.files/image053.jpg" \* MERGEFORMATINET [image: image238.jpg]


   [image: image239.jpg]



图1-14  对图像执行水波滤镜
1.2.8  制作网页图像与动画
随着网页的流行，几乎所有的软件都在向Internet靠拢，Photoshop自然也不例外。现在，用户可利用Photoshop制作和优化网页图像，并可利用其姊妹软件ImageReady制作简单的动画，并可将制作的动画输出为Flash的.swf格式等。
1.3 图像处理的基本概念(1)


     

在了解了有关Photoshop的基本功能之后，为了便于后面的学习，让我们再来一起熟悉一些有关图像处理的基本概念。
1.3.1  矢量图与点阵图
所谓矢量图是指使用线条绘制的各种图形，由于图形在存储时保存的是其形状和填充属性，因此，其优点是占用的空间小，且放大后不会失真（也就意味着与分辨率无关），如图1-15所示。但是，图形的缺点是色彩比较单调。
顾名思义，点阵图是指以点阵方式保存的图像。由于系统在保存点阵图时保存的是图像中各点的色彩信息，因此，其优点是画面细腻，它主要用于保存各种照片图像。但是，点阵图的缺点是文件尺寸太大，且和分辨率有关。因此，将点阵图的尺寸放大到一定程度后，图像将变得模糊，如图1-16所示。
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图1-15  矢量图                                  图1-16  点阵图
在Photoshop中，系统可同时处理输入的点阵图像，以及使用路径和形状工具绘制的矢量图形。但是，如果在文件中包含了矢量图形，必须以Photoshop本身的PSD格式保存文件。否则，矢量图形将被转换为点阵图。
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在Photoshop中，文字也是矢量图形。
 

1.3.2  颜色模式
颜色模式决定了用于显示和打印图像的颜色模型，它决定了如何描述和重现图像的色彩。常见的颜色模型包括HSB（色相、饱和度、亮度）、RGB（红色、绿色、蓝色）、CMYK（青色、品红、黄色、黑色）和CIE L*a*b*等，因此，相应的颜色模式也就有RGB、CMYK、Lab等。此外，Photoshop 也包括了用于特别颜色输出的模式，如Grayscale（灰度）、Index Color（索引颜色）和Duotone（双色调）。
1．RGB颜色模式
我们知道，利用红（Red）、绿（Green）和蓝（Blue）三种基本颜色进行颜色加法，可以配制出绝大部分肉眼能看到的颜色。彩色电视机的显像管，以及计算机的显示器都是以这种方式来混合出各种不同的颜色效果的。
Photoshop将24位RGB图像看做由三个颜色通道组成。这三个颜色通道分别为：红色通道、绿色通道和蓝色通道。其中每个通道使用8位颜色信息，该信息是由从0到255的亮度值来表示的。这三个通道通过组合，可以产生1 670余万种不同的颜色。由于用户可以从不同通道对RGB图像进行处理，从而增强了图像的可编辑性。
2．CMYK颜色模式
CMYK颜色模式是一种用于印刷的模式，分别是指青（Cyan）、品红（Magenta）、黄（Yellow）和黑（Black）。该颜色模式对应的是印刷用的四种油墨颜色，其中，将C、M、Y三种油墨颜色混合在一起，印刷出来的黑色不是很纯正。为了使印刷品为纯黑色，所以将黑色并入了印刷色中，以表现纯正的黑色，还可以借此减少其他油墨的使用量。
CMYK模式在本质上与RGB颜色模式没有什么区别，只是产生色彩的原理不同。由于RGB颜色合成可以产生白色，因此也称它们为加色，RGB产生颜色的方法称为加色法。而青色（C）、品红（M）和黄色（Y）的色素在合成后可以吸收所有光线并产生黑色，这些颜色因此被称为减色，CMYK产生颜色的方法称为减色法。
在处理图像时，我们一般不采用CMYK模式，因为这种模式的图像文件占用的存储空间较大。此外，在这种模式下，Photoshop提供的很多滤镜都不能使用，因此，人们只是在印刷时才将图像颜色模式转换为CMYK模式。
3．Lab颜色模式
Lab颜色模式是以一个亮度分量L（Lightness），以及两个颜色分量a与b来表示颜色的。其中，L的取值范围为0~100，a分量代表由绿色到红色的光谱变化，而b分量代表由蓝色到黄色的光谱变化，且a和b分量的取值范围均为120~120。
Lab颜色模式是Photoshop内部的颜色模式。由于该模式是目前所有模式中色彩范围（称为色域）最广的颜色模式，它能毫无偏差地在不同系统和平台之间进行交换，因此，该模式是Photoshop在不同颜色模式之间转换时使用的中间颜色模式。
4．Multichannel模式
将图像转换为Multichannel（多通道）模式后，系统将根据原图像产生相同数目的新通道，但该模式下的每个通道都为256级灰度通道（其组合仍为彩色）。这种显示模式通常用于处理特殊打印，例如，将某一灰度图像以特别颜色打印。
如果用户删除了“RGB颜色”、“CMYK颜色”、“Lab颜色”模式中的某个通道，该图像会自动转换为Multichannel模式。
5．Indexed颜色模式
为了减小图像文件所占的存储空间，人们设计了一种Indexed颜色模式。将一幅图像转换为Indexed模式后，系统将从图像中提取256种典型的颜色作为颜色表。将图像转换为Indexed 颜色模式后，Image → Mode菜单下的Color Table菜单项被激活，选择该菜单项可调整颜色表中的颜色，或选择其他颜色表。
Indexed颜色模式在印刷中很少使用。但是，这种模式可极大地减小图像文件的存储空间（大概只有RGB模式的三分之一），同时，这种颜色模式在显示上与真彩色模式基本相同。因此，这种颜色模式的图像多用于制作多媒体数据。
6．Grayscale模式
Grayscale图像中只有灰度信息而没有彩色，Photoshop将灰度图像看成只有一种颜色通道的数字图像。
7．Duotone模式
彩色印刷品通常情况下都是以CMYK四种油墨来印刷的，但也有些印刷物，例如名片，往往只需要用两种油墨颜色就可以表现出图像的层次感和质感。因此，如果并不需要全彩色的印刷质量，可以考虑利用双色印刷来节省成本。
Duotone模式与Grayscale模式相似，是由Grayscale模式发展而来的。但要注意，在Duotone模式中，颜色只是用来表示“色调”而已，因此，在这种模式下，彩色油墨是用来创建灰度级的，而不是创建彩色的。
当油墨颜色不同时，其创建的灰度级也是不同的。通常选择颜色时，都会保留原有的灰色部分作为主色，将其他加入的颜色作为副色，这样才能表现出较丰富的层次感和质感。
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要将图像转换为Duotone模式，必须首先将图像转换为Grayscale模式，然后再由Grayscale模式转换为Duotone模式。
8．Bitmap模式
要将文字或漫画等扫描进计算机，一般可以将其设置成位图形式。这种形式通常也被称为“黑白艺术”、“位图艺术”或“一位元艺术”。
Bitmap模式适合于那些只由黑白两色构成而且没有灰色阴影的图像。按这种方式扫描图像的速度快，并且产生的图像文件小、易于操作，但它所获取的原图像信息很有限。
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要将图像转换为Bitmap模式，必须首先将图像转换为Grayscale模式，然后再由Grayscale模式转换为Bitmap模式。
9．颜色模式的选择
在Photoshop中，系统推荐使用RGB颜色模式，因为只有在这种模式下，用户才能使用系统提供的所有命令与滤镜。因此，用户在进行图像处理时，如果图像的颜色模式不是RGB的话，可首先将其颜色模式转换为RGB模式，然后进行处理。处理结束后，再根据需要将其转换为相关模式。例如，如果图像文件用于彩色印刷，则应在处理结束后将其颜色模式转换为CMYK。
颜色模式除了用于确定图像中显示的颜色数量外，还影响通道数和图像的文件大小。例如，一个Grayscale（灰度）模式的图像要比RGB彩色模式的图像尺寸小得多，并且Grayscale模式图像只包含一个通道，而RGB彩色模式包含三个通道。
此外，选用何种颜色模式还与该图像文件所使用的存储格式有关。例如，用户无法将使用CMYK颜色模式的图像以BMP、GIF等格式保存。
1.3 图像处理的基本概念(2)


     

1.3.3  色域和溢色
色域是颜色系统可以显示或打印的颜色范围。人眼看到的色谱比任何颜色模型中的色域都宽。在Photoshop使用的各种颜色模型中，Lab具有最宽的色域，它包括了RGB和CMYK色域中的所有颜色，如图1-17所示。
	CMYK色域


	 


	RGB色域


	 


	Lab色域
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图1-17  色域
通常情况下，对于可在计算机显示器或电视机屏幕（它们发出红、绿和蓝光）上显示的颜色，RGB色域包含了这些颜色的子集。但是，某些颜色（如纯青或纯黄）无法在显示器上精确显示。
CMYK色域较窄，仅包含使用印刷色油墨能够打印的颜色。当不能打印的颜色显示在屏幕上时，称其为溢色，即超出CMYK色域之外。在Photoshop中，当用户选取的颜色超过选定的CMYK色域时，系统将会给出一个警告性标记[image: image249.jpg]


。单击该标记，系统将自动选取一种与该颜色最相近的颜色。
1.3.4  图像文件的格式
在进行图像处理时，采用什么格式保存图像与图像的用途是密切相关的。例如，如果希望将图像作为网页素材，则应将其保存为具有很高压缩比的JPG格式。如果希望将图像用于彩色印刷，则应将其保存为PSD格式。
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图像文件的格式由文件的扩展名标识。
 

但是，大多数的图像格式都不支持Photoshop的图层、通道、矢量元素等特性，因此，如果希望能够继续对图像进行编辑，则应将图像以PSD格式保存，然后可根据需要将其另存为其他格式。
下面简要介绍一下目前流行的几种图像文件格式的特点。
1．Photoshop（*.PSD）
此格式是Photoshop本身专用的文件格式，也是新建文件时默认的存储文件类型。此种文件格式不仅支持所有模式，还可以将文件的图层、参考线、Alpha通道等属性信息一起存储。该格式的优点是保存的信息多，缺点是文件尺寸较大。
2．BMP（*.BMP）
BMP是Windows操作系统中“画图”程序的标准文件格式，此格式与大多数Windows和OS/2平台的应用程序兼容。该图像格式采用的是无损压缩，因此，其优点是图像完全不失真，其缺点是图像文件的尺寸较大。
BMP格式支持RGB、索引（Indexed）、灰度（Grayscale）及位图（Bitmap）等颜色模式，但无法支持含Alpha通道的图像信息。
3．JPEG（*.JPG）
JPEG是一种压缩效率很高的存储格式，但是它采用的是具有破坏性的压缩方式，因此，该格式仅适用于保存不含文字或文字尺寸较大的图像。否则，将导致图像中的字迹模糊。就目前来说，以JPEG格式保存的图像文件多用于作为网页素材的图像。
JPEG格式支持CMYK、RGB、灰度等颜色模式，但不支持含Alpha通道的图像信息。
4．GIF（*.GIF）
GIF格式为256色RGB图像，其特点是文件尺寸较小，支持透明背景，特别适合作为网页图像。此外，还可利用ImageReady制作GIF格式的动画。
5．TIFF（*.TIF）
TIFF格式也是一种应用非常广泛的图像文件格式，它支持包括一个Alpha通道的RGB、CMYK、Grayscale模式，以及不含Alpha通道的Lab Color、Indexed Color、Bitmap模式，并且可以设置透明背景。
6．Photoshop PDF（*.PDF）
该格式是由Adobe公司推出的专为网上出版而制订的。它以PostScript Level 2语言为基础，可以覆盖矢量式图像和点阵式图像，并且支持超级链接。
PDF格式是由Adobe Acrobat软件生成的文件格式，该格式可以保存多页信息，其中可以包含图形和文本。此外，由于该格式支持超级链接，因此是网络信息交流经常使用的文件格式。
PDF格式支持RGB，Indexed，CMYK，Grayscale，Bitmap和Lab等颜色模式，但不支持Alpha通道。
1.3.5  像素与图像分辨率
为了制作高质量的图像，用户必须理解图像的像素数据是如何被测量与显示的，这里主要涉及如下几个概念。
  像素大小：图像的像素大小是指位图在高、宽两个方向的像素数。
  图像分辨率：图像的分辨率是指打印图像时，在每个单位长度上打印的像素数，通常以“像素／英寸”（pixel/inch，ppi）来衡量。
  显示器分辨率：在显示器中每个单位长度显示的像素或点数，通常以“点／英寸”（dpi）来衡量。显示器的分辨率依赖于显示器尺寸与像素设置，PC计算机显示器的典型分辨率通常为96dpi，Mac OS显示器的典型分辨率通常为72dpi。
  打印机分辨率：与显示器分辨率类似，打印机分辨率也以“点／英寸”来衡量。如果打印机分辨率为300dpi~600dpi，则图像的分辨率最好为72ppi~150ppi；如果打印机的分辨率为1200dpi或更高，则图像分辨率最好为200ppi~300ppi。
通常情况下，如果希望图像仅用于显示，可将其分辨率设置为72ppi或96ppi（与显示器分辨率相同）；如果希望图像用于印刷输出，则应将其分辨率设置为300ppi或更高。
1.3.6  色相、饱和度、亮度与色调
在各种颜色模型中，HSB模型以人类对颜色的感觉为基础，描述了颜色的3种基本特性。
  色相是从物体反射或透过物体传播的颜色。在0°到360°的标准色轮上，按位置度量色相。通常情况下，色相由颜色名称标识，如红色、橙色或绿色。
  饱和度（又称彩度）是指颜色的强度或纯度。饱和度表示色相中灰色分量所占的比例，它使用从0%（灰色）至100%（完全饱和）的百分比来度量。在标准色轮上，饱和度从中心到边缘递增。
  亮度是颜色的相对明暗程度，通常使用从0%（黑色）至100%（白色）的百分比来度量。
图像的色调通常是指图像的整体明暗度，例如，如果图像亮部像素较多的话，则图像整体上看起来较为明快。反之，如果图像中暗部像素较多的话，则图像整体上看起来较为昏暗。对于彩色图像而言，图像具有多个色调。通过调整不同颜色通道的色调，可对图像进行细微的调整。
第2章 Photoshop CS基本操作
2.1 认识Photoshop CS的操作环境(1)


     

启动Photoshop CS后，用户将看到如图2-1所示的屏幕组件。如果读者对Windows操作系统比较熟悉或者使用过Office、WPS等软件的话，要理解Photoshop的界面元素，应该是非常容易了。
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图2-1  Photoshop CS的工作环境
2.1.1  程序窗口和图像窗口
在Photoshop中，用户可以同时打开多个图像文件，因此，其中就包含了多个图像窗口。用户可分别控制程序窗口和图像窗口的状态（最小化、最大化、关闭），但由于程序窗口是父窗口，所以对图像窗口的调整受限于程序窗口。
2.1.2  主菜单和快捷菜单
和所有Windows应用软件的使用界面一样，Photoshop CS中也包括了一个提供主要功能的主菜单。要打开某项主菜单，既可使用鼠标单击该菜单项，也可同时按Alt键和菜单名中带下划线的字母键，例如，要打开Layers菜单，可按Alt+L组合键。对于子菜单而言，其约定规则如下：
  菜单项呈暗灰色时，表明该菜单项在当前状态下不可使用。
  如果菜单名后跟“►”符号，说明该菜单项下还有子菜单。
  如果某个子菜单项后跟“…”符号，说明单击该菜单项将打开一个对话框。
  如果某个子菜单项后跟一组合键（称为菜单快捷键），说明用户可不必打开主菜单，直接按该组合键即可执行命令。
  要切换菜单，在各菜单项上移动鼠标即可。
  要关闭所有已打开的菜单，可单击已经打开的主菜单名称，按Alt键或F10键。要逐级向上关闭菜单，可按Esc键或切换主、次菜单。
  与大多数应用软件一样，为了方便用户操作，Photoshop CS还提供了另一类菜单，即快捷菜单。要打开快捷菜单，单击鼠标右键即可，如图2-2所示。
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图2-2  在图像编辑窗口打开快捷菜单
对于快捷菜单而言，有如下几点值得说明：
  对于不同的状态，系统所打开的快捷菜单不同。
  快捷菜单中的大多数选项均可在主菜单中找到。
  根据不同的编辑状态，快捷菜单中的某些菜单项可能被暂时禁用。
  仍可根据快捷菜单项后面是否跟有“…”或“[image: image253.jpg]


”符号，确定单击该菜单项是否可打开对话框或该菜单项后是否跟有子菜单。
  要关闭快捷菜单，可按Esc键、Alt键或F10键。
请不要轻易通过单击快捷菜单区域外位置来关闭快捷菜单，这将取消当前选区设置。基于同样的道理，关闭主菜单时也应注意这一点。
2.1 认识Photoshop CS的操作环境(2)


     

2.1.3  工具箱与工具属性栏
Photoshop CS的工具箱中包含了40余种工具，大致可分为选区制作工具、绘画工具、修饰工具、颜色设置工具，以及显示控制工具等几类，如图2-3所示。
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图2-3  Photoshop CS工具箱中的工具
要使用某种工具，只需单击该工具即可，例如，要想制作选区，可单击矩形选框工具，然后在图像窗口中拖动光标选择所需区域。工具箱中某些工具右下角有一个小三角形符号“[image: image255.jpg]


”，这表示在该工具位置上存在一个工具组，其中包括了若干相关工具。要选择工具组中的其他工具，可单击该工具图标并按住鼠标按钮不放，然后在打开的相应子工具弹出框中选择相应工具即可，如图2-4所示。
[image: image256.jpg]



图2-4  选择工具组中的其他工具
要移动工具箱，可将鼠标定位在工具箱上方的蓝条上，然后拖动鼠标即可。要关闭工具箱和所有调板，可按Tab键。再次按Tab键，将重新显示工具箱和所有调板。
选择某个工具后，系统将在工具属性栏区域显示该工具的相应参数。用户可在该工具属性栏中进行参数的调整，如果希望保存当前参数设置状态，可按如下步骤进行操作。
（1）在工具属性栏中设置完工具属性后，单击属性栏左边的小三角符号，这时将弹出参数预置面板。如图2-5所示。
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图2-5  参数预置面板
（2）在参数设置面板中单击 [image: image258.jpg]


 按钮，将弹出New Tool Preset对话框。在Name栏中输入新建工具参数的名称，如图2-6所示。
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图2-6  New Tool Preset对话框
（3）输入完毕，单击OK按钮，此时参数预置面板中将出现新建工具参数的名称，如图2-7所示。
如果希望下次使用前面保存的参数预置，可首先参照前面介绍的步骤打开参数预置面板，然后单击选择参数预置名称。
如果要复位当前工具参数或全部工具参数，可在打开的参数预置面板中单击 [image: image260.jpg]


 按钮，然后从弹出的下拉菜单中选择Reset Tool或Reset All Tools命令，如图2-8所示。
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图2-7  设置后的参数预置面板
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图2-8  复位当前工具参数或全部工具参数
2.1 认识Photoshop CS的操作环境(3)


     

2.1.4  调板
调板是Photoshop中一项很有特色的功能，用户可利用调板的导航显示，观察编辑信息，选择颜色，管理图层、通道、路径、历史记录、动作等。
Photoshop CS为用户提供了16个调板，它们被组合放置在6个调板窗口中。要打开／隐藏调板窗口，可在Window菜单中选择未打钩的选项打开调板窗口，如图2-9左图所示；选择Window菜单中打钩选项可隐藏调板窗口，单击调板右上角的 [image: image263.jpg]


 按钮也可以关闭组合调板窗口，如图2-9右图所示。
按Shift+Tab组合键可在保留工具箱的情况下，显示或隐藏所有调板。
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图2-9  打开／隐藏调板的显示
默认情况下，调板被分为6组。不过，用户可根据需要将它们进行任意分离、移动和组合，例如，要使Layers调板脱离原来的组合调板窗口成为独立的调板，可单击Layers标签并拖动到其他位置；要还原Layers调板到组合调板窗口中，只需将Layers调板拖动到组合调板窗口中即可，如图2-10所示。如果用户已经将调板分离，要将调板恢复到原位，可选择Window → Workspace（工作区）→ Reset Palette Locations（复位调板位置）菜单即可。
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图2-10  Layers调板的分离和还原
下面对各调板的作用给出一些简单介绍。
  Navigator（导航）：用于显示图像的缩览图，当图像被放大超出当前窗口时，可打开该调板。此时光标呈[image: image268.jpg]


形状，单击并拖动即可调整图像窗口中所显示的图像区域（位于Navigator调板的预览区中），如图2-11所示。此外，利用预览区下方的滑动条还可缩放图像。
  Info（信息）：用于显示鼠标所在位置的坐标和颜色值。当使用工具制作选区或旋转选区时，还可以显示选区的尺寸和旋转角度。
  Histogram（直方图）：用于检查图像色调范围，图像调整前，应查看图像的直方图，评估图像是否有足够的细节产生高品质的输出。直方图中数值的范围越大，细节越丰富。效果不好的扫描出来的图像和缺少足够细节的照片即使可以校正，也很难处理。过多的色彩校正也可能会造成像素值损失和细节太少。
  Color（颜色）与Swatches（色板）：都用于选择和设置颜色。
  Styles（样式）：用来为创建的图层套用样式，也可以将创建好的图层样式添加到样式库中，以备后用。
  Layers（图层）：用于控制层操作，例如，为图层增加样式，打开、关闭图层样式，调整图层的颜色混合模式、不透明度，新建层、切换层和合并层等。
  Channels（通道）：用来选择、切换、复制或删除图像通道，以及创建、删除、编辑Alpha通道或专色通道等。
  Paths（路径）：用于管理图像路径，例如，将选区转换为路径，对路径进行填充、描边，将路径转换为选区等。
  History（历史记录）：用来管理图像编辑操作记录，例如，撤销前面执行的某些操作，为图像当前状态创建快照等。
  Actions（动作）：用于管理“动作”。例如，执行、录制动作，加载动作文件，复位“动作”调板等。
  Character（字符）与Paragraph（段落）：这两个调板用于设置文字的字符格式和段落格式。
  Tool Presets（工具预置）：用于保存工具预置参数，以便以后使用。
  Brushes（画笔）：用于选择笔刷和设置笔刷特性。
  Layer Comps（图层合并）：它实际上相当于图层状态的快照，它记录了图层的可见性、位置及外观。用户可借助Layer Comps调板创建、应用、观察、更新及恢复图层合并，如图2-12所示。
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图2-11  Navigator调板            图2-12  Layer Comps调板                 

2.1.5  状态栏
状态栏位于窗口底部，它由三部分组成。其中最左侧区域用于显示图像窗口的显示比例，用户也可在此窗口中输入数值后按Enter键来改变显示比例；中间区域用于显示图像文件信息，单击其左侧的小三角“[image: image271.jpg]


”可弹出如图2-13所示的菜单，选择其中的菜单项可查看图像文件信息，各菜单项的意义如下所述。
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图2-13  Photoshop状态栏和弹出式菜单
  Document Sizes（文档容量）：用此方式显示时，在状态栏上有Doc字样，表示当前显示的是图像文件容量。其中左边的数字表示该图像在不含任何图层和通道等数据的情况下的文件容量，右边的数字表示当前图像文件的全部容量，包括图层和Photoshop所特有的数据。
  Document Profile（文档配置文件）：用此方式显示时，在状态栏上将显示文档颜色等文档概貌信息。
  Document Dimensions（文档尺寸）：用此方式显示时，在状态栏上将显示文档尺寸大小。
  Scratch Sizes（暂存盘大小）：用此方式显示时，在状态栏上有Scr字样。其中左边的数字代表图像文件所占用的内存空间，右边的数字代表计算机可供Photoshop使用的内存。
  Efficiency（效率）：选中此方式后，在状态栏上有Eff字样，其中的百分数代表Photoshop的工作效率。如果该数值经常低于60%，则表示你的计算机硬件可能已无法满足要求。
  Timing（计时）：选择此方式后，将以时间单位秒（S）显示执行上一次操作所花费的时间。
  Current Tool（当前工具）：查看当前选中的工具。
如果按住Alt键的同时，在状态栏的图像文件信息区上按下鼠标左键不放，可以查看图像的宽度、高度、通道数、颜色模式、分辨率等信息，如图2-14所示。
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图2-14  查看图像信息
如果不按Alt键，只在状态栏的图像文件信息区上按下鼠标左键不放，则可以查看图像的打印预览情况。其中两条对角线覆盖的区域表示图像的尺寸，灰色的矩形区域代表打印纸张的大小，如图2-15所示。
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图2-15  查看图像的打印预览情况
此外，状态栏最右侧区域用于显示当前工作状态信息和操作时所选工具的提示信息。
2.2 图像文件操作(1)


     

在本节中，我们将向读者介绍一些与文档操作相关的操作，例如，浏览、新建、打开、保存文件，为文件增加注释和版权信息等。
2.2.1  图像文件浏览器
选择File → Browse菜单或Window → File Browser菜单，系统都将打开如图2-16所示的File Browser（文件浏览器）对话框，在该对话框中将显示所有图片文件的缩略图，用户可在对话框左侧的目录树窗口中找到文件所在位置，在右侧缩略图浏览窗口中进行浏览，选中一个图片后，可在图像预览窗口中预览图像，在图像数据窗口读取图像数据，如文件的名称、格式、大小、颜色模式和分辨率等，双击所选图片即可在Photoshop中打开该图片文件。
Photoshop CS中文件浏览器的功能被大大增强。利用旗帜、关键字和文件名、创建日期、修改日期、图像格式等可编辑元数据（Metadata），用户可快速组合和查找所需图像，还可在不打开图像文件的情况下对一组图像进行批处理操作。
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图2-16  File Browser对话框
在文件浏览器窗口中用户可执行如下操作。
  要旋转图像，可单击工具栏中的逆时针旋转按钮 [image: image277.jpg]


 与顺时针旋转按钮 [image: image278.jpg]


 。
  通过为图像增加旗帜标记，对一些常用图像进行标记。要为图像增加旗帜，可在选中希望标记的图像后单击工具栏中的旗帜按钮 [image: image279.jpg]


 ，此时将在图像的右下角出现一个旗帜图标，如图2-17所示。为选定图像增加旗帜标记后，用户此后可利用View→Flagged Files菜单控制主窗口中只显示带有旗帜标记的缩览图，从而方便查找图像。
  如果希望搜索图像，可单击工具栏中的搜索按钮 [image: image280.jpg]


 ，此时系统将打开如图2-18所示的搜索对话框。用户可在此处设置希望搜索的驱动器或文件夹，以及希望搜索的文件名或其他信息，然后单击Search按钮进行搜索。
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           图2-17  为图像增加旗帜标记                       图2-18  搜索对话框
  如果图像不是只读文件，则可通过单击工具栏中的删除按钮 [image: image283.jpg]


 删除选定文件。
  如果用户需要经常使用某些文件夹中的图像，则可通过为该文件夹创建Cache（缓冲）来加快浏览速度。要创建或删除Cache，可选择File菜单中的Build Cache for Subfolders（为当前子文件夹创建Cache）、Export Cache（输出Cache）、Purge Cache（删除Cache）与Purge Entire Cache（删除全部Cache）。
  如果用户希望对某些文件统一执行选定的动作，则可选择Automate → Batch菜单，此时系统将打开如图2-19所示的批处理对话框。在该对话框的Play设置区可选择希望执行的动作，在Source设置区可选择对哪些文件（文件浏览器中的文件、选定文件夹中的文件、导入的文件或当前已经打开的文件）执行批处理操作，在Destination设置区可设置将处理的文件保存至何处（选择None表示只打开和处理文件，暂时不
[image: image284.jpg])
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图2-19  批处理对话框
保存；选择Save and Close表示保存并关闭处理的文件；选择Folder表示将处理的文件保存到指定的文件夹中）。
  如果希望将多幅图像合并到一幅图像中，可首先选择这些文件，然后选择Automate → Photomerge菜单，此时系统将自动对图像进行合并，合并结束后将打开如图2-20所示的Photomerge（图像合并）对话框，用户此时可手工调整各图像的位置、旋转角度。同时，系统会自动在各图像的接缝处进行融合，从而实现无缝合并。单击OK按钮后，系统将自动创建一个新图像文件。
  如果希望在一页纸上打印图像的多份复制，可选择Automate → Picture Package菜单。
  如果希望改变图像的排列顺序，可选择Sort菜单中的适当选项。
  如果希望改变图像的显示形式，可选择View菜单中的适当选项。
  如果希望查看或更新文件信息，可选择File → File Info菜单。
[image: image285.jpg]



图2-20  合并图像
2.2 图像文件操作(2)


     

2.2.2  创建新图像
要创建新图像文件，可选择File → New菜单，此时系统将打开如图2-21所示的New对话框。可通过该对话框设置所要创建新图像文件的尺寸、分辨率、模式和背景颜色。
默认情况下，将创建一个以白色为背景的图像。但是，若在Contents（内容）选区中选择Background Color（背景色）单选钮，则系统将以当前使用的背景色填充新图像；若选择Transparent（透明）单选钮，则系统将创建一个没有颜色值的单层图像。
如果所制作的图像仅用于显示（例如，作为网页图像），可将其分辨率设置为72 ppi或96ppi（像素／英寸）；如果制作的是图书封面、招贴画等希望进行印刷的彩色图像，其分辨率通常应设置为300ppi。
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图2-21  利用“新建”对话框创建新图像文件
2.2.3  保存图像
要保存图像，可选择File → Save菜单或按Ctrl+S组合键。如果该图像为新图像，此时系统将打开如图2-22所示的Save As对话框。用户可通过该对话框设置文件名、文件格式、创建新文件夹、切换文件夹，以及决定以何种方式列表文件。Save Options区域中各复选框的意义如下所述。
[image: image287.jpg]



图2-22  Save As对话框
  As a Copy（作为副本）：为文件保存一份复制，但不影响原文件，例如，对于一幅名为YW.PSD的图像文件，用户可用YW Copy.TIF的名称保存之。以复制方式保存图像文件后，用户仍可继续编辑原文件。
  Annotations（注释）：决定是否保存注释文字或注释声音。如果图像中没有注释，该项将以灰色显示。
  Alpha Channels（Alpha通道）：决定是否在保存图像的同时保存Alpha通道。如果图像中没有Alpha通道，则该项以灰色显示。
  Spot Colors（专色）：决定是否在保存图像时保存Spot Colors通道。如果图像中没有Spot Colors通道，则该项以灰色显示。
  Layers（图层）：选中该项，图像将分层保存。不选中该项，在对话框的底部将显示警告信息，并将所有的层进行合并保存。
  Use Proof Setup    Working CMYK（使用校样设置：处理CMYK）：决定是否使用检测CMYK图像溢色功能。仅当选定PDF格式时，该设置项有效。
  ICC Profile：sRGB IEC61966-2.1：设置是否保存ICC Profile（ICC概貌）信息，以使图像在不同显示器中所显示的颜色相一致。不过，该设置仅对PSD、PDF、JPEG、TIFF、AI等格式有效。
此外，用户还可通过Thumbnail（缩览图）复选框来确定是否保存预览缩览图，这决定着在打开图像时能否在打开对话框中预览图像。
一般情况下，如果是对已有文件进行编辑，则选择File → Save菜单时，系统将不打开Save As对话框。但是，如果对文件进行了某些特殊操作，例如，为一TIF格式的图像文件创建了图层等，由于只有Photoshop的PSD格式图像文件才能保存这些特性，因此，此时系统将打开Save As对话框，且图像格式下拉列表中只能选择PSD格式。
 

此外，用户还可方便地在该对话框或Open对话框中删除、复制、发送、打印、重命名文件。方法是单击鼠标右键选定文件名，然后从打开的快捷菜单中选择适当的选项，如图2-23所示。
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图2-23  对选定的文件进行操作
在编辑图像时，如果不希望对原图像文件进行更改，则可选择File → Save As菜单，将编辑后的图像文件以其他名称保存。
2.2 图像文件操作(3)


     

2.2.4  关闭与打开图像
如果用户不想再继续编辑某个图像，可选择File → Close菜单，Window → Documents → Close All菜单，按Ctrl+W或Ctrl+F4组合键，或单击图像窗口右上角的[image: image289.jpg]


 按钮等操作来关闭图像窗口。
要打开一幅或多幅已经存在的图像，可选择File → Open菜单，此时系统将打开Open对话框。单击要打开的图像文件名，然后单击“打开”按钮或直接双击要打开的图像文件名即可打开选定图像。
要一次打开多个图像文件，可配合Ctrl键和Shift键。其中，要打开一组连续的文件，可在单击选定第一个文件后，按住Shift键不放单击最后一个要打开的图像文件；要打开一组不连续的文件，可在单击选定第一个图像文件后，按住Ctrl键不放，单击选定其他图像文件。最后单击“打开”按钮。
要打开最近打开过的文件可选择File → Open Recent菜单，该菜单最多可列出最近打开过的10个文件，供用户快速选择。
2.2.5  为图像文件增加注释信息
要为图像增加文字注释或语音注释，应首先在工具箱中选择注释工具或语音注释工具，然后在图像窗口单击，接下来利用注释工具属性栏为注释信息设置作者名称、字体、大小及颜色，最后输入注释内容，如图2-24所示。
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图2-24 为图像增加文字注释
此外，要关闭或打开注释标记，可选择View → Show → Annotations菜单。
2.3 控制图像显示


     

在Photoshop的工作区里，用户可以同时打开多个图像窗口，其中，当前窗口将会出现在最前面。根据工作需要，用户可能经常需要移动窗口位置，调整窗口尺寸，改变窗口排列方式或在各窗口之间切换等。为此，本节将简单地向读者介绍一些这方面的情况。
2.3.1  改变窗口的位置和尺寸
当窗口未处于最大化状态时，单击窗口的标题栏位置并拖动即可移动窗口的位置。
要调整窗口的尺寸，用户除了可以利用窗口右上角的“最小化”按钮[image: image293.jpg]


和“最大化”按钮[image: image294.jpg]


外，还可通过将光标置于图像窗口边界（此时光标呈[image: image295.jpg]| P



 形状），然后拖动鼠标来进行调整，如图2-25所示。
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图2-25  调整窗口的尺寸
2.3.2  调整窗口排列和切换当前窗口
当打开了多个图像窗口时，屏幕可能会显得有些零乱。为此，用户可通过选择Window → Documents菜单中的Cascade（层叠）、Tile（拼贴）、Arrange Icons（排列图标）等菜单项来安排图像窗口的显示，如图2-26所示。
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图2-26  多个图像窗口的显示
要在打开的多个窗口间切换，最简单的方法是直接单击想要处理的窗口，使之成为当前窗口。此外，用户也可单击Window菜单中的图像文件名，使该图像窗口成为当前窗口。按下Ctrl+Tab或Ctrl+F6组合键，可在各窗口之间循环切换。
2.3.3  切换屏幕显示模式
我们在前面曾经向读者介绍过，在Photoshop的工具箱中，系统提供了三个显示方式设置工具，其中包括一个标准屏幕模式显示工具 [image: image300.jpg]


 和两个全屏模式显示工具 [image: image301.jpg]


、[image: image302.jpg]


。
默认情况下，系统处于标准屏幕显示模式，即Photoshop窗口中显示所有的屏幕组件。若切换至全屏模式显示，则系统将图像窗口放大到最大。
两种全屏模式之间的区别在于前者同时显示菜单栏，而后者不显示。
 

2.3.4  图像缩放和平移
在处理图像时，用户可能经常会根据需要放大或缩小图像显示。为此，可选用工具箱中的缩放工具 [image: image303.jpg]


，或使用View菜单中的Zoom In（放大）、Zoom Out（缩小）、Fit on Screen（满画布显示）、Actual Pixels（实际像素）、Print Size（打印尺寸）等选项。其中，缩放工具 [image: image304.jpg]


 的用法如下所述。
（1）选定缩放工具后，在图像窗口中单击，即可将图像放大到下一预定比例，此时光标显示为[image: image305.jpg]


；若在选定缩放工具后，首先按住Alt键不放，然后在图像窗口中单击，则将图像缩小到下一预定比例，此时光标显示为[image: image306.jpg]


。
（2）若在选定缩放工具后，在图像窗口中双击，则可将图像按实际像素显示，即显示比例为100%。
（3）若在选定缩放工具后，通过拖动方法在图像窗口中选定某一区域，则该区域将被放大至充满窗口。
不管选用了何种工具，用户均可通过按Ctrl++组合键放大图像显示，按Ctrl+－组合键缩小图像显示。
View菜单中与图像显示调整相关的命令如下所述。
  Zoom In：将图像放大到下一预定比例显示。
  Zoom Out：将图像缩小到下一预定比例显示。
  Fit on Screen：使图像以最合适的比例完整显示。
  Actual Pixels：使图像以100%的比例显示。
  Print Size：使图像以实际打印尺寸显示。
另外一种控制图像显示比例的方法是利用Navigator（导航器）调板，即首先将光标定位在Navigator调板的滑块上，然后左右拖动，如图2-27所示。
 [image: image307.jpg]



图2-27  利用Navigator调板调整图像的显示比例
当图像超出当前显示窗口时，系统将自动在显示窗口中的右侧和下方出现垂直滚动条或水平滚动条。因此，用户可直接借助滚动条在显示窗口中移动显示区域。
此外，还可借助工具箱中的抓手工具 [image: image308.jpg]


 和Navigator调板来改变显示区域。选定抓手工具 [image: image309.jpg]


 后，光标呈[image: image310.jpg]


 形状，在图像显示窗口拖动光标即可改变显示区域，如图2-28所示。
借助Navigator调板，不管用户当前选中的是何种工具，均可随时改变显示区域。其方法是将光标移至Navigator调板的图像显示区，然后按下并拖动鼠标即可，如图2-29所示。
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图2-28  利用抓手工具 [image: image313.jpg]


 改变显示区域     图2-29  利用Navigator调板改变图像显示区域
2.4 调整图像的大小与分辨率


     

在实际工作中，人们经常需要根据情况调整图像尺寸、画布尺寸和图像分辨率。例如，如果希望将图像用于印刷，应将图像的分辨率设置为300dpi。
2.4.1  改变图像尺寸与分辨率
要改变图像的显示尺寸、打印尺寸和分辨率，可选择Image → Image Size菜单，此时系统将打开如图2-30所示的Image Size对话框。
该对话框上方的Pixel Dimensions（像素尺寸）选区显示了图像在屏幕上的显示尺寸，中间Document Size（文档大小）选区显示了图像的打印尺寸和分辨率。
若选中Constrain Proportions（约束比例）复选框，用户在更改图像的宽度或高度时，系统将按比例调整其高度或宽度，以使图像保持宽高比例不变。
若选中Resample Image（重定图像像素）复选框，表示在改变图像显示尺寸时，系统将自动调整打印尺寸，此时图像的分辨率将保持不变。同时，用户还可通过Resample Image复选框后面的下拉框选择插值方法。
[image: image314.jpg]



图2-30  Image Size对话框
若取消Resample Image复选框（禁止采样），则改变图像的分辨率时，图像的打印尺寸将相应改变。
2.4.2  修改画布大小
有时用户可能需要的不是改变图像的显示或打印尺寸，而是对图像进行裁剪或增加空白区。为此，可选择Image → Canvas Size菜单，此时系统将打开如图2-31所示的Canvas Size对话框。
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图2-31  Canvas Size对话框
若设置的尺寸小于原尺寸，则按所设宽度（对应左右侧）和高度（沿上下方向）沿图像四周裁切图像，反之，则在图像四周增加空白区。增加空白区时，背景层的扩展部分可从Canvas extension color下拉列表中选择前景色、背景色和白色等多种颜色填充，其他层的扩展部分将为透明区。
此外，可利用Anchor（定位）区设置图像裁切或延伸的方向。默认情况下，图像裁切或扩展是以图像中心为中心的。若单击右上角的小方格，则裁切或扩展将以图像右上角为起点进行，如图2-32所示。
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图2-32  利用Anchor区设置图像延伸方向扩大画布
2.4.3  利用裁切工具裁切图像
尽管用户可以利用设置画布大小来裁切图像，但这种方式不直观。下面向读者介绍一种更为实用的裁切方法，即使用裁切工具 [image: image318.jpg]


。
要想使用裁切工具 [image: image319.jpg]


 裁切图像，请首先选择该工具，然后在图像中单击裁切区域的第一个角点，并拖动光标至裁切区域的对角点，如图2-33所示。
[image: image320.jpg]



图2-33  定义裁切区域
若在选定裁剪区域的同时按下Shift键，则可选择一个正方形裁剪区域。若同时按下Alt键，则选取以开始点为中心的裁剪区域。若同时按下Shift+Alt组合键，则选取以开始点为中心的正方形裁剪区域。
接下来请按照下述方法移动和调整裁剪区域：
  要移动裁切区域，可首先将光标定位在裁切区域，拖动光标即可。
  要调整裁切区域的尺寸，可将光标移至四周的控制点上，待光标变为“[image: image321.jpg]


”形状后，拖动光标即可。
从图2-33中可以看出，在裁切区域的中心有一个[image: image322.jpg]


标记，该标记被称为旋转支点，即用户在旋转裁切区域时将围绕该点来进行。要移动旋转支点，可首先将光标移至支点附近，待光标变为 [image: image323.jpg]


形状后拖动光标即可；要旋转裁切区域，可首先将光标定位在裁切区域外侧，待光标形状变为“[image: image324.jpg]


”后拖动光标即可。
选定裁切范围后，按Enter键，在裁剪区内双击，选择Image → Crop菜单或单击工具箱中的 [image: image325.jpg]


 工具均可执行裁剪操作。如果希望在选定裁切区域后取消裁切，可按Esc键。
用户也可在使用矩形选框工具 [image: image326.jpg]


 选定区域后，选择Image → Crop菜单进行区域裁切。
 

2.4.4  旋转与翻转画布
通过选择Image → Rotate Canvas菜单中的各子菜单项，可旋转和翻转画布，其效果如图2-34所示。
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                        原图                  旋转180°             顺时针旋转90°                逆时针旋转90°
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原图                      水平翻转                      垂直翻转
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按任意角度旋转画布
图2-34  旋转和翻转画布
当扩展画布时，对于不同图层，画布的扩展部分将以不同内容填充。对于背景图层而言，其扩展部分将以当前背景色填充；对于其他图层，其扩展部分将被设置为透明区。
2.5 操作的撤销和重复


     

图像处理是一项实验性很强的工作，因此用户在进行图像处理时，经常需要撤销或重复所进行的操作，本节就针对撤销和重复操作的方法进行介绍。
2.5.1  利用编辑菜单撤销最近一步操作
用户在进行图像处理时，最近所进行的操作均会出现在Edit菜单中的第一位置上，如图2-35所示。该位置的开始内容为Undo（还原），当执行了某项操作后，它就被替换为“Undo操作名称”。若单击该菜单项，系统将撤销前面所进行的操作，此时菜单项将变为“Redo操作名称”，单击该菜单项则取消的操作又被恢复。
这种方法的缺点是，用户只能撤销最近进行的一步操作，而且有些操作还无法撤销。因此，系统又为Edit菜单增加了Step Backward（向前）和Step Forward（返回）功能。其中，通过选择Step Backward，可逐步恢复被删除的操作；通过选择Step Forward，可逐步回溯删除前面执行的各项操作。
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图2-35  在Edit菜单中操作的撤销和重复
不过，在Photoshop中，处理撤销或重复操作的最有效的方法应该是借助History调板。因此，在下面的小节中将详细介绍History调板的特点与用法。
2.5.2  利用History调板撤销任意操作
History调板如图2-36所示，是一个非常有用的工具。用户可利用它撤销前面所进行的任何操作，并可在图像处理过程中为当前处理结果创建快照，以及将当前处理结果保存为文件。
由图2-36可以看出，History调板主要由快照区、操作步骤区、历史记录画笔和若干按钮组成。下面首先来看一看如何利用History调板来撤销操作。
1．撤销打开图像后所进行的所有操作
当用户打开一个图像文件后，系统将自动把该图像文件的初始状态登录在快照区中，快照名称为文件名。用户只要简单地单击该快照，即可撤销打开文件后所执行的全部操作。
2．撤销指定步骤后所执行的系列操作
要撤销指定步骤后所执行的系列操作，用户只需简单地在操作步骤区中单击该操作步骤即可，这时该操作步骤后面的所有操作都被取消，被取消的操作步骤变成灰色。
3．恢复被撤销的步骤
如果撤销了某些步骤，但又未执行其他操作，用户还可恢复被撤销的步骤，此时只需简单地单击要恢复的一系列步骤中的最后一步，则其前面的所有步骤（包括本步骤）均被恢复。
[image: image338.jpg]



图2-36  History调板
撤销了某些步骤后，如果又执行了其他操作，则新操作将取代在History面板中被撤销的操作步骤。
4．使用快照暂存图像处理状态
所谓快照，实际上就是图像处理的某个状态。创建快照以后，不管以后如何操作（包括撤销和恢复），系统均会保存该状态。
默认情况下，系统会为每个打开的图像文件创建一个快照。要为某个状态的图像创建快照，可在History调板中单击Create new snapshot按钮 [image: image339.jpg]


。其中，创建的第一个快照被称为Snapshot 1，第二个快照被称为Snapshot 2，依次类推。以后要恢复某个保存的快照，只需在History调板的快照区单击该快照即可。
保存文件时不保存快照，因此，关闭文件后快照即消失。
 

 
由于History调板中只能保存有限的操作步骤（默认为20），当操作步骤太多时，将导致无法撤销某些操作。因此，利用快照可克服此问题。
5．为某个状态的图像创建新文件
由于快照只是保存在内存中，因此，如果用户希望永久保存某些图像处理状态，可利用History调板为图像的某些处理状态创建新图像文件。为此，可在History调板中选定某个步骤后，单击面板中的 [image: image340.jpg]


 按钮，系统将以该步骤的名称创建新图像文件，并打开一个新的图像窗口。用户可通过选择File菜单中的Save或Save As选项来保存该文件，如图2-37所示。
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图2-37  为图像处理状态创建的新图像文件
如果不在History调板中选择操作步骤，即表示为图像的当前处理状态创建新图像文件。
6．通过History调板删除操作步骤
要删除某些操作步骤也非常容易，选定这些步骤后，单击History调板中的Delete current state按钮 [image: image342.jpg]


 即可。
2.5.3  利用恢复命令从磁盘上恢复图像
如果用户在处理图像时，中间曾经保存过图像，且其后又进行了其他处理，则选择File → Revert菜单，可让系统从磁盘上恢复最近保存的图像。
2.5.4  利用清理命令清理内存
Photoshop在处理图像时要保存大量的中间数据，如果图像处理较为复杂的话，这些数据量就会非常可观，以致减慢计算机处理图像的速度。为此，可选择Edit → Purge菜单中的选项，来清理、还原剪贴板数据、历史步骤或全部操作。
2.6 设置前景色和背景色的方法


     

用户在处理图像时，不管是进行颜色填充还是在图像上绘画、输入文字或擦除图像，其效果首先取决于当前的颜色设置。例如，假定通过扫描仪输入的某个照片中有污损，便可利用吸管工具（从图像中获取颜色）和其他绘画工具进行修复。
2.6.1  工具箱中的颜色工具
在工具箱中有一个颜色工具，用户可通过该工具设置当前使用的前景色和背景色、切换前景色和背景色，以及恢复默认的颜色设置（前景色为100%黑色，背景色为100%白色），如图2-38所示。
[image: image343.jpg]



图2-38  工具箱中的前景色和背景色设置工具
2.6.2  利用拾色器设置颜色
最常用的设置颜色方法就是利用拾色器进行设置。在工具箱中单击前景色或背景色方块，将打开Color Picker（拾色器）对话框，其设置方法如图2-39所示。
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图2-39  利用颜色拾取器选择颜色
如果当前颜色或选定颜色超出了打印机所能打印的范围即CMYK色域，则对话框中色样的右侧将出现一个溢色警告标志 [image: image345.jpg]


，其下方的小方块显示了与所选颜色最接近的CMYK颜色（该颜色通常要比所选颜色稍暗一些）。单击溢色警告标志 [image: image346.jpg]


，可将此CMYK颜色设置为选定颜色。（对于Web调色板颜色警告标记来说，其意义与其基本相同。）
如果用户单击Color Picker对话框中的Custom（自定）按钮，则系统将打开Custom Color（自定颜色）对话框，用户可从中选择系统提供的色彩体系并设置相应颜色。所选颜色将被编号并能精确地利用C，M，Y，K的不同比例混成，从而为印刷提供方便。
2.6.3  利用颜色调板设置颜色
利用Color调板，用户可轻松地设置当前使用的前景色和背景色。例如，要设置前景色，可首先单击前景色颜色框，然后利用R，G，B滑块调整颜色。当然，也可直接在最下方的颜色样本框中单击获取颜色。
如果用户选定的颜色已超出打印机所能打印的范围，则Color调板中将出现一个溢色警告标志 [image: image347.jpg]


 ，其意义与拾色器对话框中溢色警告标志 [image: image348.jpg]


 相同，如果用户单击Color调板右上角的 [image: image349.jpg]


 标志，系统将打开一个如图2-40所示的快捷菜单。通过选择适当的菜单项，用户可以以其他方式设置颜色。
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图2-40  利用Color调板设置颜色
2.6.4  利用色板调板选择颜色
为了便于用户快速选择颜色，系统还提供了Swatches调板。该调板中的颜色都是预先设置好的，用户可直接从中选取而不用自己配制，如图2-41所示。
用户还可调整Swatches中的颜色，不过，用户此时应首先利用Color调板或Color Picker（拾色器）设置好要添加的颜色，然后按如下方法进行。
  要在Swatches（色板）中添加色样，可将光标移至调板中的空白处，然后单击（此时光标为油漆桶形状），如图2-42左图所示。
  要删除色样，可首先按下Alt键，然后单击要删除的色样方格（此时光标呈剪刀状），如图2-42右图所示。
  若要在指定的色样方格前增加色样，可在按下Alt+Shift键后单击该色样方格。
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图2-41  利用色板调板设置颜色                   图2-42  向色板中增加和删除色样               

  若要替换原有色样，可在按下Shift键后单击要替换的色样方格。
若单击Swatches右上角的 [image: image354.jpg]


 按钮，系统也将打开一个快捷菜单，从中选择适当的菜单项，用户可恢复系统色样配置，装入其他色样配置（加在当前色样配置之后），替换现有色样配置或保存现有色样配置。
2.6.5  使用吸管工具从图像中获取颜色
我们在处理图像时，可能经常需要从图像中获取颜色，例如，要修补图像中某个区域的颜色，通常要从该区域附近找出相近的颜色，然后再用该颜色进行处理，此时便用到吸管工具 [image: image355.jpg]


 了。其使用方法是首先单击工具箱中的吸管工具，然后单击图像中的取色位置。吸管工具只能设置前景色，要设置背景色，可首先单击 [image: image356.jpg]


 工具，将背景色设置为前景色，利用吸管工具设置颜色后，再切换过来。
此外，利用吸管工具属性栏，用户还可设置取样大小。其中包括Point Sample（按点采样）、33像素平均和55像素平均三种方式，如图2-43所示。
为了便于用户了解某些点的颜色数值以方便颜色设置，Photoshop还提供了一个颜色取样器工具 [image: image357.jpg]


，用户可利用该工具查看图像中若干关键点的颜色值，以便在调整颜色时参考，如图2-44所示。
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图2-43  吸管工具属性栏               图2-44  系统提供的颜色取样器工具 

要使用颜色取样器工具，应首先选中该工具，然后在图像中单击希望查看颜色值的点。这些点将以类似[image: image360.jpg]


记号标识，其值将显示在Info调板中，如图2-45所示。
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图2-45  利用颜色取样器工具查看颜色值
使用吸管工具 [image: image363.jpg]


 时，取样点不得超过4个。
 

要移动取样点位置，只需将光标移至取样点，然后单击并拖动即可，此时用户可通过信息调板浏览光标所经过的区域的颜色变化。
 

要删除取样点，可在按下Alt键后单击取样点，或直接将其拖出图像。
 
第3章 学习抠图
3.1 利用矩形、椭圆、单行和单列选框工具制作规则选区


     

在利用矩形和椭圆选框工具定义选区时，除了使用拖动方法定义选区外，还可利用工具属性栏中的Style下拉列表中的选项进行定义，如图3-1所示。这些选项的意义如下所述。
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图3-1  定义选区
  Nomal（正常）：这是默认的区域定义方式，用户可通过拖动方法选择任意尺寸和比例的区域。
  Fixed Aspect Radio（约束长宽比）：选定此方式后，系统将以设置的宽度和高度比例定义区域，其比例由工具属性栏中的Width（宽度）和Height（高度）编辑框定义。
  Fixed Size（固定大小）：表示以固定尺寸制作选区，选区尺寸由工具属性栏中的宽度和高度编辑框定义。使用该方式时，用户只需在图像窗口单击即可制作选区。
 

使用矩形或椭圆选框工具定义选区时，若按下Shift键，则可定义正方形选区或圆形选区；若按下Alt键，则可定义一个以起点为中心的矩形或椭圆形选区；若按下Alt+Shift键，则可定义一个以起点为中心的正方形或圆形选区。
利用单行 [image: image365.jpg]


 和单列选框工具 [image: image366.jpg]


 可选择一个像素宽的横线或竖线，这两个工具主要用于制作一些线条。使用这两个工具时必须将Feather（羽化）参数设置为0，如图3-2所示。
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图3-2  利用 [image: image368.jpg]


 工具和 [image: image369.jpg]


 工具制作线条
3.2 利用套索工具定义不规则区域


     

利用系统所提供的三种套索工具（套索工具 [image: image370.jpg]


 、多边形套索工具 [image: image371.jpg]


 和磁性套索工具[image: image372.jpg]


 ），可以非常方便地制作不规则区域，下面对其进行详细介绍。
3.2.1  套索工具
利用套索工具 [image: image373.jpg]


 可定义任意形状的区域。以选择图3-3中的鸭子为例，可首先选择该工具 [image: image374.jpg]


 ，然后在图像窗口单击确定其起点，并拖动鼠标定义要选择的区域。释放鼠标后，系统会自动用直线将起点和终点连接起来，形成一个封闭区域，如图3-3所示。
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图3-3  曲线套索工具 [image: image377.jpg]


 的用法
此外，如果在释放鼠标前按下Esc键，则可取消此时的选区定义，释放鼠标按键后可恢复前面的选区设定；如果按下Alt键，则可切换为“多边形套索”功能。
3.2.2  多边形套索工具
利用多边形套索工具 [image: image378.jpg]


 ，用户可定义一些像三角形、多边形、五角星等形状的选区。要使用该工具，可首先选定 [image: image379.jpg]


 工具，然后在图像窗口中单击定义起点。和“曲线套索”工具不同的是，用户在单击定义起点后应马上释放鼠标并移动光标，并在需要拐弯处再次单击鼠标，此时第一条边线即被定义。释放鼠标按键后继续移动光标，在需要拐弯处再次单击鼠标可定义第二条边线，依次类推。最后，双击鼠标可将起点与终点自动连接，从而形成封闭选区，如图3-4所示。
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图3-4  多边形套索工具 [image: image383.jpg]


 的用法
如果按下Delete键，则可取消最近定义的边线；如果按住Delete键不放，则可取消所有定义的边线，也可按下Esc键来做到这点。
3.2.3  磁性套索工具
利用磁性套索工具 [image: image384.jpg]


 ，用户可以精确定位边界。在磁性套索工具 [image: image385.jpg]


 的属性栏中，用户除了可设置Feather（羽化）和Anti-aliased（锯齿）特性外，还可设置其他几个参数，如图3-5所示。
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图3-5  [image: image387.jpg]


 工具的属性栏
  Width（宽度）：设置利用磁性套索工具定义边界时，系统检测的边缘宽度。其值可在1到40之间，值越小，检测范围越小。
  Edge Contrast（边对比度）：设置边缘对比度，其值在1%~100%之间，值越大，对比度越大，边界定位也就越准确。
  Frequency（频率）：设置定义边界时的锚点数，这些锚点起到了定位选择的作用。其值可在0到100之间，值越大，产生的锚点也就越多。
  Pen Pressure（光笔压力）：设置绘图板的笔刷压力，该参数仅在安装了绘图板驱动程序时可用。绘图板是一种类似鼠标的输入设备，用户可利用它进行绘画，其效果将立即出现在屏幕上。
磁性套索工具 [image: image388.jpg]


 适合选择图形与背景反差较大的图像，图形与背景的反差越大，选取的精确度越高。选择 [image: image389.jpg]


 工具后，在图像窗口单击确定选区起点，然后释放鼠标，并沿要定义的边界拖动光标，则系统会自动在设定的像素宽度内分析图像，从而精确定义选区边界。与前面介绍的大多数工具相同，要结束选区定义，可双击鼠标连接起点和终点，如图3-6所示。
[image: image390.jpg]


    [image: image391.jpg]


    [image: image392.jpg]



图3-6  磁性套索工具精确定位边界
当所选区域的边界不太明显，利用磁性套索工具 [image: image393.jpg]


 无法精确地分辨选区边界时，用户可通过单击鼠标手工设置定位节点。
如果所选取的边界不符合要求，可按Delete键删除所定位的节点。
3.3 利用魔棒工具自动定义颜色相近的区域


     

利用魔棒工具 [image: image394.jpg]


，用户可以对图像中颜色相近的区域进行选取，进而对该区域进行编辑处理，其工具属性栏如图3-7所示，其工具参数的意义如下所述。
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图3-7  魔棒工具 [image: image396.jpg]


 属性栏
  Tolerance（容差）：设置颜色选取范围，其值可为0~255。值越小，选取的颜色越接近，选取范围越小。
  Continuous（连续的）：选择位置相邻并且颜色相接近的区域。如果取消了该复选框，表示选择所有颜色相近，但位置不一定相邻的区域。
  Use All Layers（用于所有图层）：确定是否选取所有层。在Photoshop中，为了使图像处理更为方便，可以将其分为若干层，用户可分别对其进行处理。有关层的详细介绍，请参见后面的内容。
下面我们举例说明魔棒工具的用法。在图3-8中，选中该画面中的人物操作步骤如下所述。
（1）选择魔棒工具 [image: image397.jpg]


 ，在工具属性栏中设置Tolerance值为50，单击添加到选区按钮 [image: image398.jpg]


 ，或在选取时配合Shift键进行加选，然后在图像的心形背景外侧连续单击进行选取，结果如图3-9所示。
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图3-8  素材图片                      图3-9  容差值为50时选取的效果
单击不同的点，可选择不同的区域。因此，用户在使用魔棒工具进行区域选择时，可反复进行选取，直到符合要求为止。
（2）由于画面中心形的颜色和人物皮肤的颜色比较相近，所以我们将Tolerance值设的小一些，本例设为10。在剩余的心形部分连续单击进行选取，如图3-10所示。
（3）选择Select（选择）→ Inverse（反选）菜单，将选区进行反选，这样我们就选出了图像中的人物，如图3-11所示。
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图3-10  容差值为10时选取的效果                         图3-11  最终效果图
3.4 利用色彩范围命令按颜色制作选区


     

利用Select → Color Range菜单，用户可通过在图像窗口中指定颜色来定义选区，并可通过指定其他颜色来增大或减小选区。选择该命令，系统将打开如图3-12所示的Color Range对话框，该对话框中主要选项和工具的意义如下所述。
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图3-12  Color Range对话框
  Select（选择）下拉列表：单击该框将打开一个下拉列表，可从中选择选区制作方式，如图3-36所示。默认情况下，系统是根据样本色进行选择的。当用户将光标移至图像窗口或预览窗口指定样本色时，光标将呈吸管形状[image: image404.jpg]


。在这种情况下，用户可利用“颜色容差”滑杆调整颜色选取范围。利用红色、黄色、绿色、青色、蓝色和品红，可根据颜色制作选区；利用高亮色调、中间色调和暗色调可根据色调制作选区；利用溢色，可将印刷上无法印出的颜色区选出来。
  Fuzzines（颜色容差）：在使用样本色选取时指定颜色范围。
  利用Selection（选择范围）和Image（图像）单选钮可指定色彩范围预览窗口中的图像显示方式（显示选区图像或完整图像）。
  Selection Preview（选区预览）下拉列表：指定图像窗口（不是预览窗口）中的图像选择预览方式。默认情况下，其设置为“正常”，即不在图像窗口显示选择效果。若选灰度、黑色杂边和白色杂边，则表示以灰色调、黑色或白色显示未选区域；若选择快速蒙版，表示以预设的蒙版颜色显示未选区域。
  [image: image405.jpg]


 工具：默认情况下，该工具被选定，表示制作新选区。
  [image: image406.jpg]


 工具：选择该工具，表示在前面已有选区的基础上增大选区。
  [image: image407.jpg]


 工具：选择该工具，表示在前面已选区域的基础上减小选区。
  Load（装载）和Save（保存）按钮：用来装载和保存Color Range对话框中的设定。
  Invert（反选）：反转选区，它相当于制作选区后，选择“选择”→“反选”命令。
利用颜色来定义选区这一功能可以在复杂的图像中选择特殊图形，下面我们通过选中图中人物的上衣来说明其具体用法。
（1）打开一幅人物图片，为了将图中人物上衣选出，可首先单击 [image: image408.jpg]


 工具，在上衣区域制作矩形选区，如图3-13所示。
（2）选择Select → Color Range菜单，打开如图3-14所示的Color Range对话框。
（3）在对话框中选中 [image: image409.jpg]


 工具，然后单击图中人物的上衣部位，以显示该选区，如图3-15左图所示，适当调整Fuzziness的数值，以调整选区，结果如图3-15右图所示。
[image: image410.jpg]


           [image: image411.jpg]3





              图3-13  利用 [image: image412.jpg]


 工具大致选中上衣区域             图3-14  Color Range对话框
[image: image413.jpg]


    [image: image414.jpg]



图3-15  显示并调整选区
（4）在对话框中单击选中 [image: image415.jpg]


 工具，然后在人物上衣部位中的黑色区域单击，扩大选区，如图3-16所示。
（5）设置完成后，单击OK按钮，得到如图3-17所示的上衣选区。
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图3-16  利用 [image: image418.jpg]


 工具扩大选区                      图3-17  制作的选区
3.5 利用快速蒙版模式制作选区


     

快速蒙版模式是制作选区的另一种非常有效的方法。单击工具箱中的快速蒙版编辑模式按钮 [image: image419.jpg]


 ，进入快速蒙版模式，用户可使用画笔、橡皮擦等工具编辑蒙版，然后可将蒙版转换为选区。使用这种方法主要有如下优点：
  可制作精确选区。当使用其他选区制作工具不能选中有效区域时，可使用快速蒙版模式进行弥补。
  由于用户可使用各种绘画和修饰工具编辑蒙版，因此，用户可利用它制作任意形状的选区。特别是在图像非常复杂时，这种方法非常有效。
[image: image699.png]


  由于蒙版本身包含了透明度信息，因此，利用这种方法可获取各种形式的羽化效果，从而制作出一些令人意想不到的效果。
双击快速蒙版编辑模式按钮 [image: image420.jpg]


 ，打开如图3-18所示的Quick Mask Options对话框。选中Masked Areas单选钮表示将在蒙版区（非选区）显示颜色；选中Selected Aresa单选钮表示将在选区显示颜色。此外通过Color和Opacity项可设置蒙版的颜色和不透明度。
下面举例说明如何利用快速蒙版模式制作选区。例如要选中图3-19所示人物可按如下步骤操作。
（1）首先使用 [image: image421.jpg]


 工具在图中背景处单击，但未能有效选中图中的人物，如图3-20所示。
[image: image422.jpg]


               [image: image423.jpg]



图3-19  素材图片              图3-20  利用魔棒工具大致选出人物轮廓
（2）单击工具箱底部的快速蒙版编辑模式按钮 [image: image424.jpg]


 ，进入快速蒙版编辑模式。由于图3-20中背景颜色为粉红色与蒙版颜色相近，因此双击 [image: image425.jpg]


 按钮，在打开的Quick Mask Options对话框中设置Color为绿色，Opacity（透明度）设置为70%，则画面效果如图3-21所示。
（3）下面开始进行蒙版的修改，以精确制作选区。选择画笔工具 [image: image426.jpg]


 在图中涂抹可增加蒙版区，使用橡皮擦工具 [image: image427.jpg]


 在图中涂抹可减小蒙版区。涂抹过程中可随时调节画笔的尺寸，可将图像适当放大，结果如图3-22所示。
（4）单击工具箱中的标准编辑模式按钮 [image: image428.jpg]


 ，将显示切换成正常的显示模式。可以看出，此时人物周围的区域被选中，如图3-23所示。
[image: image429.jpg]
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图3-21  重新设置蒙版颜色和透明度
（5）选择Select → Inverse菜单，反选选区即可选中图中的人物，如图3-24所示。
[image: image431.jpg]


      [image: image432.jpg]


      [image: image433.jpg]



图3-22  编辑蒙版         图3-23  显示正常模式下选区     图3-24  反转选区选中人物
蒙版是一种普通的256色灰度图像，其默认颜色为红色。纯红色区域表示不选择该区域，无色区域表示选择该区域，位于纯红色和无色之间的浅红色区域表示该选区为带有半透明效果的选区。
尽管用户可使用所有图像编辑手段来编辑蒙版图像，但通常情况下，用户应使用画笔工具和铅笔工具绘制蒙版，而使用橡皮擦工具擦除蒙版。当然，在某些情况下，用户也可借助渐变色工具、指绘工具等制作特殊蒙版图像，甚至可以使用色彩和色调调整命令调整蒙版的色彩和色调。
3.6 选区的运算、羽化和锯齿消除


     

用户可能注意到了在利用工具箱中的选区制作工具制作选区时，其工具属性栏中都有一组 [image: image434.jpg]FISLa]



 按钮、Feather和Anti-Aliased项。其中工具属性栏中的4个选区运算按钮[image: image435.jpg]FISLa]



，从左至右，各按钮的意义如下所述。
  [image: image436.jpg]


 ：按下该按钮，表示制作新选区。
  [image: image437.jpg]


 ：按下该按钮，表示执行选区相加操作，同按下Shift键。
  [image: image438.jpg]


 ：按下该按钮，表示执行选区相减操作，同按下Alt键。
  [image: image439.jpg]


 ：按下该按钮，表示执行选区交叉操作。
下面我们通过选择如图3-25中的玉马来介绍各按钮的用法。
（1）在工具箱中选中魔棒工具 [image: image440.jpg]


 ，然后在图中背景处单击，如图3-26所示。
[image: image441.jpg]


              [image: image442.jpg]



图3-25  素材图片                图3-26  使用魔棒工具在图中背景处单击
（2）在魔棒工具属性栏中单击添加到选区按钮 [image: image443.jpg]


 ，然后在图3-26中玉马周围其他区域单击，以扩大选区，如图3-27所示。
（3）选中工具栏中的 [image: image444.jpg]


 工具，在工具属性栏中单击 [image: image445.jpg]


 按钮，然后勾选玉马下面的台座区域，继续扩大选区如图3-28所示。
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     [image: image447.jpg]


                [image: image448.jpg]



图3-27  利用 [image: image449.jpg]


 按钮扩大选区                     图3-28  继续扩大选区
（4）再次单击工具属性栏中的从选区中减去按钮 [image: image450.jpg]


 钩选玉马的尾部，以缩小选区，如图3-29所示。
（5）选择Select → Inverse菜单，反选选区，即可选中玉马，如图3-30所示。
[image: image451.jpg]


  [image: image452.jpg]


       [image: image453.jpg]



图3-29  缩小选区                              图3-30  反选选区选中玉马
[image: image700.png]


通过在定义选区时设置羽化参数，可在处理选区时获得晕开的柔和效果。例如，在图3-31中，我们分别绘制了两个椭圆，并使用油漆桶工具 [image: image454.jpg]e



 对其进行了填色。它们的不同之处在于，定义第一个椭圆时没有使用羽化效果，而第二个设置了羽化参数。
要设置羽化效果，可在选定选区制作工具后，利用工具属性栏设置羽化参数，如图3-32所示，然后在图像中制作选区。
[image: image455.jpg]



图3-32  在工具属性栏中设置羽化参数
如果希望在定义选区之后设置羽化参数，可选择Select → Feather菜单，在打开的Feather Selection对话框输入羽化值，如图3-33所示，最终的羽化效果为工具属性栏中的羽化值和此处的羽化值之和。
我们知道，图像实际上是由众多的像素组成的，而像素实际上是正方形的色块。因此，当选择斜线区域或弧线区域时，就会产生锯齿形状，且图像的分辨率越低，锯齿效果就越明显。默认情况下，选择工具属性栏中的Anti-Aliased（消除锯齿）复选框是选中的，此时Photoshop会在锯齿之间填入介于边缘和背景的中间色调的色彩，从而使锯齿的硬边变得较为平滑，图3-34显示了工具属性栏中选中和未选中消除锯齿复选框时的图像效果。
                  [image: image456.jpg]


           [image: image457.jpg]



       图3-33  定义选区后设置羽化参数    图3-34  利用选择工具属性栏中的“消除锯齿”复选框控制锯齿效果
3.7 选区的调整


     

选区的调整操作包括对选区进行全选、移动、反选、扩展或收缩、扩大、拉伸、倾斜，以及平滑选区边界、制作边界选区等，下面我们将具体介绍。
3.7.1  选区的全选、重选、反选、隐藏和移动
要对图像执行全选、取消、重选、反选及隐藏选区等操作，可选择如图3-35所示的菜单中的命令。
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图3-35  菜单命令
要移动选定的区域位置，用户可将光标移至选区，然后单击并拖动。此时光标将呈[image: image460.jpg]


形状。如在移动时按下Shift键，则只能将选区沿水平、垂直或45°方向移动；如在移动时按下Ctrl键，则可移动选区中的图像（相当于选择了移动工具 [image: image461.jpg]


 ）。
用户可使用上、下、左、右4个光标移动键精确移动选区。
 

要将当前图层中的选区与非选区进行相互转换，可选择Select → Inverse菜单。
3.7.2  制作边界选区与选区平滑
制作边界选区的操作很简单，选择Select（选择）→ Modify（修改）→ Border（扩边）菜单，用户可设置选区边缘的宽度为1~64像素。其结果是将原来的选区转换为了边界选区，如图3-36所示。
[image: image462.jpg]


  [image: image463.jpg]
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图3-36  利用Select → Modify → Border菜单获取边界选区
选区平滑的作用是消除用魔棒工具 [image: image465.jpg]


 或通过指定颜色范围定义选区时所选择的一些不必要的零星区域。用户可选择Select → Modify → Smooth（平滑）菜单，系统将打开Smooth Selection对话框。通过设置Sample Radius（取样半径），系统即可按照设置对选区边界进行平滑处理。所设半径越大，边界也就越平滑，如图3-37所示。
[image: image466.jpg]
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图3-37  利用Select → Modify → Smooth菜单对选区边界进行平滑处理
3.7.3  扩展和收缩选区
扩展选区就是对用户所制作的选区进行全方位的扩展。选择Select → Modify → Expand（扩展）菜单，系统将打开Expand Selection对话框。在Expand编辑框中可输入一个1~16之间的值，选区将按指定像素被扩展，如图3-38所示。
[image: image469.jpg]
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图3-38  利用Select → Modify → Expand菜单扩展选区
此外，选择Select → Grow菜单和Select → Similar菜单也可扩展选区，其意义如下所述。
  Grow（扩大选取）：执行该命令时，可以按颜色的近似程度（由魔术棒工具属性栏中的Tolerance确定）扩大与选区相邻的选择范围。
  Similar（选取相似）：执行该命令时，也将按可以按颜色的近似程度（同样由魔术棒工具属性栏中的Tolerance确定）扩大选区范围。不过，这些扩展的选区并不一定与原选区相邻。
要缩小选区，可选择Select → Modify → Contract（缩小）菜单，系统将按用户所设置的像素减小选区。
3.7.4  选区的旋转、翻转和自由变形
用户在制作选区后，所选出的区域并非完全符合要求。为此，用户可对选区进行调整，下面我们通过一个实例来说明其具体操作。
（1）打开一幅图片，并利用前面介绍的方法初步制作选区。
（2）选择Select → Transform Selection菜单，则此时系统将显示一个变形框，如图3-39所示。
[image: image472.jpg]



图3-39  选择Select → Transform Selection菜单打开一个变形框
（3）调整变形框便可对选区执行以下几种调整操作。
  移动选区图像：将光标定位至选区，按下鼠标，待光标变为 [image: image473.jpg]


 形状后单击并拖动即可移动选区，如图3-40左图所示。
  改变大小：将光标移至选区的控制柄“□”上，待光标变为 [image: image474.jpg]L )



 形状后单击并拖动即可，如图3-40中图所示。
  自由旋转：将光标移动到选区外任意位置，待光标变为 [image: image475.jpg]


 形状后单击并拖动即可，如图3-40右图所示。其中，[image: image476.jpg]


 为旋转支点，要移动该点，可在将光标移至该点附近且光标呈 [image: image477.jpg]


 形状后单击并拖动即可。
（4）用户也可单击鼠标右键，从弹出的快捷菜单中选择相应命令对选区进行其他变形操作，如图3-41所示。
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图3-40  移动、调整和旋转选区                 图3-41  利用快捷菜单选择其他变形
（5）变形结束后，在控制框中双击或按回车键均可确认变形操作。若单击工具箱中的工具，系统将给出一询问对话框，请用户确认或取消操作。
3.8 选区的保存和安装(1)


     

用户在花费大量的时间和精力制作了一个比较精密的选区之后，可以对它进行保存，以后使用时，将其从Channels调板中装载进来即可。
选择Select → Save Selection后，系统将显示如图3-42所示Save Selection对话框。该对话框中各项目的作用如下所述。
[image: image482.jpg]



图3-42  Save Selection对话框
  Document（文档）：用于指定保存选区的文件，默认为当前图像文件。若选择其中的New选项，则将新建一个图像窗口进行保存，如图3-43所示。所新建的文件为一个多通道模式文件，并含在图层和通道内，且通道名称可由Name编辑框指定。
[image: image483.jpg]
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图3-43  将选区保存在新文档时产生的新图像窗口
  Channel（通道）：选择创建通道或蒙版的方式。默认情况下，将创建一个新Alpha1通道。若图像中包含了Alpha通道或当前图层是非背景图层的话，则在Channel下拉列表中出现通道名称和当前图层蒙版选项。在Channel下拉列表中选择某个Alpha通道后，Operation（操作）设置区将如图3-44所示，可选择替换原有通道，将选区增加到已有通道，从已有通道减去选区，或与已有通道执行求交集操作。
通道主要用于保存颜色数据，例如，一幅彩色图像通常由四个通道组成（RGB、R、G、B），通过关闭、打开、合并或删除通道，可更好地对图像进行处理。除此之外，通道还可用于保存蒙版。在Photoshop 7.0中，新建通道被称为Alpha通道。
 [image: image485.jpg]



图3-44  Save Selection对话框
所谓蒙版，实际上也就是选区，用户在处理图像时可通过蒙版屏蔽图像的其他区域，然后进行处理，从而增强图像处理的灵活性。
保存选区后，若要安装选区，可选择Select → Load Selection菜单，此时系统将打开如图3-45所示的Load Selection对话框。用户可通过该对话框选择所要安装的通道，以及是否反转选区（利用Invert复选框）。
[image: image486.jpg]



图3-45  Load Selection对话框
此外，还可通过Operation（操作）设置区选择如何处理选区，其各选项意义如下所述。
  New Selection（新选区）：安装的选区将成为新选区，且执行安装操作前的已有选区（如果有的话）被取消。
  Add to Selection（添加到选区）：将安装的选区增加到执行安装操作前的已有选区。
  Subtract from Selection（从选区中减去）：从执行安装操作前的已有选区中减去安装的选区。
  Intersect with Selection（与选区交叉）：执行安装操作前的已有选区和安装的选区的重叠部分成为新选区。
3.8 选区的保存和安装(2)


     

上机实践——合成图像
本实例的制作首先利用选区制作工具抠出选区图像，然后利用图像编辑命令调整选区图像的大小，最后利用通过复制的图层命令和仿制图章工具制作了如图3-46所示的合成图像。
[image: image487.jpg]



图3-46  合成图像
（1）选择File → Open菜单，打开PhotoshopCS.Zip文件中的“习题图片／CH03／合成图片／”中的“素材1”和“素材2”图片。
（2）选择工具箱中的裁切工具 [image: image488.jpg]


 ，裁切素材2图片，如图3-47所示。
[image: image489.jpg]


    [image: image490.jpg]



图3-47  裁切素材2图片
（3）选择工具箱中的魔棒工具 [image: image491.jpg]


 ，在其工具属性栏中选中增加选区按钮 [image: image492.jpg]


 ，在图中白色区域连续单击，选中白色区域和阴影，然后选择Select → Inverse菜单，反选选区，如图3-48所示。
[image: image493.jpg]


    [image: image494.jpg]


 

图3-48  选中图中的工装裤
（4）选择Edit（编辑）→ Copy（复制）菜单，将选区图像复制到剪贴板中。切换到素材1图片，选择Edit → Paste（粘贴）菜单，将剪贴板中的图像粘贴到素材1图片中，如图3-49所示。
（5）选择Edit → Free Transform（自由变换）菜单，移动并调整控制框，使工装裤与企鹅的身体吻合，按Enter键结束变形，如图3-50所示。
[image: image495.jpg]


       [image: image496.jpg]


  [image: image497.jpg]



          图3-49  将选区图像粘贴到素材1中                图3-50  移动并调整工装裤的大小
（6）在Layers调板中单击选中Background层，在Navigator（导航器）调板中将图像显示放大到100%。
（7）选择工具箱中的多边形套索工具 [image: image498.jpg]


 ，按照图3-51左图所示勾画选区，结果如图3-51右图所示。
[image: image499.jpg]
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图3-51  在背景层中勾画选区
（8）选择Layer（图层）→ New（新建）→ Layer Via Copy（通过复制的图层）菜单，复制选区图像到新层Layer 2。
（9）在Layers调板中，用鼠标拖动Layer 2层到Layer 1层上方，调整图层顺序，如图3-52所示。
[image: image501.jpg]
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图3-52  调整图层顺序
（10）处理企鹅的下半身，单击选中Background层，选择工具箱中的磁性套索工具 [image: image503.jpg]


 ，按照图3-53勾画选区。
（11）设置前景色为白色，选择Edit → Fill菜单，将选区填充为白色，如图3-54左图所示。选择工具箱中的仿制图章工具 [image: image504.jpg]


 ，按下Alt键在图中石子处单击设置参考点，在工具属性栏中设置Brush为20，然后在选区内涂抹复制图像，如图3-54右图所示。
[image: image505.jpg]
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        图3-53  勾画选区                     图3-54  填充选区并利用 [image: image508.jpg]


 工具复制图像
（12）按Ctrl+D组合键取消选区，选择Fill → Save As菜单，将图像命名并保存。
4.1 选区图像的剪切、复制和粘贴


     

当用户选中图像中的全部区域或部分区域时，选择Edit（编辑）→ Cut（剪切）菜单，可将选区图像放在剪贴板上。但是，该区域将被从原图像中剪除，并以背景色填充。
若选择Edit（编辑）→ Copy（复制）菜单，可将选中区域的图像放在剪贴板上，原图像保持不变，从而可利用剪贴板进行数据交换。
若希望将剪贴板中的图像粘贴到当前图像中，可选择Edit → Paste（粘贴）菜单，粘贴区域将被放置在图像的中心位置，并创建一新层来放置该区域，如图4-1所示。
[image: image509.jpg]
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图4-1  复制粘贴图像
默认情况下，在Photoshop中粘贴的图像并未和原图像完全融合，而是将其放置在了一个单独的层中，这为图像处理带来了很大便利。例如，用户可以移动粘贴区域的位置，对其进行各种编辑，设置其透明度，关闭或打开其显示。
在粘贴图像时，要特别注意图像的像素大小。如果剪贴板中图像的像素大小远远大于要粘贴进的目标图像的大小，则粘贴的内容为空白。因此，在执行图像复制和粘贴操作前，可首先查看一下两者的像素大小，然后利用调整图像大小的方法对其进行适当的调整。
在选择移动工具 [image: image512.jpg]


 后，也可采用直接拖动的方法将一幅图像拖动到另一幅图像中。
第4章 图像基本编辑命令
4.2 Copy Merged和Paste Into命令的使用


     

Copy Merged（合并复制）命令的作用是把选区内所有层的内容复制到剪贴板，而Copy命令则只把当前层的内容复制到剪贴板。使用Paste Into（粘贴入）命令则只把剪贴板中的数据复制到选区内，而选区以外的内容不受影响。例如，在图4-2中显示了Copy Merged和Paste Into命令的效果。
[image: image513.jpg]
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图4-2  合并复制和粘贴到选区的图像效果
4.3 清除选区图像


     

要清除选区图像，可选择Edit（编辑）→ Clear（清除）菜单或按Delete键，此时被清理的区域将以背景色填充（对于背景层），或者成为透明区（对于其他普通图层）。不过，要注意的是，清除图像只能清除当前层的内容，如图4-3所示。此外，无论是复制、剪切、粘贴或清除选区，都支持羽化效果。
[image: image517.jpg]
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图4-3  清除选区图像
4.4 选区图像的自由变形与边界描边


     

我们在上一章详细介绍了选区的自由变形方法，此处我们介绍选区图像的自由变形。要对图像进行自由变形，可选择Edit（编辑）菜单中的Free Transform（自由变换）或Transform（变换）中的子菜单项。下面通过一个实例具体说明对图像进行自由变形和边界描边的方法与步骤。
（1）打开一幅图像，利用前面介绍的选区制作工具定义选区。
（2）选择Edit → Free Transform菜单，进入自由变形状态，用鼠标在控制框内单击并拖动可移动选区图像位置；拖动控制框的各个控制点可改变图像的形状；当鼠标变形为[image: image519.jpg]


形状时拖动鼠标可以将图像进行自由旋转，如图4-4所示。
[image: image520.jpg]
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图4-4  移动、调整和旋转选区图像
（3）在前面的状态下，用户只能移动、旋转选区或调整其尺寸。除此之外，若此时单击鼠标右键，则系统将打开图4-5所示快捷菜单（对应Edit → Transform子菜单）。通过选择其中不同的菜单项，可执行其他变形操作，其意义如下所述。
  Scale（缩放）：选中该菜单项后，可在维持矩形各边方向不变的情况下，调整选区图像的大小。若同时按下Shift键，则以固定的长宽比例缩放选区图像。
  Rotate（旋转）：可自由旋转选区图像。
  Skew（倾斜）：若将光标移至四角的控制柄上并拖动（此时光标呈[image: image523.jpg]


 形状），可在保持其他三个角点不动的情况下对选区进行倾斜变形，如图4-6左图所示。若将光标移至四边的中间控制柄上（此时光标呈[image: image524.jpg]


形状），可以在保持其他两个角点不动的情况下，将控制框沿控制柄所在边的方向进行移动，如图4-6右图所示。
[image: image525.jpg]
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图4-5  利用快捷菜单或“编辑→变换”子菜单选择其他变形操作
[image: image527.jpg]
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图4-6  对选区图像进行倾斜变形
  Distort（扭曲）：选择该菜单项后，可以任意拉伸框线的四个角点进行自由变形，但框线的区域不得为凹入形状，如图4-7左图所示。它和“倾斜”变形的区别在于，进行“倾斜”变形时，用户只能在某一时刻沿某一邻边方向进行移动，而“扭曲”变形则无此限制。若将光标定位在控制框边界中间的控制柄上进行移动，则在保持另两个角点不动的情况下进行三个方向的变形。
  Perspective（透视）：利用该方式，拖动角点时框线会形成对称的梯形，这种变形可以制作出特殊的透视效果，如图4-7右图所示。若将光标定位到控制框边线的中间控制柄上，然后拖动光标，则可在保持其他两角点不变的情况下，沿该控制柄所在方向移动该边，这相当于“倾斜”变形。
[image: image529.jpg]
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图4-7  扭曲变形与透视变形
[image: image701.png]Fas



变形结束后，在控制框中双击或按Enter键均可确认变形操作，按Esc键将取消变形操作。若单击工具箱中的工具，则系统将给出一询问对话框，单击Apply按钮将确认变形操作，单击Don’t Apply按钮将取消变形操作，如图4-8所示。
执行变形操作后，Edit → Transform子菜单中最上方的Again（再次）菜单项可用。选择该命令可重复上一次的变形操作，从而对其他选区图像进行相同的变形。
（4）除了可以对选区图像进行变形外，还可以对选区图像进行描边。确认一种变形操作后，选择Edit → Stroke（描边）菜单，在打开的如图4-9左图所示的Stroke对话框中设置描边的宽度、颜色、位置、模式及不透明度等参数。设置完成后，单击OK按钮退出对话框，按Ctrl+D组合键取消选区，结果如图4-9右图所示。
[image: image531.jpg]
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图4-9  对选区图像执行描边操作
4.5 旋转和翻转图像


     

利用Image（图像）→ Rotate Canvas（旋转画布）菜单中的各子菜单项，可旋转和翻转图像，如图4-10所示。各菜单项的意义如下所示。
  180°：将图像旋转180°。
  90°CW（顺时针）：将图像沿顺时针旋转90°。
  90°CCW（逆时针）：将图像沿逆时针旋转90°。
  Arbitrary（任意角度）：按指定角度和方向（顺时针或逆时针）旋转图像。
  Flip Canvas Horizontal（水平翻转）：水平翻转图像。
  Flip Canvas Vertical（垂直翻转）：垂直翻转图像。
当选择Image → Rotate Canvas→ Arbitrary菜单时，系统将打开Rotate Canvas对话框，可以设置调整的角度，以任意角度调整图像，如图4-11所示。
如果用户只想旋转或翻转选区内的图像，则可在制作好选区后，选择Edit → Transform菜单中的相关命令，如图4-12所示。
[image: image533.jpg]
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原图                             旋转180°                    顺时针旋转90°
[image: image536.jpg]


  [image: image537.jpg]


  [image: image538.jpg]



逆时针旋转90°                   水平镜像                            垂直镜像
图4-10  旋转和翻转整幅图像效果
[image: image539.jpg]
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图4-11  以任意角度旋转图像
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图4-12  Edit → Transform菜单中的相关命令
与旋转和翻转整幅图像不同，选区的旋转或翻转仅对当前图层中的选区图像有效。如果希望对某个图层进行旋转或翻转，可在将该图层设置为当前层后，选择Edit → Transform菜单中的相关命令，此时系统会自动选中该图层中的非透明区。
4.6 移动和复制当前层图像或选区图像


     

要移动图像中某层图像的位置，可首先利用Layers（图层）调板将该层设置为当前层，然后选择 [image: image542.jpg]


 工具，在图像区拖动即可。如果仅想移动选区图像，则应首先制作好选区，然后在选中 [image: image543.jpg]


 工具后单击并拖动即可，如图4-13所示。
选中移动工具后，若在拖动时按下Shift键，可按水平、垂直或45°方向移动图像。
如果希望移动图像时保持原图像不变，只复制其内容到其他位置，可在选中 [image: image544.jpg]


 工具后按下Alt键（此时光标呈 [image: image545.jpg]


 形状），然后再拖动，如图4-14所示。
[image: image546.jpg]
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图4-13  移动选区图像                        图4-14  移动时复制图像
用户也可用如下方法移动或复制图像，且此时不必选中移动工具 [image: image548.jpg]


 ：
  在选中其他工具时（ [image: image549.jpg]


 、[image: image550.jpg]


 工具除外），可按“Ctrl+拖动”移动图像。
  按下Ctrl键后，可用4个方向键以1个像素为单位移动图像。
  按下Alt+Ctrl组合键后，可用4个方向键以1个像素为单位移动并复制图像。
  按下Shift+Ctrl组合键后，可用4个方向键以10个像素为单位移动并复制图像。
4.7 图案的定义与运用


     

图案和快照类似，用户可用它将选定区域的图像保存到内存中，然后利用图案图章工具[image: image551.jpg]


 、修复画笔工具 [image: image552.jpg]


 ，或者使用Fill命令将其复制到同一图像中的其他位置或另一幅图像中，具体操作步骤如下：
（1）打开一幅图片，选择矩形选框工具定义需作为图案的矩形选区，如图4-15所示。
（2）选择Edit → Define Pattern（定义图案）菜单，将选区内图像定义为图案，如图4-16所示。
[image: image553.jpg]


          [image: image554.jpg]



           图4-15  打开图片并制作选区                          图4-16  命名制作的图案
（3）在Layers调板中单击 [image: image555.jpg]


 按钮，为图像创建新层，然后按Ctrl+D组合键取消矩形选区，如图4-17所示。
（4）选择Edit → Fill（填充）菜单，在打开的Fill对话框中设置填充内容、混合模式及不透明度等参数，如图4-18所示。
[image: image556.png]
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          图4-17  创建一个新层图                             4-18  设置填充参数
（5）设置完毕后单击OK按钮关闭对话框，结果如图4-19所示。
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图4-19  图案填充效果
定义图案时，选区只能为矩形，且羽化值必须为0。
 

图案以当前显示效果为准。
4.8 填充颜色与图案


     

在进行图像编辑时，经常需要对选区或整幅图像填充颜色、图案等。为此，用户需首先设置前景色、背景色或定义图案，然后参照4.7节所述的图案填充的方法进行操作即可。
若执行填充操作时未定义选区，则填充整幅图像；若定义了选区，则只对选区进行填充，且选区可为任意形状，并可带有羽化效果，如图4-20所示。
 

填充时不创建新图层，而只是改变当前图层。若当前图层被隐藏或当前图层为文字图层，则不能进行填充。
 

若选择使用“历史记录”进行填充，必须确定历史记录画笔 [image: image561.jpg]


 的位置，即历史记录画笔在哪里，填充的内容就是当时所选择的画面。
 

若要快速填充前景色，可按Alt+Delete或Alt+BackSpace组合键；若要快速填充背景色，可按Ctrl+Delete或Ctrl+BackSpace组合键。如果按Shift+BackSpace组合键，可打开“填充”对话框。
[image: image562.jpg]



图4-20  为选区填充图案
4.9 使用标尺、参考线、网格和测量工具(1)


     

为了便于精确地定位图形和文字的位置，使选择更加准确，系统还提供了一些辅助手段供用户使用，如标尺、网格、参考线等。
4.9.1  使用标尺、参考线和网格
利用标尺可以精确显示光标所在位置，从而使选择更加准确，如图4-21所示。要显示标尺，可单击View（视图）→ Rulers（标尺）菜单或按Ctrl+R组合键。
[image: image563.jpg]



图4-21  在窗口中显示标尺
默认情况下，标尺的单位为厘米，但用户可通过选择Edit（编辑）→ Preferences（预设）→ Units&Rulers（单位与标尺）菜单，在打开的对话框中设置其他单位。
参考线用于对齐目标。例如，在制作图书封面时便需要利用参考线确定书名、作者名、出版社、书脊的位置，如图4-22所示。要使用参考线，必须首先显示标尺，接下来只需在标尺上单击并在显示窗口拖动即可创建参考线。其中拖动水平标尺可创建水平参考线，拖动垂直标尺可创建垂直参考线，且参考线可创建多条。
要移动参考线，按下Ctrl键后将光标移至参考线并拖动，此时光标将呈 [image: image564.jpg]


 形状，或者利用移动工具 [image: image565.jpg]


 ，将需要移动的参考线选中后拖动鼠标即可。若将参考线拖出画面，则可删除参考线。
[image: image566.jpg]



图4-22  参考线的作用
利用View（视图）菜单中的Lock Guides（锁定参考线）和Clear Guides（清除参考线）菜单项，用户可锁定和删除参考线；选择Edit → Preferences（预设）→ Guides，Grid & Slices（参考线、网格与切片）菜单，用户可设置参考线和网格的线型和颜色；选择View → Snap To（对齐到）→ Guides（参考线）菜单，可打开与关闭参考线捕捉。
除了使用标尺和参考线外，利用网格也可帮助用户精确定位光标位置，如图4-23所示。要显示网格，可选择View → Show（显示）→ Grid（网格）菜单；要控制光标按网格移动，可选择View → Snap to → Grid菜单。
4.9.2  使用测量器
利用测量器工具，用户可方便地测量任意两点之间的距离和角度。要使用测量器工具，可首先在工具箱中单击选择测量器工具，然后在图像显示窗口中要测量的起点处单击，然后拖动光标至要测量的终点，则系统将自动显示Info（信息）调板以显示测量结果，如图4-24所示。
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图4-23  打开网格显示                  图4-24  利用测量器测量两点之间的距离和角度
Info调板中各项参数的意义如下所述。
  X，Y：通常情况下，显示的是光标所在位置的坐标。当选用了测量器工具后，其显示值为测量的起点或终点坐标。
  A，D：测量的两点间的角度和长度。
  W，H：测量范围的宽度和高度，即测量两点间水平和垂直方向的距离。
将光标移至测量线上并拖动光标，可改变测量线的位置。若将光标移至测量端点处并拖动光标可改变相应的测量点的位置。
在测量的同时按住Shift键，可以沿水平、垂直或45°方向进行测量。若要删除测量线，可在任意位置单击或将测量线拖出显示窗口均可。
4.9 使用标尺、参考线、网格和测量工具(2)


     

上机实践——制作西瓜
本实例的制作主要用到了本章所学的图像的各种编辑命令，还运用了选区制作工具、渐变工具、滤镜等，制作的效果如图4-25所示。
（1）选择File → New菜单，创建一个宽为640像素，高为480像素的白色RGB文件。
（2）在Layers调板中单击调板下方的创建新层按钮 [image: image570.jpg]


 ，新建一个Layer 1层。
（3）选择工具箱中的椭圆选框工具 [image: image571.jpg]


 ，在图中画一个椭圆选区，如图4-26所示。
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图4-25  制作的西瓜                         图4-26  制作椭圆选区
（4）将前景色设置为淡黄色（R：245，G：246，B：215），背景色设置为墨绿色，（R：67，G：119，B：56），选择工具箱中的渐变工具 [image: image574.jpg]


 ，在工具属性栏中选中径向渐变工具 [image: image575.jpg]


 ，然后从选区的左上角至右下角进行渐变填充，如图4-27所示。
（5）新建Layer 2层，用矩形选框工具 [image: image576.jpg]


 画一长条选区，设置前景色为深绿色（R：18，G：88，B：7），选择Edit → Fill命令，打开Fill对话框用前景色填充选区，如图4-28所示。 
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图4-27  对选区进行渐变填充               4-28  制作矩形选区并填充颜色
（6）选择工具箱中的移动工具 [image: image580.jpg]


 ，按住Alt键拖动矩形长条，复制多个长条来制作瓜纹，如图4-29所示。
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图4-29  复制多个长条
（7）确定当前层为瓜纹层，按住Ctrl键的同时单击瓜体层（Layer 1层），调出该层选区，选择Filter（滤镜）→ Distort（扭曲）→ Ripple（波纹）菜单，打开Ripple对话框，其参数设置和结果如图4-30所示。
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图4-30  执行波纹滤镜及效果
（8）继续选择Filter（滤镜）／Distort（扭曲）／Spherize（球面化）菜单，打开Spherize对话框，设置数量设为100%，单击OK按钮，结果如图4-31左图所示。选择Select → Inverse（反选）菜单，将选区反选，按Delete键将多余瓜纹删除。按Ctrl+D组合键取消选区，结果如图4-31右图所示。
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  [image: image585.jpg]



图4-31  执行球面化滤镜后反选图像并删除选区内图像
（9）下面制作瓜蒂。新建Layer 3层，画一矩形选区，填充深褐色（R：113，G：76，B：12）。
（10）选择Filter（滤镜）→ Liquify（液化）菜单，打开Liquify对话框，选择对话框中的调抹工具 [image: image586.jpg]


 ，在对话框右侧的参数设置区中设置Brush Size值为55，在图中单击并拖动变形图像至瓜蒂形状，如图4-32所示。
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图4-32  在Liquify滤镜对话框中变形图像
（11）单击OK按钮，结果如图4-33所示。在Layers调板中拖动Layer 3层到Background层上方，调整图层顺序。
（12）选择Edit → Free Transform菜单，出现变形控制框，对图像进行旋转和缩放，并将图像移到适当位置，如图4-34所示。
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       图4-33  执行Liquify滤镜后的结果              图4-34  旋转并调整瓜蒂位置
（13）选择Filter（滤镜）→ Noise（杂点）→ Add Noise（添加杂点）菜单，打开Add Noise对话框，其参数设置和结果如图4-35所示。
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图4-35  为瓜蒂添加杂点
（14）选择Layer → Flatten Image（合并图像）菜单，将所有图像合并。为使西瓜效果更为真实，选择工具箱中的减淡工具 [image: image592.jpg]


 和加深工具 [image: image593.jpg]


 ，在其工具属性栏中设置较大的笔刷尺寸，在西瓜中涂抹，将高光区和暗调区进行适当调整，如图4-36所示。
（15）打开PhotoshopCS.Zip文件中的“习题图片／CH04／制作西瓜”目录下的“西瓜素材.PSD”图像文件，如图4-37所示。
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         图4-36  调整图像的高光区和暗调区             图4-37  打开一幅素材图片
（16）将图中的西瓜复制、粘贴到新打开的素材图片中，并按Ctrl+T组合键适当调整西瓜的大小与位置，如图4-38所示。
（17）在Layers调板中拖动西瓜层到层调板下方的新建层按钮中 [image: image596.jpg]


 ，复制该层，并将复制层拖动到Background层上方，如图4-39所示。
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          图4-38  将西瓜复制、粘贴到素材图片中             图4-39  复制并调整西瓜层
（18）双击Layer 1copy 1层名称，将其命名为“阴影”层。设置前景色为黑色，按下Ctrl键的同时单击阴影层，调出该层选区，并将该层填充为黑色。
（19）选择Edit → Free Transform菜单，旋转和调整图像大小，并将阴影图像移动到适当位置，在Layers调板中，调整阴影层的Opacity（不透明度）为31%，结果如图4-40所示。
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图4-40  为西瓜制作阴影
第5章 学习绘画工具之一
5.1 绘画工具的通用属性及笔刷设置


     

在Photoshop CS中，大多数图像编辑工具（如铅笔、画笔、历史画笔）都拥有一些共同的属性，如笔刷选择、Mode（色彩混合模式）、Opacity（不透明度）、Flow（流动速率）。同时，用户还可利用笔刷调板设置笔刷的一些特性，如发散（Scatter）、动态（Shape Dynamics）、湿边（Wet Edges）等。因此，我们在本节将首先向读者介绍绘画工具的通用属性，然后再介绍笔刷的设置方法。
5.1.1  各种色彩混合模式的特点
色彩混合模式决定了进行图像编辑（包括绘画、擦除、描边或填充等）时，当前选定的绘图颜色如何与图像原有的底色进行混合。要设置色彩混合模式，可按照如图5-1所示的方法进行设置。
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图5-1  设置色彩混合模式
下面我们就来分别介绍Photoshop提供的色彩混合模式。
  Normal（普通）：这是Photoshop提供的默认色彩混合模式，此时新绘制的图像将完全覆盖原来的颜色，或选定层完全覆盖下面的层（透明区域除外）。
  Dissolve（溶解）：在这种模式下，系统将混合颜色随机取代基色，以达到溶解效果。但是，在设置层的颜色混合模式时，如果此时Opacity参数为100%，将无法看到溶解效果。
  Behind（置后）：该特性仅用于设置工具，此时用户只能在当前层的透明区域画图，而不影响不透明区域的形状和颜色。此外，用户还应确认在Layers调板中未选中Preserve Transparency（保留透明区）复选框。
  Darken（加暗）：混合时比较混合颜色与基色，将其中较暗的颜色作为结果颜色。也就是说，比混合色亮的像素被取代，而比混合色暗的像素不变。
  Multiply（相乘）：将混合色与基色相乘，结果颜色通常比原色要深，如图5-2所示。
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图5-2  Multiply效果
  Color Burn（遮光）：通过增加对比度使基色变暗。其中，与白色混合时不改变基色。
  Linear Burn（遮线）：通过降低亮度使基色变暗。其中，与白色混合时不改变基色。
  Lighten（加亮）：混合时比较混合颜色与基色，将其中较亮的颜色作为结果颜色。也就是说，比混合色暗的像素被取代，而比混合色亮的像素不变。
  Screen（屏幕）：选择此模式时，系统将混合色与基色相乘，再转为互补色。利用这种模式得到的结果颜色通常为亮色，如图5-3所示。
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图5-3  Screen效果
  Color Dodge（加光）：通过降低对比度来加亮基色。其中，与黑色混合时色彩不变。
  Linear Dodge（加线）：通过增加亮度来加亮基色。其中，与黑色混合时色彩不变。
  Overlay（叠加）：将混合色与基色叠加，并保持基色的高亮和阴影。此时基色不会被代替，但会与混合色混合，以反映原色的明暗度，如图5-4所示。
  Soft Light（柔光）：根据混合色使图像变亮或变暗。其中，当混合色灰度大于50%时，图像变亮；反之，图像变暗，如图5-5所示。
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           图5-4  Overlay效果                    图5-5  Soft Light效果
  Hard Light（强光）：根据混合色的不同，使像素变亮或变暗。其中，如果混合色大于50%灰度，图像变亮。反之，图像变暗。这种模式特别适于为图像增加阴影。
  Vivid Light（清晰变亮）：如果混合色大于50%灰度，则以Color Burn模式混合，可使图像变亮；反之，则以Color Dodge模式混合，可使图像变暗。
  Linear Light（线性变亮）：如果混合色大于50%灰度，则以Linear Burn模式混合，可使图像变亮；反之，则以Linear Dodge模式混合，可使图像变暗，如图5-6所示。
  Pin Light（针状变亮）：如果混合色大于50%灰度，比混合色暗的像素将被替代，比混合色亮的像素不变；反之，则比混合色亮的像素将被替代，比混合色暗的像素不变，如图5-7所示。
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               图5-6  Linear Light效果                   图5-7  Pin Light效果
  Difference（差值）：以绘图颜色和基色中较亮颜色的亮度减去较暗颜色的亮度。因此，当混合色为白色时可使基色反相，混合色为黑色时原图不变。
  Exclusion（排除）：与Difference类似，但更柔和。
  Hue（色相）：混合后的亮度和饱和度由基色决定，但色相由混合色决定。
  Saturation（饱和度）：混合后的亮度和色相由基色决定，但饱和度由混合色决定。
  Color（颜色）：混合后的亮度由基色决定，但色相和饱和度由混合色决定。
  Luminosity（亮度）：混合后的亮度由混合色决定，但色相和饱和度由基色决定。
5.1 绘画工具的通用属性及笔刷设置(2)


     

5.1.2  不透明度参数
通过设置Opacity参数（取值范围为100%~1%，值越小，透明度越大）可决定所绘图案及当前图层的透明程度。要设置Opacity（不透明度），用户既可直接在Opacity编辑框中输入具体数值，也可单击该编辑框右侧的三角符号 [image: image611.jpg]


 打开一滚动条，然后左右拖动滚动条下方的△符号进行调整，如图5-8所示。
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图5-8  利用工具属性栏或Layers调板设置不透明度
5.1.3  笔刷的选择、创建、保存与加载
用户在使用工具箱中的绘图工具时，可通过工具属性栏对笔刷进行选择和设置。除了需要设置笔刷的直径外，为了绘制一些特殊线条，还可能经常需要为笔刷设置一些其他特性。例如，改变其圆度、形状、纹理等特性。
1．笔刷的选择、删除和重命名
在默认状态下笔刷可分为两大类，一类为没有发散效果的硬边笔刷，一类为具有发散效果的软边笔刷。要选择笔刷，可单击笔刷工具属性栏中的Brush（画笔）下拉按钮，在打开的下拉列表中选择合适的笔刷。
默认情况下，笔刷在其下拉面板中以Stroke Thumbnail（描边缩览图）形式显示。通过单击笔刷下拉面板右上角的 [image: image615.jpg]


 按钮，在弹出的下拉菜单中选择Text Only（纯文本）、Small Thumbnail（小缩览图）、Large Thumbnail（大缩览图）、Small List（小列表）、Large List（大列表）和Stroke Thumbnail（描边缩览图）等选项，可以改变笔刷面板中的笔刷显示方式，如图5-9所示。
要从笔刷下拉面板中删除某个笔刷或对笔刷重命名，可首先在笔刷列表中选中该笔刷，然后单击笔刷下拉面板右上角的 [image: image616.jpg]


 按钮，在弹出的下拉菜单中选择Delete Brush（删除笔刷）或Rename Brush（重命名笔刷）菜单即可。或者在选中笔刷后，单击鼠标右键，在弹出的快捷菜单中选择Delete Brush或Rename Brush项，如图5-9所示。
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图5-9  笔刷下拉面板和下拉控制菜单
2．创建笔刷
如果现有的笔刷不能满足用户的要求，用户还可以以现有笔刷为基础创建自己的笔刷。为此，可按如下步骤操作。
（1）单击工具属性栏中的Brush下拉按钮，打开Brush下拉面板。
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（2）在笔刷列表中选择一个基本笔刷，作为新建笔刷的原型笔刷。
（3）拖动Master Diameter（主直径）滑块或直接填写想要的数值，设置笔刷的主直径。
（4）在Brush下拉面板中单击 [image: image618.jpg]


 图标，打开Brush name（笔刷名称）对话框。
（5）填写笔刷名称，单击OK按钮，则新笔刷将被放在Brush列表的最下面，如图5-10所示。
3．自定义笔刷
在Photoshop CS中，用户可将任意形状的选区图像定义为笔刷。但是，笔刷中只保存了相关图像信息，而未保存其色彩。因此，自定义笔刷均为灰度图。
自定义笔刷的操作步骤如下：
（1）打开一幅素材图片，并定义图像选区，如图5-11所示。
（2）选择Edit → Define Brush Preset（定义笔刷）菜单，打开Brush Name（笔刷名称）对话框，输入笔刷名称，然后单击OK按钮，如图5-12所示。
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        图5-11  制作选区                         图5-12  命名自定义笔刷
（3）选中画笔工具（橡皮工具、修复工具都可以），打开笔刷下拉面板。可以看到，前面自定义的笔刷已经出现在笔刷面板的最下方，如图5-13所示。
（4）选择自定义笔刷，并调整画笔的主直径，然后进行绘画，如图5-14所示。
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        图5-13  自定义笔刷出现在笔刷面板的最下方       图5-14  使用自定义笔刷进行绘画
4．保存与加载笔刷文件
创建新笔刷后，如果希望将当前笔刷列表保存起来以备以后使用，可在笔刷下拉面板控制菜单中选择Save Brushes，此时系统将打开如图5-15所示的Save对话框。
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图5-15  保存笔刷文件
要安装笔刷，既可直接在笔刷下拉面板控制菜单中选择位于菜单下方的笔刷文件，也可选择Load Brushes菜单项打开Load对话框，安装其他笔刷文件。
笔刷文件的扩展名为*.ABR。Photoshop中用于保存笔刷文件的目录为Program Files\Adobe\Photoshop 7.0\Presets \Brushes。
如果在笔刷下拉面板控制菜单中选择Replace Brushes，可用加载的笔刷替换当前笔刷列表中的内容；选择Reset Brushes，将恢复系统默认笔刷设置。
5.1 绘画工具的通用属性及笔刷设置(3)


     

5.1.4  设置笔刷特性
如前所述，要设置所选笔刷的直径，只需简单地在笔刷下拉面板中调整笔刷的Master Diameter参数即可。但是，若要调整笔刷的直径、旋转角度、圆度、硬度、间距，或者设置笔刷的形状动态、发散、纹理填充、颜色动态等特性，则必须借助笔刷调板了。
要打开笔刷调板，可单击工具属性栏右侧的 [image: image624.jpg]


 按钮或选择Window → Brushes菜单，如图5-16所示。
1．设置笔刷的基本特性
如果希望设置笔刷的直径、旋转角度、圆度、硬度、间距等基本特性，可首先在笔刷调板的左侧设置区中单击Brush Tip Shape项，然后在打开的右侧笔刷列表中选择笔刷并进行设置，如图5-17所示。
对于各种笔刷来讲，用户可设置笔刷的如下所述的基本参数。
  Diameter（直径）：定义笔刷直径尺寸，其值在1~2500像素之间。
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图5-16  设置笔刷特性                    图5-17  设置笔刷的基本特性
  Angle（角度）：设置笔刷的旋转角度。不过，只有当笔刷形状为椭圆时，该设置才有意义，如图5-18所示。
  Roundness（圆度）：用于控制笔刷的长短轴比例，以制作椭圆形笔刷（参见图5-18）。
  Hardness（硬度）：定义笔刷边界的柔和程度，变化范围为0%~100%。该值越小，笔刷越柔和。
  Spacing（间距）：用于控制绘制线条时两个笔刷点之间的中心距离，取值范围为1%~1000%。值越大，线条断续效果越明显，如图5-19所示。
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图5-18  设置笔刷的旋转角度和圆度          图5-19  Spacing值对所绘线条的影响
2．形状抖动（Shape Dynamics）
如果在笔刷调板的左侧列表中单击Shape Dynamics，利用右侧的控制区可设置如下参数。
  Size Jitter（尺寸抖动）：通过调整该参数，可绘制粗细不均匀的线条，如图5-20所示。同时，通过在其下方的Control下拉列表中选择Fade，并设置合适的减弱步数，调整Minimum Diameter（最小直径）参数还可设置尺寸减弱效果，如图5-21所示。
减弱步长数的取值范围为1～9999，此值越大，减弱效果越匀称，也就越容易表现其减弱过程，这是因为步长数代表了一个画线长度。不过，如果画线较短而此数值较大，可能无法表现减弱效果。
在笔刷的很多设置项目（如下面介绍的角度抖动、圆度抖动等）中都可设置减弱参数，其用法与此类似。通常情况下，如果打开该项设置，将会加强相应的效果。
[image: image629.jpg]


               [image: image630.jpg]



          图5-20  设置尺寸抖动效果                       图5-21  减弱效果
  Angle Jitter（角度抖动）：利用该设置区可设置所绘线条弯曲处的抖动效果。
  Roundness Jitter（圆度抖动）：如前所述，使用画笔等工具绘制线条时，这些线条实际上是由一组圆点组成的。通常情况下，由于圆点十分密集，因此，用户并未觉察出它的存在。通过设置圆度抖动参数，可改变笔刷的圆度，从而制作出带有毛刺的线条。此外，通过打开其Fade设置，还可增强圆度抖动效果，如图5-22所示。
3．发散（Scatter）
利用该设置项目可设置笔刷的发散效果，如图5-23所示。其中，利用Scatter滑动杆可设置发散程度，该数值越大，发散程度越大；利用Count可设置发散密度，该数值越大，线条的密度越大；利用Count Jitter滑动杆可设置发散抖动效果。
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           图5-22  圆度抖动效果                     图5-23  笔刷的发散效果
4．纹理（Texture）
利用该设置项目可设置笔刷的纹理效果，如图5-24所示。其中，利用Scale滑动杆可设置纹理比例，利用Mode下拉列表可设置笔刷与图案的混合模式。
此外，通过选中Texture Each Tip复选框，可确定绘画时是否单独渲染每个线条的尖顶。同时，选中该复选框后，还可利用下面的设置区设置笔刷渗透到纹理的深度、最大深度及深度抖动等。
5．双笔刷（Dual Brush）
利用该设置项目可设置笔刷的双笔刷特性，如图5-25所示。选中该项目后，可在笔刷面板的右侧区域选择笔刷，以及笔刷直径、间距、发散度及密度等。
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         图5-24  笔刷的纹理效果                    图5-25  笔刷的双笔刷效果
6．颜色动态（Color Dynamics）与其他动态（Other Dynamics）
利用Color Dynamics设置项目可设置笔刷的颜色、色相、饱和度、亮度抖动效果，利用Other Dynamics设置项目可设置笔刷的不透明度抖动与流动抖动效果。
7．噪声（Noise）与湿边（Wet Edges）
通过在笔刷调板中选中Noise复选框，可为笔刷增加噪声效果。通过选中Wet Edges复选框，可为笔刷增加湿边效果，从而创建类似水彩效果的线条。
此外，通过在笔刷调板中选中Airbrush复选框、Smoothing复选框及Protect Texture复选框，用户还可为笔刷设置喷枪效果、平滑效果及保护纹理效果等。
8．清除笔刷设置
在为笔刷设置了各种特性后，如果希望清除其各项设置，可首先单击笔刷调板右上角的 [image: image635.jpg]


 按钮，打开笔刷调板控制菜单，然后选择Clear Brush Controls（清除笔刷控制），如图5-26所示。
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图5-26  清除笔刷设置
5.2 使用画笔工具和铅笔工具进行绘画


     

在Photoshop CS中，画笔（Paintbrush）和铅笔（Pencil）工具是最基本的绘画工具。其中，画笔工具 [image: image639.jpg]


 用于绘制线条，其作用类似现实生活中的毛笔，该工具的属性栏如图5-27所示。
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图5-27  画笔工具属性栏
使用画笔工具时应注意以下几点。
  可利用工具属性栏选择笔刷，设置色彩混合模式与不透明度（Opacity）。
  可利用Flow（流量）下拉编辑框设置流动速率。该数值越小，所绘线条越细。
  如果按下工具属性栏中的 [image: image641.jpg]


 工具，可使画笔具有喷涂能力。
若单击鼠标确定绘制起点后，按住Shift键再拖动画笔，可画出一条直线；若按住Shift键后反复单击，则可自动画出首尾相连的多条直线；按住Alt键，则画笔工具变为吸管工具；按住Ctrl键，则暂时将画笔工具切换为移动工具。
铅笔工具 [image: image642.jpg]


 通常用来绘制一些棱角比较突出、无边缘发散效果的线条，其用法和前面介绍的画笔基本相同。
5.3 历史画笔和历史艺术画笔的使用


     

通过将历史画笔和History调板相结合，用户可以轻松地恢复某个图像处理状态（由History调板指定）的某一部分内容，为图像制作特殊效果。
要使用历史画笔工具，应首先选择通过单击历史调板左侧的小方块 [image: image643.jpg]


 指定要恢复的图像处理状态，然后选择工具箱中的历史画笔工具 [image: image644.jpg]


 ，最后在图像窗口进行涂抹。下面通过一个简单的实例来说明其用法，其操作步骤如下所述。
（1）打开一幅图像，并对其执行ZigZag（水波）滤镜（位于Filter → Distort菜单），如图5-28所示。
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图5-28 对图像执行滤镜
（2）打开History调板，在工具箱中选中历史画笔工具 [image: image648.jpg]


，在History调板中单击Open操作旁的小方块 [image: image649.jpg]


，设置恢复点，如图5-29所示。
（3）在历史画笔工具属性栏中设置笔刷的直径，然后在图像中反复涂抹，恢复Open状态的部分图像，如图5-30所示。
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图5-29设置恢复点              图5-30  恢复Open状态图像
此外，Photoshop CS还提供了另一个历史画笔，这就是历史艺术画笔 [image: image652.jpg]


。两种画笔的区别在于，利用历史画笔可准确重现原来的状态，而利用历史艺术画笔则可在重现原状态时进行调整。图5-31上图显示了历史艺术画笔的工具属性栏。
历史艺术画笔的用法与历史画笔的用法相同，即首先通过History调板定位历史画笔的位置，然后利用工具属性栏设置工具属性，随后在选定位置进行涂抹，如图5-31下图所示。
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图5-31  使用历史艺术画笔
使用历史艺术画笔时，请注意设置笔刷的尺寸、样式（Style）与容差（Tolerance）。
上机实践——制作工笔画(1)


     

上机实践——制作工笔画
在下面的上机实践中，我们首先利用铅笔工具绘制景物的轮廓线，然后利用画笔工具给绘制好的景物上色。绘制的工笔画效果如图5-32所示。
1．绘制景物的轮廓线
（1）选择Open → New菜单，在弹出的New对话框中按照如图5-33所示的参数进行设置，单击OK按钮创建一个新文件。
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图5-32  工笔画效果             图5-33  设置新文件的名称、尺寸、分辨率和模式
（2）将工具箱中的前景色设为浅绿灰色（R:226，G:229，B:218），然后按Alt+Delete组合键，给Background层填充前景色，结果如图5-34所示。
（3）在Layers调板中单击Create a new layer按钮 [image: image658.jpg]


，在Background层之上创建新图层Layer 1，如图5-35左图所示。选择工具箱中的Pencil Tool按钮 [image: image659.jpg]


，在Layer1层中绘制老虎的轮廓线，结果如图5-35右图所示。
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图5-34  给Background层填充前景色              图5-35  创建新图层并绘制老虎的轮廓线
（4）在Layers调板中单击Background层，然后单击Create a new layer按钮 [image: image663.jpg]


，在Background层之上创建新图层Layer 2，并在Layer 2层中绘制山石的轮廓线，结果如图5-36所示。同样的方法，在Background层之上再创建新图层Layer 3，并绘制出远山的轮廓线，结果如图5-37所示。
2．沿轮廓线给景物上色
（1）用前面所讲的方法，在Background层之上创建新图层Layer 4，在工具箱中设置前景色的RGB值为（R:198，G:207，B:200），单击工具箱中的Brush Tool按钮 [image: image664.jpg]


，并单击工具属性栏中的Toggle the Brushes palette按钮 [image: image665.jpg]


，在弹出的Brushes调板中选择Brush Tip Shape选项并设置相应的参数，如图5-38所示。然后，在Layer 4层中进行如图5-39所示的绘制。
（2）设置前景色的RGB值为（R:174，G:198，B:208），并对笔刷进行如图5-40所示的参数设置。在Layer 4层中沿着远山的轮廓线为其上色，结果如图5-41所示。
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图5-36  绘制山石的轮廓线                图5-37  绘制远山的轮廓线
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图5-38  设置笔刷的参数                   图5-39  绘制远山的边缘
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图5-40  设置笔刷的参数                     图5-41  为远山上色
（3）在工具箱中将前景色的RGB值设为（R:176，G:175，B:171），并将笔刷按照图5-42所示的参数进行设置。然后，继续沿远山的轮廓线进行喷绘，结果如图5-43所示。
（4）在Layer 3层之上创建新图层Layer 5，设置前景色的RGB值为（R:172，G:164，B:148），并对笔刷进行如图5-44所示的参数设置。在Layer 5层中沿着山石的轮廓线为其上色，结果如图5-45所示。
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图5-42  设置笔刷的参数                  图5-43  为远山添加山顶色
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图5-44  设置笔刷的参数                     图5-45  为山石上色
（5）设置前景色的RGB值为（R:100，G:93，B:71），并将笔刷进行如图5-46所示的参数设置。然后在Layer 5层中，沿着山石的轮廓线绘制出石缝的效果，如图5-47所示。
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图5-46  设置笔刷的参数                    图5-47  绘制石缝效果
（6）设置前景色的RGB值为（R:14，G:9，B:9），并分别将笔刷进行如图5-48所示的参数设置，在Layer 5层中绘制出石缝中的植被效果，如图5-49所示。
（7）在Layer 2层之上创建新图层Layer 6，设置前景色为纯白色，对画笔进行适当的参数设置，然后在Layer 6层中沿老虎的轮廓线为其添加底色，如图5-50所示。
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图5-48  设置笔刷的参数
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图5-49  绘制植被效果                   图5-50  为老虎添加底色
上机实践——制作工笔画(2)


     

（8）适当调整前景色的色值和画笔的参数，分别在虎腿和虎嘴处进行喷绘，结果如图5-51所示。
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图5-51  在虎腿和虎嘴处进行喷绘
（9）继续调整前景色的颜色值和笔刷的参数，在Layer 6层中沿老虎的轮廓线进行喷绘，结果如图5-52所示。
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图5-52  沿轮廓线喷绘
（10）在Layer 6层之上创建新图层Layer 7，设置前景色的RGB值为（R:210，G:129，B:91），参照图5-53所示设置笔刷参数，然后在Layer 7层中沿老虎的轮廓线进行喷绘。为了便于观察，我们在Layers调板中单击Layer 6层左侧的 [image: image686.jpg]


 图标，将该层设为不可见，观察Layer 7层的效果，如图5-54所示。
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图5-53  设置笔刷的参数                图5-54  Layer 7层中的喷绘效果
（11）打开Layer 6层左侧的 [image: image689.jpg]


 图标，将该层设为可见。适当调整前景色的RGB值和画笔的参数，然后分别绘制出老虎的眼睛、鼻子和舌头，结果如图5-55所示。
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图5-55  绘制出眼睛、鼻子和舌头
（12）在Layer 1层之上创建新图层Layer 8，设置前景色的色值为纯黑色（R:0，G:0，B:0），按照图5-56所示设置笔刷的参数，在Layer 8层中沿老虎的黑色纹理进行喷绘，将其加粗，结果如图5-57所示。
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图5-56  设置笔刷的参数                     图5-57  加粗黑色纹理
（13）分别按照图5-58所示设置笔刷的参数，在Layer 8层中绘制出老虎脖子处的毛发，结果如图5-59所示。
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图5-58  设置笔刷的参数                         图5-59  绘制毛发效果
（14）设置前景色为纯白色，用前面所讲的方法对画笔进行适当的参数设置，然后在Layer 8层中为老虎添加上胡须和眉毛，结果如图5-60所示。
（15）将前景色设为纯黑色（R:0，G:0，B:0），选择工具箱中的Horizontal Type Tool工具[image: image696.jpg]


，在绘制的画面左侧输入文字“啸”，结果如图5-61所示。
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          图5-60  绘制出胡须和眉毛                     图5-61  输入文字
（16）选择File → Save菜单，将文件保存。
(源码网整理：www.codepub.com)
